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Get Started 
Organizer Quick Start 
Follow along and you’ll be up and running in no time! 

Install GoToMeeting 
Once installed, you can start and schedule meetings with just a couple clicks. You can install 
GoToMeeting on your Windows or Mac computer, as well as your iOS, Android or Windows devices. 

The GoToMeeting desktop application is used to host meetings. 

• Download GoToMeeting 

Start an instant "Meet Now" session 
You can start an unscheduled meeting any time you want using the desktop software, web account or our 
mobile apps.  

• Start Instant Meetings 

Start a scheduled meeting 
You can also schedule meetings ahead of time using the desktop software, web account or our mobile 
apps. 

• Schedule a meeting 
• Start a scheduled meeting 
• View scheduled meetings 
• Edit scheduled meetings 

Explore GoToMeeting features and tools 
GoToMeeting is chock-full of cool communication features. Use the links below to learn more! 

• Connect to audio 
• Invite others to join 
• Share your desktop 
• Share your webcam 
• Send chat messages 
• Use drawing tools 
• Record sessions 
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How to Log In 
When you create a new account, or receive notification that you have a new Citrix account through your 
company, you can use your email address and password to access the applications. 

About Login IDs 
There are two types of logins for Citrix accounts (also referred to as your "account credentials"): 

• Citrix ID – These are users who access Citrix products directly using an email and password of 
their choice. This is the majority of accounts. 

• Company ID – These are users in a Single Sign-On (SSO) company framework, so they use their 
business username and password to log into Citrix. This type of login is only available if your 
system administrator has configured it for your account. If you're unsure, contact your system 
administrator. 

The Company ID accounts are currently a beta program. Release of the new capabilities is expected 
around June 30, 2015. To learn more about the beta program, contact signin-beta@citrix.com. 

For additional information on setting up Single Sign-On for your organization, see: 

• Set up Citrix WebSSO Integration 
• Provision accounts with Citrix Active Directory Connector 
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Log in to your personal account 
1. Go to https://global.gotomeeting.com. 

2. Either enter your Citrix ID (i.e., the email address and password created during sign up), or if you 
are on a company SSO account, click Use My Company ID and enter your company username and 
password. 

You will be directed to the Citrix ID page by default; you can switch between login types by clicking the 
Use My Company ID link or I have a Citrix ID link. To have your information stored for the next 30 
days, enable the "Remember me" check box. 

IMPORTANT: Use My Company ID is only available if your system administrator has configured it for your account. If you're 
unsure, contact your system administrator. 

 

3. Click Sign In. You'll then have access to all of the features and tools GoToMeeting offers! 
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4. If you want to access your personal account settings once you are in the account, choose My 
Account from the options menu. 

 

Log in to the Admin Center 
If you are an account administrator, you can log into the Admin Center directly. 

1. Go to https://admin.citrixonline.com. 

2. Either enter your Citrix ID (i.e., the email address and password created during sign up), or if you 
are on a company SSO account, click Use My Company ID and enter your company username and 
password. 

You will be directed to the Citrix ID page by default; you can switch between login types by clicking the 
Use My Company ID link or I have a Citrix ID link. To have your information stored for the next 30 
days, enable the "Remember me" check box. 

IMPORTANT: Use My Company ID is only available if your system administrator has configured it for your account. If you're 
unsure, contact your system administrator. 

3. Click Sign In.  
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4. If you are an account administrator and you are also an organizer for one or more products (for 
example for GoToMeeting, you can also access the Admin Center from your options menu.  

 

Trouble logging in? 
If you're having trouble logging in to your account, try the following: 

• You may be trying to log in with the wrong type of Login ID. Click the Use My Company ID link or I 
have a Citrix ID link, then try logging in again. 

• Are we lost? See why here. 
• Try resetting your password.  
• If you still can't log in, contact Citrix Support. 

Forgot your password? 
If you can't remember your password, you can reset it using your email address.  

1. Click the Forgot Your Password? link on the login page.  

2. Enter your login email address and click Continue to reset your password. 

3. Soon you’ll receive a Forgot Your Password email. Click the link inside to create a new password. 

 

4. You can also change your password from the options menu if you are logged in. 
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Why are we lost? 
There are occasions when the Citrix authentication service cannot tell where you intended to go. This can 
happen, for instance, if you are already logged in and attempt to log in again. The page, You're not lost - 
we're lost, provides links to Citrix product accounts. If you do not have one of the products and click on 
the link, you are offered the opportunity to start a Trial account. 

 

Don't have an account? 
Try GoToMeeting free for 30 days! Included in your 30-day free trial: 

• Unlimited online sessions 
• Up to 25 attendees per session 
• Audio via telephone and/or mic and speakers 
• Free product training and 24/7 support  

Find your Optimal Connection Settings (Windows) 
The GoToMeeting Connection Wizard tests and determines the ideal connection settings that 
GoToMeeting can make within your network. After running the wizard, you can store your optional 
connection settings on your Windows computer and use those settings in the future to connect to 
sessions.  

Run the GoToMeeting Connection Wizard on Windows 
1. To begin the test, download the GoToMeeting Connection Wizard. The G2MConnectionWizard.exe 
file should download in your default browser. 

2. Open the G2MConnectionWizard.exe file and run the software when prompted. 

3. When the GoToMeeting Connection Wizard launches, click Next to start the connection test. 
GoToMeeting's home page should launch in your default browser. If you're not redirected to 
www.gotomeeting.com, open your browser and go to that page. 
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4. Click OK to continue. The Connection Wizard will determine the best connection setting for your 
computer when connecting to GoToMeeting. This process may take a few minutes to complete. 
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5. Once the detection process is complete, click Next.  

6. Try out the new connection settings by starting a meeting, then select the appropriate option in the 
Connection Wizard window:  

• GoToMeeting now properly connections to the GoToMeeting service infrastructure – Click 
Next > Finish to complete the Connection Wizard test. 

• GoToMeeting now properly connects to the GoToMeeting service infrastructure, but I still 
experience problems – Contact Global Customer Support for further troubleshooting. You 
may be asked to provide a GoToMeeting Connection Wizard report by clicking Wizard Report.  

• GoToMeeting still cannot connect to the GoToMeeting service infrastructure – Contact 
Global Customer Support for further troubleshooting. You may be asked to provide a 
GoToMeeting Connection Wizard report by clicking Wizard Report.  

7. Click Next. The following screen will explain the next recommended steps.  
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Test your Connection, Audio or Webcam 
You can test your internet connection, audio connection and webcam at any time, whether you're getting 
ready to start a session or are already in one.  

Test your internet connection 

Before a session 

1. To test your connection from a computer or mobile device, join the test session using the following 
URL: https://www3.gotomeeting.com/join/406552062.  

2. You will automatically be launched into session.  

• Desktop users – If you have not yet installed the GoToMeeting desktop application, the download 
will automatically begin. See Install on Windows or Install on Mac for more information.  

• Mobile users – If you have not yet installed the GoToMeeting app, you will be directed to the app 
store to download it.  

3. If you see a "Waiting for Organizer" message, you've successfully joined the test session. You 
should be able to join GoToMeeting, GoToWebinar and GoToTraining sessions from this computer. 
Close the "Waiting for Organizer" dialog to exit the test session. 

Note: If you're unable to join the session, you may not have all the necessary software. See Join Help for more troubleshooting 
tips, and make sure you have all the System Requirements.  
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During a session (Windows only) 

Does something feel off with your meeting session? You can test your GoToMeeting connection while in 
session to find out for sure. 

1. While in a session, open Preferences. 

2. Click Connection in the left navigation. 

3. Under "Test your GoToMeeting connection", click Test Connection. 

4. Under "Test Results", you'll see one of the following messages: 

• Passed: You've established a connection. 
• Fail: You haven't established a connection. See Connection Test Help for troubleshooting info. 
Note: You may need to enter your Windows username and password or domain if you have a proxy that prevents you from 
connecting to GoToMeeting. If you don't have a proxy, please check to see that you have the minimum system 
requirements.  

5. Click OK when finished. 
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Test your computer audio 

Before a session 

1. Right-click the daisy icon  in the system tray and select Preferences. 

2. Select Audio in the left navigation.  

3. Configure and test your audio as follows: 

• Use the drop-down menus to select which devices to use for microphone and speakers. If you do 
not see the device you're looking for, ensure that it is properly plugged into your computer.  

• If they are working as expected, you'll see the Mic meter  and Speakers meter  light up in 
green. If you do not see that happen, try selecting a different device.  

• If needed, click Play Sound to play a noise to test your speakers setup. 

4. Click OK when finished. GoToMeeting will remember your selection (unless the selected device is 
disconnected before the next session). 
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During a session 

1. You can use any of the following methods while in session: 

• Follow the instructions under Preferences > Audio, as described above. 
• Access the drop-down menus described above in the Audio pane of the Control Panel. 
• Click Sound Check in the Audio pane of the Control Panel, then use the Sound Check window to 

select your device and test the sound. If the audio isn't working as expected, try selecting 
another device that's connected to your computer from the drop-down menu until the audio 
indicators turn green. 
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Test your webcam 
You can test your webcam at any time to make sure everything looks the way you want it to. 

1. Right-click the daisy icon in the system tray and select Preferences. 

2. Click Webcam in the left navigation.  

3. If you have a webcam connected, you will see a preview of it under "Webcam Setup".  
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Preview your webcam 
1. While in a meeting, select the Webcam tab in the Options pane.  

2. A preview of your webcam will be displayed. Once you share your webcam, a blue highlight will 
appear around the webcam box and the "Preview" header will disappear.  
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System Requirements 
Before you download the latest version of GoToMeeting, please check to see that your computer and 
accessories meet the minimum system requirements. Note that while most computers have built-in 
microphones and speakers, you will get much better audio quality if you use a headset. You can also 
make calls on your landline or mobile device. 

The following are required in order to use GoToMeeting: 
Desktop app 
Operating system 

Windows XP or later 
Windows 2003 Server or later 
Mac OS X 10.7 (Lion) or later 

Internet  Recommended broadband connection with 1+ Mbps 
Web Browser 

Google Chrome v39.0 or later 
Mozilla FIrefox v34 or later  
Internet Explorer v8.0 or later 
Safari v6 or later 

Software GoToMeeting desktop app 
JavaScript enabled 

Hardware 2GB or more of RAM 
Microphone and speakers (USB headset recommended) 
Webcam (to use HDFaces) 

  

iOS app 
Operating system iOS 8 or newer 
Device iPhone 4 or newer  

iPad 2 or newer 
Internet WiFi recommended for VoIP audio 
Software 

Free GoToMeeting App from the App Store 

Hardware Headset recommended for VoIP audio 

  

Android app   
Operating system Android 4.0 or higher 
Internet WiFi recommended for VoIP 
Additional software 

Free GoToMeeting App from the Google Play Store 

Hardware Headset recommended for VoIP audio 

  

Windows Phone & Windows 8/RT app 
Operating system Windows 8 or Windows RT 
Internet WiFi recommended for VoIP 
Software Free GoToMeeting App from the Windows Store 
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Manage your Account 
  

Forgot Your Password 
Remembering all your passwords is hard. Luckily, resetting your GoToMeeting password is easy. 

Forgot your password? 
1. Go to the Forgot Your Password? page.  

2. Enter your login email address and click Continue to reset your password. 

3. Soon you’ll receive a Forgot Your Password email. Click the link inside to create a new password. 

 

If you're still having trouble accessing your account, contact Global Customer Support.  

Can’t Access Your Account 
If you're trying to log in but can't access your account, your subscription may have expired. You'll need to 
first update your billing information to continue using GoToMeeting. 

Update your account 
  1. Log in to your GoToMeeting account. 

2. You should be taken directly to the My Account page. In the Plan Details, click Subscribe Now to 
sign up for a paid subscription plan. 

3. Choose the plan that best fits your needs, and click Review Your Plan.  

4. On the Confirm Your Plan page, click Purchase Now. To ensure uninterrupted service, you will be 
billed automatically on the billing date. You can click Turn Off Renewal on the My Account page at 
any time to turn off automatic renewal. 

5. Once you confirm your plan, you'll be able to use GoToMeeting without any disruptions. 

© 2015 Citrix Systems. All rights reserved. 16 
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Change Your Login Info 
Have a new email address? Want to change passwords? No problem; just follow along.  

Change your login info 
1. Log in to your online account.  

2. Select My Account in the top navigation. 

3. Click Edit next to Login Info. 

4. To change your email address, edit your email address in the Email Address field. To change your 
password, enter your new password twice – it must contain 8 - 32 alphanumeric characters. 

5. Then enter your current password. If you forgot your password, click Forgot password? Enter your 
email address and reset your password by opening the link you receive in the Forgot Password email. 

6. When you’re done, click Save Changes. You’ll see a confirmation message saying that your login 
information has been updated. 
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Change Your Plan 
You can change your plan level at any time. Since your service is pre-paid, changes made to your plan 
won't take effect until the end of your subscription period.  

Note: If you are the administrator of your account but are still unable to see some of the features and buttons described below, it is 
likely that you have an "offline" account (meaning that you manage your account and billing options through a Citrix Sales 
representative). In this case, you must contact Global Customer Support to modify your account and subscription plans. 

Change your subscription plan 
1. Log in to your online account.  

2. Select My Account in the top navigation. 

3. Click Change Plan in the Plan Details section. 

4. Select a plan that best fits your needs. To purchase a multi-seat account, select the number of 
organizer seats you need from the drop-down menu.  

5. Click Purchase Now. You can click Edit next to Plan Details or Billing Info to make any changes. 

Your plan will renew on your billing start date to ensure uninterrupted service. Your credit card on file 
will be automatically charged. Learn about how to turn off automatic renewal. 
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Upgrade from a GoToMeeting Essentials plan to a GoToMeeting 25 plan 
1. Log in to your GoToMeeting account.  

2. Select My Account in the top navigation. 

3. On the My Account page, click Change Plan in the Plan Details section. 

4. To switch your plan from a GoToMeeting Essentials plan to a GoToMeeting 25 plan, select the 
number of organizer seats (optional) and then choose either the monthly or annual plan. 

5. On the Confirm Your Plan page, click Purchase Now. 
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Edit Your Personal Info 
You can edit your personal info, such as your first and last name, primary language, time zone and 
daytime phone number. 

Edit your personal info 
  1. Log in to your GoToMeeting account. 

2. Select My Account in the top navigation. 

3. On the My Account page, click Edit next to Personal Info. 

4. On the Change Personal Information page, you can edit your first or last name, primary language, 
time zone and daytime phone number (optional). You can also add your Twitter username to post 
questions about GoToMeeting and receive support. 

5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your 
personal information has been updated. 
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Update Your Billing Info 
You can change or update your billing info at any time. If you have a corporate account, follow steps 1 - 2 
below, and then click Contact Us in the Account Details section for Corporate Billing support. 

Change your billing info 
  1. Log in to your GoToMeeting account. 

2. Select My Account in the top navigation. 

3. On the My Account page, click Edit next to Billing Info. 

4. On the Change Billing Information page, you can change your credit card information. 

5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your billing 
information has been updated. 
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Set Your Default Language 
You can set your default language for how you view the GoToMeeting website from the My Account 
page. After you've chosen your preferred primary language, you can view the GoToMeeting website in 
that language. You can also choose your preferred language while you're in-session – whatever language 
your operating system is set to is the default language for your in-session experience, but you can 
change that at any time from your Windows computer. 

Set your account's default language 
  1. Log in to your GoToMeeting account. 

2. Select My Account in the top navigation. 

3. On the My Account page, click Edit next to Personal Info. 

4. On the Change Personal Information page, you can choose your primary language so that the 
GoToMeeting website appears in your preferred language. 

5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your 
personal information has been updated. 
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Choose your language in-session (Windows only) 

1. During a session, select the Globe icon  at the top of your Control Panel. 

2. Select your preferred language. You can switch languages at any time by selecting another 

language from the Globe icon . 

Updates to Your Account 
We’re in the process of rolling out updated versions of GoToMeeting, GoToWebinar and GoToTraining to 
our remaining customers who do not yet have the latest experience. As always, the updates are 
absolutely free. 

As part of this upgrade, we’re also combining your GoTo ™ product log-in credentials. If you use the 
same email address for GoToMeeting, GoToWebinar or GoToTraining and also for Open Voice and the 
GoToAssist family of products, you will need to complete a secure, one time password reset. This means 
one less password to remember, and it’ll be easier than ever to switch between some of our most popular 
solutions. 

Attend a live, online training session to learn more. Register today!   

GoToMeeting Updates 
Log in to your account at www.gotomeeting.com to get started.  

  

Schedule meetings even faster and easier:  

• Schedule and host meetings in localized languages such as French, German, Spanish, Italian and 
Mandarin. 

• Schedule and start your meetings directly from the website. 
• Designate a GoToMeeting organizer to host meetings on your behalf with the new meeting co-

organizer feature. Watch the Co-Organizer Basics video (3 min) to learn more! 

Personalize your meeting experience with new settings options:   

• Create brand awareness by uploading a custom logo to the GoToMeeting waiting room. 
• Select your default audio numbers, then set a preferred audio number so it conveniently appears 

first for attendees. 
• Enable a no download, Web App option, for attendees who are unable to download software or are 

using an unsupported operating system such as Linux. 
• Watch the Settings video (5 min) to learn more! 

Try our latest features and tools using Citrix Labs: 

• Try out GoToMeet.Me, one of our most popular new features. It’s a simple way for organizers to 
increase their professional presence online with a custom profile page and personalized meeting 
URLs to share with others. Try it today! 
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GoToWebinar Updates 
Log in to your account at www.gotowebinar.com to get started.  

   

Schedule webinars even faster and easier: 

• Schedule and host webinars in localized languages such as French, German, Spanish and Italian. 
• Create a webinar registration link in seconds with just a few clicks. 
• Watch the Scheduling Basics video (9 min) to learn more! 

Get more control over how attendees register and in-session interaction:   

• Add a splash of color to your event by selecting custom background, header and border colors for 
registration and confirmation pages. 

• Enjoy an increased capacity for polls (20) and survey questions (25), which means more attendee 
engagement. 

Learn more about your audience: 

• Use our new registration source tracking capability. 
• Get more details from your registrants with up to 20 custom registration questions. 

Improve vital email communication: 

• Re-send invitations to individuals and cancel registration on behalf of registrants as well. 
• Preview the automated webinar communication by sending yourself a copy of the confirmation and 

follow-up emails. 
• Improve the webinar's workflow by setting the “reply-to” email address to any email of your 

choosing. 

Leverage the content you create:   

• Review past webinars with archived recordings that will no longer expire. We’ll continue to store 
them so you can build out your content library. 

• Enjoy 3GBs of archived storage capacity for each webinar user at no additional cost. 
• Archive larger recording files with a new, increased upload limit of 1GB per recording. 
• Allow organizers on Macs to archive recordings. 
• Watch the Recording Basics video (4 min) to learn more! 
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GoToTraining Updates 
Log into your account at www.gototraining.com to get started.  

Schedule trainings even faster and easier: 

• Schedule and host trainings in localized languages such as French, German, Spanish and Italian. 
• Watch the Scheduling Quick Start video (3 min) to learn more.  

Easily manage your trainings with improved website usability 

• Quickly find content such as tests, materials, polls and co-organizers using the search function. 
• Generate reports to view training history. 
• Enable a no download, Web App option for attendees who are unable to download software or are 

using an unsupported operating system such as Linux. 
• Watch the Managing Libraries and Materials (9 min to learn more) 

Easily record your events and share them with your learners:  

• Immediately preview your newly added archived recordings directly from My Recordings. 
• Learn on the go with archived recordings viewable from any mobile device. 
• Allow organizers on Macs to archive any.mov or .wmv file. 

Corporate Admin Center Updates 
Log in to your updated administration center at www.gotomeeting.com and have a look around. See the 
Global Admin Center Guide for more information.  

Easily manage users and settings with improved search, filter and management functionality: 

• Create custom invitation templates to match your business processes. 
• Save time by creating default user settings for all new invitees. 
• Manage user settings even before the user accounts are activated. 
• Make settings changes in bulk for all users at the same time. 
• Assign seats, roles and groupings at the same time as well. 
• Create a localized user experience by setting the primary language. 
• Save important meeting links with the ability to reassign scheduled meetings to another user. 
• Select your default audio numbers, then set a preferred audio number so it conveniently appears 

first for attendees joining sessions. 
• Generate usage and bill reports for Open Voice Integrated services. 
• Add a custom field within your Settings options to track cost centers. 
• Watch the Global Admin Center Tutorial video (9 min) to learn more! 

Don’t forget to explore our additional integrations available to administrators, including the Active 
Directory Connector (ADC) and WebSSO (SAML 2.0). 
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Cancel or Renew Your Account 
Your plan is set to auto-renew, but you can turn that setting off any time. When you cancel your account, 
your service will continue until the end of your subscription period (since GoToMeeting is a pre-paid 
service). At that time your service will stop, you will lose access to scheduled sessions and reports and 
you will not be automatically charged again. You can renew your account at any time.  

Note: If you are the administrator of your account but are still unable to see some of the features and buttons described below, it is 
likely that you have an "offline" account (meaning that you manage your account and billing options through a Citrix Sales 
representative). In this case, you must contact Global Customer Support to modify your account and subscription plans. 

Turn off renewal for free trials 
1. Log in to your online account.  

2. Select My Account in the top navigation.  

3. Click Change Plan in the Plan Details section.  

4. Select Cancel after my GoToMeeting Free Trial ends and click Continue.  

5. Click Cancel after Trial. You’ll see a message and receive an email confirming that you won't be 
charged after your free trial ends.  
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Turn off renewal for paid plans 
1. Log in to your online account.  

2. Select My Account in the top navigation. 

3. Click Turn Off Renewal in the Plan Details section. 

4. Click Turn Off Renewal. Your service will stop, and you will not be automatically charged after your 
plan ends. If you change your mind, you can log in at any time to restart your plan. 
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Renew your plan 
1. Log in to your online account.  

2. Select My Account in the top navigation. 

3. Click Renew Your Plan in the Plan Details section. 

4. If desired, click Edit to change your plan level. Then click Purchase Now. Your account will 
reactivate immediately! 

Note: You will be billed automatically on your billing start date.  
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Billing and Cancellation FAQs 
Review frequently asked billing and cancellation questions. 

How do I change my password? 
Have a new email address? Want to change passwords? See Change Your Login Info for more 
information.  

How do I cancel my paid subscription plan? 
Your plan is set to auto-renew, but you can turn that setting off any time. See Cancel or Renew Your 
Account for more information.  

If you're on a corporate plan, contact our Corporate Billing Center.  

How do I change my plan or switch products? 
You can change your plan level at any time. See Change Your Plan for more information.  

What charges apply when I change my plan? 
Plan changes will be automatically adjusted and pro-rated against your current account balance. We’ll 
send you a confirmation email receipt after the changes are completed. 

• If your new plan selection increases your subscription price, you’ll be prompted to enter payment. 
Once finished, you’ll have instant access to the features for the new plan. Your subscription billing 
date will change to reflect the date of the change in plan. 

• If your new plan selection decreases your subscription price, we’ll credit your account and apply 
the credit toward your next scheduled payment. Your subscription billing date will change to reflect 
the date of the change in plan. 

My account lapsed. How do I reactivate it? 
We’re glad you’re back! See Cancel or Renew Your Account for more information.  

How can I review the charges billed to my account? 
You can see your account history by logging in and viewing your recent billing activity at the bottom of the 
page. 

How do I get answers to billing questions or request a refund? 
Contact Global Customer Support and we'll take care of all your questions and requests. 

Will I get a receipt for my purchase? 
You can see all your receipts by logging in and clicking My Account > View All Activity. We’ll also send 
a receipt via email for your first subscription purchase, subsequent renewals and any time you change 
your subscription plan. 
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Preferences (Windows) 
The Preferences window allows you to modify the settings for running GoToMeeting (including audio, 
connection and integration settings).  

• Windows users can access Preferences by right-clicking the GoToMeeting daisy icon  in the 
system tray, or from the File menu while in-session. 

• Mac users can access Preferences by opening the GoToMeeting desktop application and 
selecting GoToMeeting > Preferences in the menu bar. Please see Preferences - Mac Users for 
more information. 

Start Up preferences 
These settings allow you to determine how GoToMeeting is launched and updated.  

• Start Automatically – Choose to have GoToMeeting automatically launch as soon as you log in to 
Windows. 

• Start Manually – Choose to have GoToMeeting wait until you manually launch it to open.  
• Remember me– Enter the login credentials for your account and choose whether GoToMeeting 

should remember them when you launch it.  
• Show me desktop notifications – Choose whether to allow GoToMeeting to show pop-up 

notifications regarding your account.  
• Remind me of upcoming meetings – Choose whether see pop-up notifications reminding 

you of upcoming meetings.  
• Automatically install updates – Choose whether to allow the GoToMeeting desktop application 

to automatically download and install new versions/builds when they become available (without 
prompt). 
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General preferences 
The General category lets you set your general GoToMeeting preferences. 

• File save settings - Enables you to save the Chat Log to any drive or directory. 
• Security - Set the inactivity timeout to automatically stop screen sharing if there is no keyboard 

input or mouse movement for the specified period of time. 
• Session Identity - Remember your name and email as displayed in the attendee list. 
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Meetings preferences 
The Meetings category lets you determine which GoToMeeting options are available to attendees during 
a meeting. You can also select which messages are viewable during a meeting. 

• Enable or disable the ability for attendees to chat and view the Attendee List. 
• Create a Chat Welcome Message that is sent to each attendee upon joining the meeting. 
• Enable or disable various system messages that appear to you when specific meeting actions 

occur. 
• Select the desired color for your GoToMeeting Viewer and Control Panel. 

Note: If you disable the Chat Bubbles option, a new message icon will still appear on the Grab Tab to notify you of new chat 
messages as they are received. 
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Webinar preferences 

 

Training preferences 
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Recording preferences 
These preferences allow you to specify how sessions are recorded and where those recordings are 
saved.  

Note: Be sure to check your audio device settings under Audio. Mac users can only view meetings recorded in the Windows Media 
Player format. 

1. Select Recording in the left navigation. 

2. In the Audio section, choose how you want the audio to be recorded: 

• Don't record audio: Records the presenter's screen only. 
• Use Use GoToMeeting integrated audio: Records everyone who speaks via VoIP or telephone. 
• Use your own audio service: Uses a microphone to record the organizer's voice, while a phone 

patch device will record everyone else who speaks (requires a physical input device).  
Using GoToMeeting 

Integrated Audio 
Using Your Own Audio Service 

Records all unmuted 
speakers in the 
meeting. 

To record all unmuted speakers, you will need a phone 
patch connected to both your phone and the mic in port of 
your computer. 

To record just your voice, you will need a microphone 
connected to your computer. 

If you want to use VoIP with your own audio 
service, please contact your Account Manager 
(GoToMeeting corporate plans) or Global 
Customer Support (GoToMeeting plans). 

Your Windows must have a sound card installed in order to record 
audio. For example, if you can hear music through your Windows, you 
have a sound card. 

3. All recordings must be converted before they can be played back. In the Recordings section, select 
whether or not to be reminded to convert recordings each time the session ends.  

5. When your recordings are converted for playback, the recording files are saved to the Documents 
folder by default (C:\Users\<username>\Documents). You can select another folder by clicking 
Browse, navigating to the desired location and clicking Save. It is recommended that you choose a 
location on your hard drive.  

4. In the Preferences window, click OK.  
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Recording preferences 
The Recording category lets you set your audio and video recording preferences. See Record a Meeting 
for more information. 

• Audio - Allows you to enable or disable recording the audio portion of your meeting. To record, 
choose which audio service you have scheduled to use for your meeting (see the following table). 

• Video - Allows you to select the meeting recording output format and destination for saving the file. 
• Save in - Select the folder in which you want to save your recording. 

Mac users are not able to record a meeting. If you want your meeting recorded, promote a Windows 
attendee to organizer in-session. A Windows-based organizer will have the recording feature. 
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Integration preferences 
The Integrations category lets you determine where to display GoToMeeting integrations. Options 
include: 

• Use GoToMeeting with - Select your GoToMeeting email and calendar integration. By selecting 
My default email application you can integrate with MAPI-compliant email/calendar programs other 
than Microsoft Outlook and Lotus Notes. Depending on your email application's capabilities, 
integration with MAPI-enabled programs allows for features such as automatically adding meetings 
to a calendar and automatic creation of email messages with meeting information. 

• Show GoToMeeting Toolbar in Microsoft Office - Display the GoToMeeting Toolbar in Microsoft 
Word, Excel and PowerPoint.  

Note: Changes will only be displayed after restarting Outlook, Lotus Notes and/or the instant-messaging application. 

 

Connection preferences 
The Connection category allows you to test the status of your GoToMeeting connection. 

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMeeting Global 
Customer Care representative directs you to perform the connection test. 

 

Audio preferences 
The Audio category lets you set up and test your microphone and speakers for recording and for your 
meetings utilizing VoIP. If changes to your audio settings are made during a meeting, your microphone is 
temporarily muted so you can privately manage your settings. See GoToMeeting Integrated Audio for 
more information. 
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• Microphone Setup - Select a microphone from the drop-down menu. To test, speak into your 
microphone; if connected correctly, the sound bar will move when you speak. 

• Speakers Setup - Select your speakers from the drop-down menu. To test, click Play Sound; if 
connected correctly, the sound bar will move and you will hear a short soundtrack. 

• Advanced - GoToMeeting automatically adjusts system mixer settings. We recommend you keep 
this checked. If you uncheck this selection, you must manually configure your audio settings 
through Windows Sounds and Audio Devices. 

• Use automatic volume and noise processing - This option usually improves audio quality when 
people are talking. Unchecking this box may improve quality of music or other audio sources.  
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Webcam preferences 
The Webcam category lets you set up and test your webcam for HDFaces Video Conferencing. Options 
include: 

• Your camera - Shows the make and model of your detected webcam. 
• Select a display format - Adjusts the aspect ratios of webcam feeds. (4:3 is the normal display 

and 16:9 is the widescreen display. 
• Advanced - Modifies your hardware settings from within GoToMeeting. Customizable options 

depend on your webcam manufacturer. 
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Preferences (Mac) 
GoToMeeting Preferences allow you to set preferences for running GoToMeeting, choose where you 
want to store recordings, select what your attendees can see and set your webcam preferences.  

Mac users may access the GoToMeeting preferences by double-clicking the GoToMeeting Suite icon on 
their desktop and selecting Preferences from the GoToMeeting menu in the menu bar. 

 

General Preferences 
The General tab allows you store your account information and display name for meetings. If you check 
the "Remember me on this computer," your account information will be saved and you will not need to re-
enter it when you join a meeting. You can also select the "Use GoToMeeting with default email 
application" check box to add email integration to your GoToMeeting account. 

Recording Preferences 
The recordings tab allows you to choose where you would like to store your recordings and how you 
would like to be notified to convert your recordings (you must convert recordings before anyone can see 
them). 
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Meeting Preferences 
The Meetings tab lets you determine which GoToMeeting options are available to attendees during a 
meeting. Options include: 

• Enable or disable the ability for attendees to chat and view the Attendee List. 
• Create a welcome message that is sent to each attendee upon joining the meeting 

Webcam Preferences 
The Webcam tab allows you to select a camera to use for your wbecam as well as a display format. 

© 2015 Citrix Systems. All rights reserved. 42 



GoToMeeting User Guide 

Install and Upgrade 
Download GoToMeeting 
To get the most out of GoToMeeting you can download and install the full-feature desktop software on 
your Windows and Mac computer.  

Install on individual computers 
Windows and Mac users must install the GoToMeeting desktop software in order to host meetings from 
their computers.  

• Download the Windows/Mac version 
• Download the Windows 8/RT version 

For step-by-step instructions on downloading and installing the desktop software, see Install on Windows 
or Install on Mac. 

Distribute to multiple computers 
System administrators may wish to install GoToMeeting across several computers at once (i.e., 
workstations at a company). See the following articles for more information: 

• Install the GoToMeeting MSI File (Windows) 
• Install the GoToMeeting DMG File (Macs) 

Install on mobile devices 
Mobile users can install the GoToMeeting free on iOS, Android or Windows devices. 

• Download the GoToMeeting app for iOS on the App Store. (See FAQs for more information.) 
• Download the GoToMeeting app for Android on Google Play . (See FAQs for more information.) 
• Download the GoToMeeting app for Windows Phone in the Windows Phone store. (See 

GoToMeeting FAQs for more information.) 

Trouble downloading? 
For step-by-step instructions on downloading and installing the desktop software, see Install on Windows 
or Install on Mac. 

Trouble joining? 
If you're running into problems joining a session, see the following resources: 

• Join a Session 
• Join a Session FAQs 
• Join Help 
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Automatic Updates  
You can easily install the latest version of GoToMeeting whenever an update is available using the 
automatic updates feature. You won’t be prompted to install the latest version – you’ll simply get 
upgraded seamlessly when you’re not in session. By default, the automatic updates feature is enabled if 
you’re logged in to the application and have the “Remember me on this computer” option selected.  

Enable or disable automatic updates 
Note: If you prefer to be prompted every 24 hours the next time an update is available, you may turn off automatic updates, but 
you’ll be required to go through the download process. 

1. Right-click the GoToMeeting daisy icon  in your system tray and select Preferences. 

2. The default setting is to automatically install updates. If you wish to disable automatic updates, 
uncheck the "Automatically install updates" check box.  

You can click learn about our latest updates to see what’s new in the latest version. 
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Steps for Installing on Windows 
When you start or join a meeting, the installation package (including applications and plugins) will be 
downloaded onto your computer. By leaving the applications installed and the plugin enabled, you will be 
able to join future meetings more quickly by avoiding the extended download process. See Join Help for 
troubleshooting information.  

Note: These instructions apply to Windows customers only; also see Steps for Installing on Macs for more information. See 
Join Help for troubleshooting information.  

About the installation package 
The installation package includes the following components:  

• GoToMeeting desktop app 
This is the main software that you use to start and join meetings.  

• GoToMeeting Launcher app 
This "helper" application is required to install and launch the GoToMeeting desktop application. It 
must be installed on the computer, even if the GoToMeeting application is already installed. 
 Note: If you remove the Launcher application at a later time, you'll need to go through the entire download process again. 
We don’t recommend that you do this if you frequently join meetings, as you will lose the benefit of faster join times.  

• Web Deployment browser plugin (optional)  
This plugin allows your web browser to automatically start the Launcher application, which in turn 
launches the GoToMeeting application. Although disabling or blocking the plugin will not prevent 
you from joining meetings, our products work best if the plugin is allowed to run when the browser 
prompts by clicking Allow, Run this time or Trust.  
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Download the desktop app 
1. Organizers can start a meeting (or attendees can join a meeting) to initiate the software download. 
Once the web browser launches, you will see the following:  

• If the Launcher application is not installed (either first time joining or it was removed), then 
the GoToMeeting Launcher.exe file will automatically start downloading. Continue to Step #2.  

• If the Launcher application is already installed, then some or all of the following steps will be 
skipped. The web browser will automatically start the Launcher app, which will then launch the 
GoToMeeting application (or install it again, if needed). The customer will not need to continue 
to Step #2, but they will see the dialogs described in Run GoToMeeting once installed.  

2. If the Launcher application is not already installed, then the GoToMeeting Launcher.exe file will 
automatically begin downloading. Depending on which web browser you are running, you can 
complete the download as follows: 

Mozilla Firefox® 

• Click Save File when prompted by the "Opening GoToMeeting Launcher.exe" dialog (click 
restart the download in the browser window if needed).  

 

• Click the Downloads button  in the toolbar, and then select the "GoToMeeting 
Launcher.exe" file.  

• Click Run if prompted.  
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 Google Chrome™ 

•  When the download finishes, click GoToMeeting Launcher file.exe at the bottom of the 
page to open the file (click restart the download in the browser window if needed).  

• Click Run when prompted.  
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Internet Explorer® 

• Click Run when prompted (click launch GoToMeeting again in the browser window if 
needed).  

 

3. The GoToMeeting Launcher application will be automatically installed, along with the Web 
Deployment browser plugin (click Yes if prompted by User Account Control). GoToMeeting will be 
automatically launched.  

 

Once the download is done, the customer will be able to join future meetings even faster! See Run 
GoToMeeting once installed for more information about joining future meetings.  

 Note: If customers remove the Launcher application at a later time, they'll need to go through the entire download process 
again. We don’t recommend that customers do this if they frequently join support sessions, as they will lose the benefit of faster 
join times.  

Run the desktop app once installed 
Once the Launcher application has been installed, customers will not need to download it again (unless 
they remove it). When these customers join a support session next, they will be prompted with additional 
dialogs from the web browser requesting permission to start the Launcher and/or GoToMeeting 
application on the customer's behalf. 

Mozilla Firefox 

If you are running Firefox, you may be prompted to choose an application to use (either the Citrix 
Online Launcher application, or the GoToMeeting application).  

1. Select the "Remember my choice for gotomeeting1468 links" check box to avoid being prompted 
by the dialog again when joining future sessions.  

2. Click OK to continue. The Launcher application will then start, as shown in Step #3 above.  
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 Google Chrome 

If you are running Chrome, it may request your permission to open an external application (i.e., the 
Launcher application or the GoToMeeting desktop application) by prompting you with an "External 
Protocol Request".  

1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted by the 
dialog again when joining future sessions.  

2. Click Launch Application to continue. The Launcher application will then start, as shown in 
Step #3 above.  
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Internet Explorer 

Customers running Internet Explorer v9 or newer will not be prompted by any additional dialogs. 
Customers running v8 or older will be prompted to manually launch the applications.  

1. Click Launch GoToMeeting in the web browser.  

2. Click Run in the Application Run dialog. The Launcher application will then start, as shown in 
Step #3 above.  
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Steps for Installing on Macs 
When you start or join a meeting, the installation package (including applications and plugins) will be 
downloaded onto your computer. By leaving the applications installed and the plugin enabled, you will be 
able to join future meetings more quickly by avoiding the extended download process. See Join Help for 
troubleshooting information.  

Note: These instructions apply to Mac customers only; also see Steps for Installing on Macs for more information. See Join Help for 
troubleshooting information.  

About the installation package 
The installation package includes the following components:  

• GoToMeeting desktop app 
This is the main software that you use to start and join meetings.  

• GoToMeeting Launcher app 
This "helper" application is required to install and launch the GoToMeeting desktop application. It 
must be installed on the computer, even if the GoToMeeting application is already installed. 
 Note: If you remove the Launcher application at a later time, you'll need to go through the entire download process again. 
We don’t recommend that you do this if you frequently join meetings, as you will lose the benefit of faster join times.  

• Web Deployment browser plugin (optional)  
This plugin allows your web browser to automatically start the Launcher application, which in turn 
launches the GoToMeeting application. Although disabling or blocking the plugin will not prevent 
you from joining meetings, our products work best if the plugin is allowed to run when the browser 
prompts by clicking Allow, Run this time or Trust.  

 

Download the desktop app 
1. Organizers can start a meeting (or attendees can join a meeting) to initiate the software download. 
Once the web browser launches, you will see the following:  

• If the Launcher application is not installed (either first time joining or it was removed), then 
the Citrix Online Launcher.dmg file will automatically start downloading. Continue to Step #2.  

• If the Launcher application is already installed, then the web browser will automatically start 
the Launcher app, which will then launch the GoToMeeting application (or install it again, if 
needed). You will not need to continue to Step #2, but you will see the dialogs described in Run 
the desktop app once installed.  

2. If the Launcher application is not already installed, the Citrix Online Launcher.dmg file will 
automatically begin downloading. Depending on which web browser you are running, you can 
complete the download as follows: 

• Apple Safari 
Double-click the "Citrix Online Launcher" file in the browser’s Downloads window  (click 
restart the download if the download doesn't start). 
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• Mozilla Firefox® 
Select "Open with" then click OK when prompted (click restart the download in the browser 
window if needed).  

 

• Google Chrome™ 
When the download finishes, click Citrix Online Launcher file.zip at the bottom of the page to 
open the file (you may need to refresh the page and/or click download & run). 

 

3. When the Citrix Online Launcher window opens, double-click the Launcher icon .  

 

4. You will see a message noting that "Citrix Online Launcher" is an application downloaded from the 
internet. Enable the "Don't warn me [...]" check box, then click Open to continue. The GoToMeeting 
application will then finish downloading and automatically launch. Once the download is done,you will 
be able to join future meetings even faster!  

 

See Run GoToMeeting once installed for more information about joining future meetings.  
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 Note: If you remove the Launcher application at a later time, you'll need to go through the entire download process again. We 
don’t recommend that you do this if you frequently join meetings, as you will lose the benefit of faster join times.  

Run the desktop app once installed 
Once the Launcher application has been installed, you will not need to download it again (unless you 
remove it). When you next start or join a meeting, you will be prompted with additional dialogs from the 
web browser requesting permission to start the Launcher and/or GoToMeeting application on your behalf. 

• Apple Safari 
Users running Safari will not be prompted by any additional dialogs.  

• Mozilla Firefox 
If you are running Firefox, you may be prompted to choose an application to use (either the Citrix 
Online Launcher application, or the GoToMeeting application).  

1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted 
by the dialog again when joining future meetings.  

2. Click OK to continue. The Launcher application will then start. 

 

•  Google Chrome 
If you are running Chrome, it may request your permission to open an external application (i.e., the 
Launcher application or the GoToMeeting desktop application) by prompting you with an "External 
Protocol Request".  

1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted by 
the dialog again when joining future meetings. 

2. Click Launch Application to continue.  

3. Click Open when prompted. The Launcher application will then start. 
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Disable the Launcher Plugin 

Disable the Citrix Online Launcher plugin in Firefox on Windows 
1. Open Firefox. 

2. Select the Firefox menu > Add-ons. 

 

3. In the Add-ons Manager, find the Citrix Online Web Deployment Plugin. Click Disable. 

 

You can re-enable it again by clicking Enable. Please note that each time you download and execute 
the Citrix Online Launcher file, the add-on will automatically become re-enabled. 
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Disable the Citrix Online Launcher plugin in Chrome on Windows 
1. Open Google Chrome, and type chrome://plugins/ into the address bar. 

2. Find the Citrix Online Web Deployment Plugin, and click Disable. 

 

You can re-enable it again by clicking Enable. Please note that each time you download and execute 
the Citrix Online Launcher file, the add-on will automatically become re-enabled. 

Disable the Citrix Online Launcher plugin in Safari on Macs 
1. Open Finder and select the Go menu > Go to Folder. Or, press Command + Shift + G. 

2. Type ~/Library/Internet Plug-Ins and click Go. 

 

3. Delete the CitrixOnlineWebDeploymentPlugin.plugin by dragging it to the Trash on your Dock. 
You can also Ctrl + Click the plugin, and then select Move to Trash. 

You can restore it by dragging it out of the Trash, or you can Ctrl + Click the plugin from the Trash, 
and select Put Back. 

Once you remove the plugin from your Internet Plug-ins, it is removed from your Mac and from all 
other browsers on your computer. Please note that each time you launch GoToMeeting, the plugin will 
automatically become re-enabled. 
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Disable the Citrix Online Launcher plugin in Firefox on Macs 
1. Open Firefox. 

2. Select the Tools menu > Add-ons. 

3. In the Add-ons Manager, find the Citrix Online Web Deployment Plugin. Click Disable. 

 

You can re-enable it by clicking Enable. Please note that each time you launch GoToMeeting, the 
add-on will automatically become re-enabled. 

Disable the Citrix Online Launcher plugin in Chrome on Macs 
1. Open Google Chrome, and type chrome://plugins/ into the address bar. 

2. Find the Citrix Online Web Deployment Plugin, and click Disable. 

 

You can re-enable it again by clicking Enable. Please note that each time you launch GoToMeeting, 
the plugin will automatically become re-enabled. 
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Uninstall GoToMeeting 
When you start or join a session, the installation package that is downloaded onto your computer includes 
the following components: GoToMeeting desktop application, the GoToMeeting and the Web Deployment 
browser plugin. We don't recommend uninstalling any of the components of the installation package if you 
frequently start or join sessions, because they enable you to get into session faster. However, if you need 
to uninstall GoToMeeting, there are a few options for doing so.  

Uninstall manually (recommended) 
In order to completely uninstall all components of GoToMeeting, you will need to complete 3 steps: 

1. Uninstall the desktop app: The process for uninstalling a desktop application from a computer 
varies depending on the computer's operating system. See your operating system's user manual 
for more information.  

2. Uninstall the Citrix Online Launcher app: Follow the same process for uninstalling the Launcher 
app as you did for uninstalling the desktop app.  

3. Uninstall the Web Deployment browser plugin: Using Windows Explorer, go to 
C:\Users\<username>\AppData\Local\Citrix\Plugins\104 and delete the "npappdetector.dll" file.  

Example (Windows 7): Go to Windows Start  > Control Panel > Programs and Features. Right-click GoToMeeting and select 
Uninstall > Yes.  

 

Uninstall via MSI (advanced) 
Domain administrators have the ability to automatically uninstall GoToMeeting from multiple users’ 
computers by configuring the Group Policy Object they used to install. To do this, they can do the 
following: 

WARNING: This method is not recommended, as some remnants may remain after un-installation (e.g., registry keys, shortcuts on 
the users’ desktops and Start menu items). This may cause major side effects and impact future installations of GoToMeeting. 

1. Before uninstalling user assigned GoToMeeting with a Group Policy, check that the "Start Manually" 
option is enabled from the GoToMeeting user preferences – and not "Start automatically after I log in 
to Windows" (which may result in an incomplete uninstallation).  

2. Go to GPO Properties. 

3. Select the Deployment tab and select the "Uninstall this application when it falls out of the scope of 
management" check box.  
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Uninstall the Launcher application 
When you start or join a session, the installation package that is downloaded onto your computer includes 
the following components: GoToMeeting desktop application, the GoToMeeting and the Web Deployment 
browser plugin. We don't recommend uninstalling any of the components of the installation package if you 
frequently start or join sessions, because they enable you to get into session faster. However, if you need 
to uninstall the Launcher application (e.g., to do a clean re-install), you can following the directions below.  

The process for uninstalling the desktop application from a computer varies depending on the computer's 
operating system. See your operating system's user manual for more information.  

Example (Windows 7): Go to Windows Start  > Control Panel > Programs and Features. Right-click 
Citrix Online Launcher and select Uninstall > Yes.  
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Start, Schedule and Manage Meetings 
Start Instant Meetings 
You can start an unscheduled meeting any time you want using the desktop software, web account or our 
mobile apps.  

Start a Meet Now from the desktop application 

1. On a Windows computer, right-click the GoToMeeting daisy icon  in your system tray. On a Mac, 
open GoToMeeting. 

2. Select Meet Now.  

 

3. If prompted, enter your email and password, and click Log In. You can select the "Remember me 
on this computer" check box, so you don't have to keep logging in every time you want to start a 
meeting. 

 

GoToMeeting automatically launches the session with your Control Panel appearing on the right side 
of your screen.  

4. Click Invite Others on the Control Panel to send the meeting information to your attendees.  
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Start a Meet Now from the web 
1. Log in to your GoToMeeting account.  

2. On the My Meetings page, click Meet Now. 

 

GoToMeeting automatically launches the session.  

3. Click Invite Others on the Control Panel to send the meeting information to your attendees.  

Start a Meet Now from Outlook 
1. Once you've added the GoToMeeting Toolbar to Outlook, open Outlook, and select Add-Ins from 
the banner. 

2. Using the GoToMeeting Toolbar, select Meet Now.  

 

GoToMeeting automatically launches the session.  

3. An invitation email should automatically pop up in Outlook. Send the invite to your attendees.  
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Schedule a Meeting 
You can schedule meetings and start instant meetings from the GoToMeeting desktop software or by 
logging into your account online. You can also schedule recurring meetings to save your meeting for 
future use. One-time meetings automatically expire 30 days after the scheduled end time, but recurring 
meetings stay available until you delete them. 

Schedule a meeting from the desktop software 

1. Right-click the daisy icon in the system tray  (Windows) or toolbar (Mac).  

If you don't have the GoToMeeting software installed, download it first.  

 

  

2. Use the Schedule a Meeting window to specify the details of your new meeting, as follows: 

• Subject – Enter a title for the meeting.  
• Date – Select the date and time of the meeting.  
• Audio – Select the audio options that should be available to attendees. To add more international 

long-distance (toll) and/or toll-free numbers, click Edit countries to choose more countries.  
• Password – If desired, enable the "Require meeting password" check box and enter a password. 

Attendees must enter the password in order to join the meeting.  

3. If desired, enable the "Recurring meeting" check box so that you and your attendees can reuse the 
same Meeting ID and audio information until you delete it from the My Meetings page.  

4. Click Schedule when finished. The new meeting will then be available from the My Meeting page.  
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5. If you integrate GoToMeeting with an email client (like Outlook), a meeting invitation will pop up — 
send it to attendees as a calendar appointment. If you want to remind attendees of a recurring 
meeting, click Recurrence in your Outlook invitation email, or choose another calendar to remind 
attendees. 
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Schedule a meeting from the web 
1. Log in at https://secure.citrixonline.com.  

2. On the My Meetings page, click Schedule a meeting. 

 

3. Use the pop-up window to specify the details of your new meeting, as follows: 

• Subject – Enter a title for the meeting.  
• Recurrence – Select whether the meeting occurs once or more using the drop-down menu. 
• Date – Select the date and time of the meeting.  
• Audio tab – Select the audio options that should be available to attendees. To add more 

international long-distance (toll) and/or toll-free numbers, click Edit countries to choose more 
countries.  

• Co-organizers tab – If desired, enter the name or email address of attendees whom you would 
like to become co-organizers of the meeting.  
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• Password tab – If desired, enable the "Require meeting password" check box and enter a 
password. Attendees must enter the password in order to join the meeting.  

4. Click Save when finished. The new meeting will then be available from the My Meeting page.  

 

5. In the Invite people window, click Copy to copy the information to your clipboard and paste it into an 
email, calendar invitation or web page. 
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Start a Scheduled Meeting 
You can start a scheduled session from the web or from your desktop if you have GoToMeeting installed. 
You can also start a meeting from Google Calendar if you have the GoToMeeting extension installed. 

Start a scheduled meeting from the desktop application  
1. If you already have GoToMeeting installed on your computer, you can right-click the GoToMeeting 
daisy icon  in your system tray, and select My Meetings.  

 

2. If prompted, enter your email and password, and click Log In.  

3. Click Start next to the session you want to begin hosting. 

You should see the Control Panel on the right side of your screen, which you can use to manage the 
meeting. 

Start a scheduled meeting from the web 
1. Log in to your GoToMeeting account.  

2. On the My Meetings page, click Start next to the meeting you want to host. Or, on a Windows 
computer, you can right-click the GoToMeeting daisy icon  in the system tray, and select My 
Meetings > Start. 

3. To start the meeting, enter your email address and password, and then click Log In. You should 
see the Control Panel on the right side of your screen, which you can use to manage the meeting. 
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Start a scheduled meeting from Google Calendar 
1. In Google Calendar, open the meeting you want to start.  

2. Click Start Meeting. 

 

3. For GoToMeeting Free, and if you are already logged in to GoToMeeting, the meeting starts. The 
GoToMeeting  Control Panel displays on the right side of your screen, which you can use to manage 
the meeting. Otherwise, login to start the meeting. 
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Edit a Scheduled Meeting 
You can edit a scheduled meeting any time before the start time by simply opening the GoToMeeting 
desktop application and clicking My Meetings or by logging in to your account from the web and selecting 
the meeting you want to edit. If you decide to change the date and time of the meeting, remember to 
notify your attendees of the change – the easiest way to let your attendees know of any changes is to 
send out a new invitation email.  

After 30 days past the scheduled end time, your session will expire, and you won't be able to start or edit 
it. You will need to schedule a new meeting and send the new invite to your attendees.  

Edit a scheduled meeting from the desktop application 

1. On a Windows computer, right-click the GoToMeeting daisy icon  in your system tray. On a Mac, 
open GoToMeeting, and select My Meetings. Your scheduled meetings will be displayed.  

2. If prompted, enter your email and password, and click Log In.  

3. Select the meeting you want to edit, and then click Edit. 

4. Make your changes, and click Save. 

5. Be sure to contact any previously invited attendees to notify them of the change. If you reschedule 
a meeting, remember to update your calendar appointment, or send a new invitation email to your 
attendees.  

  

 

Edit a scheduled meeting from the web 
1. Log in to your GoToMeeting account.  
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2. Next to the meeting you want to edit, click the Expand icon  to open up the toolbar. 

3. Click the Edit icon  in the toolbar and make changes to the title, date/time, audio or 
password of your meeting. 

-or- 

Click the name of the meeting you would like to edit. 

 

4. Click Save to save your changes. 

5. Be sure to contact any previously invited attendees to notify them of the change. If you 
reschedule a meeting, remember to update your calendar appointment, or send a new invitation 
email to your attendees.  
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View Scheduled Meetings 
Your scheduled meetings are first displayed on the My Meetings page when you log in to your account, 
as well as in the GoToMeeting desktop application.  

View scheduled meetings from the desktop application 

1. On a Windows computer, right-click the GoToMeeting daisy icon  in your system tray. On a Mac, 
open GoToMeeting, and select My Meetings. 

2. If prompted, enter your email and password, and click Log In. 

3. The My Meetings window appears listing all your scheduled meetings. You can start, edit or delete 
a meeting, as well as schedule new meetings.  
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View scheduled meetings from the web 
1. Log in to your GoToMeeting account.  

2. The My Meetings page displays a list of your scheduled meetings, along with meetings that are 
currently in-session. The meeting subject, start date and start time are displayed.  
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To view the Meeting Invitation, click Expand icon  and then the Invite icon  . You can click 
Copy Invitation to copy the invitation and send it to attendees.  
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Add a Custom Logo  
You can add a custom logo to your meetings, which attendees will see when a screen is not being 
shared.  

 

Upload a custom logo for meetings 
1. Log in to your online account.  

2. Click the Menu icon  in the top navigation, then select Settings.  

3. On the Settings page, click Upload Logo. 

 

4. Browse for and select the desired image, then click Open. Your logo can be up to 400 x 200 pixels 
and 100KB in size in either .GIF or .JPG format. 
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5. Click Save when finished.  

 

Create a Personal Meeting Room 
You can create your own personalized meeting room by reserving a URL and customizing the look and 
feel of your meeting room. Reserving a meeting room allows you to quickly launch a meeting and have 
attendees join at the same URL each time (without having to send out an invite for each meeting), which 
is ideal for recurring or spur-of-the-moment meetings.  

Note: The GoToMeet.Me program is currently in beta. Customers with GoToMeet.Me pages will notice many changes as the beta 
development progresses. If you attempt to sign up using your existing GoToMeeting credentials but encounter a login error 
prompting you to check your username and password, your account is not yet compatible. 
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Create a meeting room 
1. Log in to your online account.  

2. Click Settings in the right navigation.  

3. Under "Meeting room", click Let's get started!. 

 

4. Choose a name for your meeting room; this name will appear at the end of the 
URL "https://gotomeet.me/<your meeting room>". If the name is available, you will see a check mark 
next to the box. If the name is already taken, you will see a message telling you to enter a different 
name. 

5. Click Reserve when finished, then customize your new meeting room! 

 

Customize your meeting room 
1. Log in to your online account.  

2. Click Settings in the right navigation, then click Edit next to your meeting room URL.  

3. A pop-up window will provide you will the following customization options: 
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• Profile tab – Change the URL or name of the meeting room, enter personal information about 
yourself and choose a color theme. You can also click the Avatar icon  to upload a picture for 
the meeting room.  

• Audio tab – Select the audio options that should be available to attendees joining your meetings.  
• Co-organizers tab – Add co-organizers to you meeting room, which will allow them to launch the 

meeting on your behalf.  
• Password tab – If desired, you can require that attendees enter a password to join your meeting.  

 

4. Click Preview to see what your meeting room will look like with the changes you made.  

 

5. Click Save when finished. Go to your meeting room to see how it looks! 
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Change your meeting room's URL 
1. Log in to your online account.  

2. Click Settings in the right navigation, then click Edit next to your meeting room URL.  

3. On the Profile tab, change the URL of the meeting room. This will free up your former URL for 
another GoToMeeting user.  

4. Click Save when finished.  

 

Start your personal meeting 
1. You can start your personal meeting room in either of the following ways: 

• On the My Meetings page, click Start your meeting.  

 

• Go to the URL of your personal meeting room, then click Join my meeting > Start the meeting. 
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2. The GoToMeeting desktop app will automatically launch (or begin downloading if you do not have it 
installed on that computer). 

Invite others to join your meeting room 
1. On the My Meetings home page, click Share.  

2. Click Copy to copy the meeting information to your clipboard and send it to attendees as desired.  

You can also simply direct attendees to open a web browser and go to your personal meeting room's 
URL.  
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Embed a Meet Now Button on Your Website 
You can embed a GoToMeeting "Meet Now" button onto your website, so your attendees can easily join 
scheduled or instant meetings. Just copy any of the HTML codes below and paste it into the source code 
of the web page where you'd like to embed the button. 

Add a Meet Now button 
1. Copy any of the HTML codes below and paste it into the source code of your web page. 

Large Gray Button 

 
<a href="https://www.gotomeeting.com/join"><img 
src="http://www.citrixonlinecdn.com/dtsimages/im/support/en/Large_160X80.png" width="160" 
height="80" border="0"></a> 

  

Small White Button 

 
<a href="https://www.gotomeeting.com/join"><img 
src="http://www.citrixonlinecdn.com/dtsimages/im/support/en/Small_120X60.png" 
width="120" height="60" border="0"></a> 

  

Gray Button with Meeting ID Field 

 
<script src="http://www.citrixonlinecdn.com/dtsimages/im/support/en/meetNowG.js" 
language="javascript" type="text/javascript"></script> 

  

White Button with Meeting ID Field 
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White Button with Meeting ID Field 

 
<script src="http://www.citrixonlinecdn.com/dtsimages/im/support/en/meetNowW.js" 
language="javascript" type="text/javascript"></script> 

  

2. Schedule a meeting or start an instant meeting. Then invite attendees to join your meeting. 

3. You can then instruct your attendees to visit your website and click the Meet Now button to join the 
meeting. They can also join by clicking the Join URL from the invite.  

• If your attendees click one of the buttons without the Meeting ID field, they'll be redirected to the 
Join a Meeting web page where they can enter the 9-digit Meeting ID and click Join a Meeting 
to enter.  

 

• If your attendees click one of the buttons with the Meeting ID field, they should be seamlessly 
launched into the meeting after entering the Meeting ID.  
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View Meeting History 
You can view meeting history data to see information on your past meetings (date, time, title, duration 
and attendees). Meeting history data is stored for 90 days after a meeting's scheduled end date. If you're 
on a GoToMeeting corporate plan, meeting history is stored for up to 12 months. 

View Meeting History 
1. Log in to your GoToMeeting account.  

2. On the My Meetings page, click the Meeting History column.  

3.You can use the dates at the top of the page to select a date range for past meetings. 

 

View Attendee Details 
1. On the Meeting History column, select the number in the Attendees column to view attendee details 
(i.e., name, email address and join and leave times) for a session. 
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2. To export the attendee data to Excel (.XLS), click the Export to Excel button. 
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Cancel a Meeting 
You can edit or delete a scheduled meeting from the GoToMeeting desktop application or from the web. 

Cancel a scheduled meeting from the desktop application 

1. On a Windows computer, right-click the GoToMeeting daisy icon  in your system tray. On a Mac, 
open GoToMeeting, and select My Meetings. Your scheduled meetings will be displayed.  

2. Select the meeting you wish to delete. 

3. Select Delete. When prompted to delete the meeting, click OK. Remember to manually delete the 
meeting from your calendar.  
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Cancel a scheduled meeting from the web 
1. Log in to your GoToMeeting account.  

2. Click the Expand icon  to open up the toolbar next to the meeting you would like to cancel. 

3. Select Trash icon  .  

4. Click the Yes on the Delete Meeting dialog. Remember to cancel or delete the meeting from your 
calendar. 
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Join Sessions 
Join a Session 
You can join meetings from the web, desktop software or a mobile device! 

Join a session from a computer 
1. Access the meeting in any of the following ways: 

• Invitation email 
Select the Join URL in your Invitation email. This will launch a new web browser page. 

 

• Web browser 
Open a web browser and go to the Join the Meeting  page. Enter the meeting ID (listed in your 
Invitation email), then click Continue.    
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• Desktop software 
Right-click the daisy icon in the system tray  (Windows) or toolbar (Mac).  Select Join, enter 
the meeting ID (listed in your Invitation email), and click OK. 

Note: This method is only available if you already have the GoToMeeting desktop software installed on your computer.  

 

2. Depending on the organizer's account settings (as well as your operating system and web browser), 
you will be launched into session via the web app or via the desktop software. The desktop software 
will be automatically installed if needed. 

Note: If you have not yet done so, you will first be prompted to register for the active meeting. 

3. Once you're in session, choose one of the audio options provided by the organizer to connect to the 
audio conference. You can choose your preferred audio option from the Audio pane of your Control 
Panel. 

Join from a mobile device 
1. Access the meeting in either of the following ways: 

• Invitation email 
Select the Join URL in your Invitation email. This will automatically launch the mobile app (or 
the app store if you have not yet installed it onto your device).  

• Mobile app 
Open the GoToMeeting app, enter the meeting ID and select Join. Alternatively, you can select 
the scheduled meeting from the list that is imported from your phone's calendar (if available).  
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2. You will be automatically launched into session. If you have not yet installed the mobile app, you 
will be instructed to do so. See the following articles for more information: 

• Download the GoToMeeting app for iOS on the App Store. (See FAQs for more information.) 
• Download the GoToMeeting app for Android on Google Play . (See FAQs for more information.) 
• Download the GoToMeeting app for Windows Phone in the Windows Phone store. (See 

GoToMeeting FAQs for more information.) 

GoToMeeting Web App 
Using the GoToMeeting Web App, you can join meetings entirely within your web browser (rather than 
installing and using the GoToMeeting desktop app). This provides you with the following advantages: 

• You can get into meetings even faster than with the desktop app (great for when you need to 
quickly touch base and share your screen). 

• If you have software-installation restrictions (e.g., using a company computer or net kiosk), you can 
still quickly and easily join sessions. 

• You can easily switch to the full-featured desktop app if you want to use additional features. 
• If you are running an operating system that isn't supported by the desktop app (e.g., Linux, Google 

Chrome OS, Windows XP or older), you can join sessions entirely within your web browser.  
Note: Once you have switched to the desktop app, you will then use it to join subsequent sessions directly rather than first joining 
via the Web App.  

 

Web app features and tools 
You can use the following features and tools when you join a session from the Web App. 

• Join instantly without going through a download or installation. 
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• View the presenter's shared screen. 
• View webcams being shared by other attendees.  
• Share your own screen (if made presenter).* 
• Connect to the audio conference using your computer's mic and speakers.* 
• Connect to the audio conference by dialing in via phone. 
• Send chat messages to other attendees (either privately or to everyone). 
• Mute and unmute yourself, and see which attendees are speaking. 
• Change the language of the web app. 

Note: The availability of these features depends on the attendee's web browser. Items marked with an asterisk (*) are only available 
attendees running Chrome. 

Enable/disable the web app 
Organizers must have the Web App enabled in order to provide attendees the ability to join via their web 
browsers. Once it is enabled, all attendees who do not have the desktop app or the Citrix Online 
Launcher application installed on their computer will automatically join sessions via the Web App. 

1. Click Settings in the right navigation. 

2. In the "Web app" section, enable or disable the "Attendees will join meetings from the web app" 
check box. 

3. Click Save when finished.  

Note: Any change to this setting will affect all future sessions, including those that have already been scheduled. 

 

Join a session via Web App 
When Web App has been enabled, GoToMeeting will automatically detect the optimal join method for 
each attendee. 

• If you already have the desktop app or the Citrix Online Launcher application installed, then 
you will join the session using the desktop app (an updated version will be downloaded if needed). 

• If you have neither of those applications installed, then you will join directly through your web 
browser using the Web App. 

• If you cannot install software on your computer, then you will join the session directly through 
your web browser using the Web App. 

See the GoToMeeting Web App FAQs for more information and system requirements. 
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Connect to session audio 
1. The first time you join a session via web app, you will see a "Select audio" pop-up. You can then 
select either Use computer audio (VoIP) or Dial in using a phone (depending on the audio options 
provided by the organizer). You can switch audio modes at any time during the session. 

Note: You will only see this prompt the first time you join. The web browser will then remember your selection for future 
sessions. 

 

Join via mic and speakers (VoIP) 

Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to 
Chrome or download the desktop app in order to use it.  

• If you select Use computer audio, you will be prompted to allow the browser to use your 
microphone. Click Allow to continue. 

 

• You will then see a "computer audio" pop-up window. You can select which device to use as your 
mic, then click OK, I'm all set to join the meeting. 
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Join via phone 

• If you select Dial in using a phone, you will see "call in" information. You can select the desired 
country, use a telephone to dial in to the audio and then click OK, I'm all set. 
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Mute/unmute yourself 
You can easily mute or unmute yourself at any time in either of the following ways: 

• Click the Audio button  in the right navigation. It will turn red  when muted and green when 
unmuted  (i.e., others can hear you). 

• Click the Attendees icon  in the right navigation, then select your own name and click Mute me. 

 

  

Switch audio modes (mic/speakers vs. phone) 
Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to 
Chrome or download the desktop app in order to use it.  

You can switch between using your mic and speakers (VoIP) and dialing in via phone at any time.  

1. Click the Settings icon  in the right navigation. 

2. On the Audio tab, select one of the following (depending on what options the organizer provided): 

• Computer Audio – Use the drop-down menu to select which device to use as mic and speakers.  
• Phone call – Use the drop-down menu to select which country's audio information should be 

displayed. 
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Chat with other attendees 
You can send instant chat messages to other attendees during the session.  

1. Click the Chat icon  in the right navigation.  

2. Use the drop-down menu to select the recipients of your message (everyone, organizers only, 
presenters only or a specific attendee). 

3. Enter your message in the text field, then click Send. 
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Enable/disable speaker notifications 
The web app displays a notification in the top right that indicates who is speaking. You can turn these 
notifications on or off.  

1. Click the Settings icon  in the right navigation. 

2. On the General tab, use the Speaker Notifications toggle to turn notifications on or off.  

3. If desired, you can change the opacity of the notification itself so that it doesn't obscure the 
presenter's screen. 
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Share your screen (become presenter) 
Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to 
Chrome or download the desktop app in order to use it.  

You can share your own screen (or a particular application) with the rest of the meeting participants.  

1. An organizer must first give you presenter control.  

2. You will be notified that you have been given presenter control and that in order to share your 
screen you must first install an extension. Click Download to continue.  

 

3. You will be prompted to download the GoToMeeting Pro Screensharing extension. Click Add to 
continue. 

 

4. Once the extension is successfully installed, you will be prompted to select which portion of your 
screen to share – either their your screen, or a particular application (all applications currently running 
will be shown). Click Share to continue. 
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5. While your screen is being shared, you will see a pop-up window reminding you that other 
attendees can see your screen. You can click Hide to minimize the window if desired. 

 

6. You can click Stop Sharing on the pop-up window to stop sharing your screen. 

Change your name and email address 
You can change the name displayed to other attendees in the Control Panel. 

1. Click the Attendees icon  in the right navigation.  

2. Click the Arrow icon next to your name and select Edit name & email. 

3. Enter your desired name and email, then click OK. 
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Change the web app's language 

1. Click the Settings icon  in the right navigation. 

2. On the General tab, use the drop-down menu to select the desired language.  

 

Switch to the desktop app 
You can easily switch to the desktop app to use all of the features that GoToMeeting offers. 

1. Click the Daisy icon  in the right navigation. 

2. Click Switch to the desktop version. The download will begin immediately; see Steps for Installing 
on Windows or Steps for Installing on Macs for more information. 

Note: Once you have switched to the desktop app, you will then use it to join subsequent sessions directly rather than first 
joining via the Web App.  
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Limitations of the Web App 
While the Web Appallows attendees to use many of the same features and tools as the GoToMeeting 
desktop app, there are some features that are not supported. To use any of these features, attendees can 
simply Switch to the desktop app while in session.  

Note: Once attendees have downloaded the desktop app, they will join all future sessions using the desktop app (unless they 
uninstall both it and the Citrix Online Launcher application).  

• Organizers cannot host sessions using the Web App. 
• Attendees cannot be promoted to organizer (though they can be promoted to Presenter).  
• Attendees cannot take control of the presenter's mouse and keyboard. 
• Attendees cannot use drawing tools. 
• Attendees cannot share their own webcams. 
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Join Help 
If you are having trouble joining a meeting, see below for some common troubleshooting information. For 
detailed instructions on installing a meeting, please see the Install on Windows and Install on Mac 
articles. 

I can't join a meeting. 
If you're having trouble joining a meeting, then try the following troubleshooting steps: 

• Make sure that you have gone through the join steps described in the Install the Desktop 
Application on Windows and Install the Desktop Application on Mac articles. These detailed 
instructions will ensure that all three components of the installation package are downloaded onto 
your computer, including the Launcher application, GoToMeeting desktop application and Web 
Deployment plugin.  

• Try uninstalling both the GoToMeeting desktop application and the Launcher application so that 
you can start fresh, then go through the join steps described in the Install the Desktop Application 
on Windows and Install the Desktop Application on Mac articles again.  

• How to Uninstall GoToMeeting from a PC 
• How to Uninstall GoToMeeting from a Mac 

• If that doesn't work, try rebooting your computer. Often this will resolve many issues you may be 
experiencing by resetting the current state of your software and starting over again. 

• If you still have trouble joining a meeting, please contact Citrix Customer Care. 

When I try to install GoToMeeting, nothing happens.  
If you're having trouble installing the GoToMeeting desktop application, then try the following 
troubleshooting steps: 

• The GoToMeeting application may be minimized or hidden behind other application windows. 
Check the Task Bar (Windows) or Dock (Mac) at the bottom of the screen for the GoToMeeting 
daisy icon, then click on it to expand the Viewer and Control Panel and see the in-session meeting.  

 

• If you're sure it didn't install properly, make sure you're following the steps for the specific web 
browser you're using. Please see the Install the Desktop Application on Windows and Install the 
Desktop Application on Mac articles for more detailed instructions about downloading with each 
web browser.  

• When you install using Internet Explorer, you should see a prompt at the bottom of the 
screen that says "Do you want to run or save GoToMeeting Launcher.exe from 
download.citrixonline.com?". You'll need to click Run to continue. 

• When you install using Firefox, you should see one of the following pop-up windows: 
• If an "Opening GoToMeeting Launcher.exe" pop-up window asks you if you would 

like to save the file, you'll need to click Save File to continue.  
• If a "Launch Application" pop-up window asks you to choose an application, you'll 

need to click OK to continue.  
• When you install using Chrome, you should see one of the following options: 

• If no pop-up window appears, you should see a GoToMeeting Launcher.exe button 
appear at the bottom-left of the browser window. You'll need to click it to continue.  

• If an "External Protocol Request" pop-up window appears, you'll need to click 
Launch Application to continue.  
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• When you install using Safari, you'll need to double-click the "Citrix Online Launcher" file 
in the browser’s Downloads window to continue.  

• If you have previously joined a meeting, webinar or training from the same computer, Internet 
Explorer may redirect you to the Connected to GoToMeeting page without showing the prompt at 
the bottom of the page. In this case, try clicking launch GoToMeeting again on the “Connected to 
GoToMeeting” page to prompt a manual download. 

 

• The web browser version that you are using may be outdated and not supported by GoToMeeting 
(see the system requirements for more information). Try joining from another web browser, or 
update to a newer version of your current browser:  

• Update Internet Explorer 
• Update Mozilla Firefox 
• Update Google Chrome 
• Update Apple Safari 

• If you still have trouble joining a meeting, please contact Citrix Customer Care. 

I can see the meeting on my computer but I cannot hear anything.  
You may not have the right settings selected for the type of audio that your organizer provided (i.e., 
dialing in via phone vs. using your computer's mic and speakers). Please see the Audio and Audio Help 
articles for more detailed information. 

I can hear audio from my computer but I cannot see anything. 
If you are hearing the audio of your session through your computer speakers but cannot see the 
presentation, the Viewer window is likely minimized. 

• The GoToMeeting application may be minimized or hidden behind other application windows. 
Check the Task Bar (Windows) or Dock (Mac) at the bottom of the screen for the GoToMeeting 
daisy icon, then click on it to expand the Viewer and Control Panel and see the in-session meeting.  
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I get a "Could not Connect" error when I try to join a session. 
If you have a security program or firewall on your Windows computer that blocks connection with 
applications, you may need to manually enable GoToMeeting to join sessions. You may do this by 
opening your security software and accessing its firewall settings. Most security programs will allow you to 
configure access for specific programs in their firewall settings. To configure the firewall to allow 
GoToMeeting, look in the program rules for g2mcomm.exe and set it to “Allow” or “Full Access”. 

 

For more targeted assistance, please visit the support site of the manufacturer of the security program 
that you have installed on your computer: 

• avast! 
• AVG 
• Kaspersky 
• McAfee 
• Norton 
• Trend Micro 
• VIPRE 
• Webroot 
• Zone Alarm 

I can't use GoToMeeting with a firewall, anti-virus program or anti-spyware. 
If you have a security program or firewall (such as Norton or McAffee) on your Windows computer that 
blocks connection with applications, you may need to manually enable GoToMeeting to join sessions. 
You may do this by opening your security software and accessing its firewall settings. Most security 
programs will allow you to configure access for specific programs in their firewall settings. To configure 
the firewall to allow GoToMeeting, look in the program rules for g2comm.exe and set it to "Allow" or "Full 
Access." 

Configure firewalls on your computer. 
1. Host or join a session to set off your firewall.  

2. When prompted to enable GoToMeeting to access the Internet, click Yes. Then select the 
"Remember the answer each time I use this program" check box.  
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3. Open your anti-virus program to allow it to accept all GoToMeeting files. The following must be 
admitted via 1 of 3 ports: 80, 443 or 8200. One-way TCP connectivity is required (TCP outbound).  

g2m_download.exe G2MStart.exe G2MChat.exe 
AppCore.exe G2MLauncher.exe G2MQandA.exe 
G2MInstallerExtractor.exe G2MTesting.exe G2MSessionControl.exe 
G2MCoreInstExtractor.exe G2MMaterials.exe G2MMatchMaking.exe 
G2MCodecInstExtractor.ex
e 

G2MPolling.exe G2MRecorder.exe 

G2MInstHigh.exe G2MView.exe G2MTranscoder.exe 
G2MInstaller.exe G2MUI.exe G2MFeedback.exe 
G2MUninstall.exe G2MComm.exe G2MHost.exee 

Configure firewalls within a corporate environment. 
If you're using a firewall in a corporate environment, you may have a hardware firewall. Instruct your IT 
department to read the Optimal Firewall Configuration Fact Sheet to allow GoToMeeting to connect. 

Join a Session FAQs 
Review frequently asked questions on joining a session. 

How do I join a session? 
Open your GoToMeeting invitation emails, and click the Join URL. Or, you can visit the Join a Meeting 
page, and enter your 9-digit Meeting ID from your invite.  

Do I need a  account to attend a session? 
No, you don't need a  account to attend a  session.  

What are the system requirements for attending a session? 
• Internet connection  
• Windows® 8, 7, Vista, 2003 Server or XP  
• Mac OS® X 10.6 (Snow Leopard®) or newer 
• iOS 6 or newer 
• Android 2.2 or higher 
• Internet Explorer® 7.0 or newer 
• Mozilla® Firefox® 4.0 or newer  
• Safari™ 3.0 or newer 
•  Google Chrome™ 

See the full  System Requirements for more information. 

Can I attend a GoToMeeting session from an iPad, iPhone or iPod touch? 
Yes, you can attend sessions on your iPad, iPhone, or iPod touch as an attendee only. You won't have 
the ability to share your screen if given presenter control. 
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Can I attend a GoToMeeting session from an Android smartphone or tablet? 
Yes, you can attend sessions on your Android smartphone or tablet as an attendee only. You won't have 
the ability to share your screen if given presenter control. 

Can I view presentations in full-screen mode? 
Yes. On the top of the Attendee Control Panel, select the View menu > Full Screen. Or, you can click 
the View button on the Grab Tab to toggle between Full Screen and Window mode. 

  

GoToMeeting Web App FAQs 
Review frequently asked questions about attending meetings via the web app. Also see GoToMeeting 
Web App for more information. 

What is the GoToMeeting web app? 
You can use the GoToMeeting web app to join sessions through your web browser (rather than joining via 
the GoToMeeting desktop app). See GoToMeeting Web App for more information.  

Can I also host meetings with the web app? 
No. The web app is only for attendees who are joining the session; organizers must use the desktop app 
to host meetings. 

Can I tell if my account is enabled for web app? 
Yes. Log in to your account, click Settings in the right navigation and look under the "Web app" section. If 
the "Attendees will join meetings from the web app" check box is enabled, the your attendees can join via 
web app. If it is disabled, then you will need to enable it in order to have attendees join via web. 

 

Is the web app experience different from the desktop app experience? 
Yes. Unlike the GoToMeeting desktop app, the GoToMeeting web app runs entirely in the attendee's web 
browser and does not require any download or installation. Like the desktop app, the web app also has a 
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collapsible Control Panel that appears at the right of the screen and provides attendees with various 
features and tools (including chat, mute and language settings).  

While the web app allows attendees to use most of the same features and tools as the desktop app, there 
are some features that are not supported. See "Limitations of the web app" under GoToMeeting Web App 
for more information. 

Can an attendee select the web app over the desktop app? 
If an attendee already has GoToMeeting installed, they will have to uninstall both the application and the 
Citrix Online Launcher in order to use Web App. 

Can I tell which attendees have joined with the web app? 
Yes. You can easily see which attendees have joined via web app by checking the Attendee pane of the 
Control Panel. Attendees who have joined via web app will have the text "(web)" next to their name. 

 

Can web app attendees share their screen? 
Yes. Web app attendees can be promoted to presenter and share their own screen. They will need to 
install the GoToMeeting Pro Screensharing extension in order to do so. 

Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to 
Chrome or download the desktop app in order to use it.  

Can web app attendees join the audio conference using VoIP? 
Yes. Web app attendees can use their computer's mic and speakers to join the audio conference (VoIP). 

Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to 
Chrome or download the desktop app in order to use it.  

Can web app attendees join the audio conference by dialing in via phone? 
Yes. Web app attendees can dial in by phone in the same way as with the desktop app. Organizers can 
provide long-distance (toll), toll-free and third-party phone numbers for attendees. 

Can web app attendees be muted by the organizer? 
Yes. If web app attendees connect to audio via VoIP or dial in via phone and use the audio PIN, then the 
organizer can mute them. If they do not use the audio PIN to identify themselves, then the organizer will 
not be able to mute them.  
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What are the system requirements for the web app? 
In order to join meetings via Web App, the following must be true on the attendee's computer: 

•  Internet Explorer 8.0 or newer or Safari 5.1 or newer with Flash Player 10.2 or newer and 
JavaScript enabled. 

•  Firefox 24 or higher and Chrome 31 and higher. 

Does the web app work on Mac or Linux systems? 
Yes. The GoToMeeting Web App works on Mac systems that meet the above requirements. Although the 
GoToMeeting Web App does not officially support Linux, it may also work on Linux systems that meet the 
above requirements.  

Note: Because Linux is not officially supported by GoToMeeting, the Global Customer Support team will be unable to troubleshoot 
any Linux joining issues.  

Does the web app work with mobile devices? 
No. The web app can only be used for desktop computers, but the GoToMeeting apps for iOS, Android 
and Windows Phones allow attendees to easily join sessions from their mobile devices.  

Is web app available to international customers? 
Yes, the Web App is available to both U.S. and international organizers. Attendees will see the Globe 
icon in their Control Panel, which they can click to switch their language while in session. 

Is the web app available with GoToWebinar and GoToTraining? 
Yes, GoToWebinar and GoToTraining each have their own web apps.  

Are there any security limitations with the web app? 
Just like the current version of GoToMeeting, the web app is backed by end-to-end 128-bit AES 
encryption. Attending meetings from a “locked-down” environment should be faster and easier since a 
download is not required when using the web app.  

Note: Some proxies and firewalls may prevent the Web App from launching. 
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In-Session Features 
New Control Panel and Viewer 
When you start or join a session, the Control Panel provides you with access to the in-session features 
and tools that GoToMeeting offers. The new Control Panel allows you to customize GoToMeeting to your 
own style and preference, including collapsing and rearranging the panes to whichever order works best 
for you and easily separating out some or all panes so that you can re-size them and move them where 
you want.  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

 

Feature comparison: original design vs. new design 
The new Control Panel and Grab Tab have the same functionality as the original design, just with an 
updated look and increased prominence of important features. Check out a side-by-side comparison 
below! 
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Control Panel 

 

(a) Session controls: The most important features for controlling your session have been 
consolidated into 3 buttons and 2 tabs for easy access: 
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• Share Your Screen – Share your desktop, an application or a document with attendees.  
• Share Your Webcam – Preview your webcam before sharing with others, then turn on your 

webcam to work face to face with attendees. 
• Change Presenter – Change presenters so that an attendee or co-organizer can share their own 

screen.  
• Give Keyboard and Mouse Control – Share keyboard and mouse control with other attendees 

while you are sharing your screen.  

(b) Audio controls: You can still control your audio mode in the same way as before: 

• Connect to Session Audio – Switch between computer audio and dialing in via phone and access 
the Sound Check.  

• Manage In-Session Audio – Manage the audio controls (e.g., on-hold beeps, entry/exit chimes). 

(c) Attendee controls: You can still view and manage attendees in the same way as before: 

• View and Manage Attendees – View the names of all individuals participating in the session, as 
well as access mute controls and other options.  

• Invite Others – Invite attendees to join while you are in an active session. 
• Add Co-Organizers – Make someone a co-organizer so that person can have full control over the 

session and/or continue running the session after you leave.  

(d) Chat: You can still exchange instant chat messages with other attendees in the same way as 
before: 

• Send Chat Messages – Send and receive public or private Chat messages. 

(e)  Recording controls: You can still start, pause and stop recording in the same way as before: 

• Record a Session – Record the presenter's screen, audio and shared applications during a 
session, then upload and store the recording for people to view. 

(f) Additional features: The File, Options, View and Help options have been consolidated into the 
GoToMeeting drop-down menu: 

• Use Drawing Tools – Use drawing tools to draw on your shared screen and better illustrate 
points.  

• Try Labs Features – Try out some of our beta features while in session. 
• Share a Video – Stream video and it's accompanying audio from your computer and broadcast it 

to attendees while in a session. 

Grab Tab 
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(a) Expand/minimize: You can still expand the Grab Tab into the Control Panel in the same way as 
before. 

(b) Session controls: The most important features for controlling your session can still be accessed 
on the Grab Tab. Simply hover over the Screen and Webcam buttons to see the Pause/Start controls. 

(c) Additional features: Rather than including specific buttons, the new Grab Tab allows you to click 
the Daisy icon to access drawing tools, Labs and other features. 

(d) New feature! This Grab Tab allows you to separate out the Attendees and Chat panes directly 
from the Grab Tab while keeping the rest of the Control Panel minimized. 

Collapse, rearrange or separate panes 
You can customize the layout of the Control Panel to your own style by taking apart the panes and laying 
them our on your desktop as you prefer.  

• To separate a pane from the Control Panel, simply click the pane and drag it away from the 
Control Panel. You can then re-size it and drag it around your desktop independently of the Control 
Panel.  

 

• To rearrange the panes within the Control Panel, click and drag a pane to the desired location. 
You will see a highlighted indicator while dragging.  
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• To separate a pane from the Grab Tab, click the Attendee  and/or Chat  icons to make the 
separate panes appear. If you expand the Grab Tab into the full Control Panel, the pane(s) will 
remain separated.  

• To return a pane to the Control Panel or Grab Tab, click the Close button  at the top of the 
separated pane.  

Switch between Control Panel and Grab Tab 
Even when the Control panel is minimized into the Grab tab, the most critical features remain accessible 
with just one click: Mute, Share Screen and Share Webcam. 

• To shrink the Control Panel into the Grab Tab, click the Shrink icon  in the top navigation. 
• To expand the Grab Tab into the Control Panel (e.g., show all panes), click the Expand button 

 on the far right.  
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Rearrange webcams and Presenter's screen in the Viewer 
When a presenter is sharing their screen and at least one attendee is sharing their webcam, you can 
rearrange the windows within your Viewer so you can focus on what's important to you. 

• When you click the Enlarge icon  for an item currently in the sidebar, it will be swapped out with 
the featured item (i.e., the currently featured item will move to the sidebar and will be replaced by 
the selected item). 
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• When you click the Shrink icon  for an item currently being featured, it will move into the sidebar 
and no other item will replace it (i.e., there will be no featured item, and all items will appear in the 
sidebar). 

 

© 2015 Citrix Systems. All rights reserved. 113 



GoToMeeting User Guide 

Original Control Panel and Viewer (Windows) 
When you start or join a session, the Control Panel provides you with access to the in-session features 
and tools that GoToMeeting offers. 

Note: If you are running Windows and your Control Panel looks different than the one shown below, please see New Control Panel 
and Viewer. 
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Session Controls 
• Share your screen: Broadcast your screen or an application to attendees during a session using 

the Start , Pause  and Stop  buttons in the Screen Sharing pane. You can choose what part 
of your screen to share using the "Show My" drop-down menu. 

• Give keyboard and mouse control: Allow other attendees to share control of your screen while 
presenting. Use the Give Keyboard and Mouse button  to grant access to attendees.  

• Change Presenter: Allow other attendees to broadcast their own screens to attendees. Use the 
Change Presenter button  to select a new presenter.  

• Record a session: Record the presenter's screen and all audio during a session. Use the Start 
Recording button to record a session.  

 

• Share webcams: Broadcast your webcam to other attendees while in session. Use the Share My 
Webcam button or Webcams drop-down menu to start or stop sharing your webcam.  

 

Audio Controls 
• Change audio mode: Choose whether to dial in via phone or connect to the audio with your 

computer's mic and speakers.  
• Manage beeps and chimes: Enable or disable the on-hold beeps (which play until another 

attendee joins) and the entry/exit chimes (which play whenever an attendee joins or leaves the 
session).  

• Talking notification: See which attendee is currently speaking.  
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Attendee Controls 
• Mute controls: Mute or unmute other attendees by right-clicking their name and selecting Mute 

<attendee>, or mute/unmute all attendees at once using the buttons . 
• Promote to organizer: Make an attendee a co-organizer of a meeting by right-clicking their name 

and selecting Make Organizer.  
• Hide Attendee/Chat panes: Hide the Attendee and/or Chat panes from some attendees by right-

clicking their name and selecting the appropriate menu item(s). 
• Use drawing tools: Allow another attendee to use drawing tools by right-clicking their name and 

selecting Allow Drawing. 
• Invite attendees: Invite other attendees to join the session by clicking the Invite Others button 

.  
• Dismiss attendees: Dismiss an attendee from the session by right-clicking their name and 

selecting Dismiss <attendee>. 

 

Additional Features 
• Chat: Use the Chat pane at the bottom of the Control Panel to exchange instant messages with 

other attendees, either privately or to the entire audience. You can also save the chat log using the 
File menu. 

• Drawing tools: Annotate directly on your screen to highlight or call attention to certain parts of the 
shared screen by clicking the Drawing Tools button  in the Grab Tab. 

• Labs: Experiment with various beta features that you can use to enhance your meeting, which you 
can access under File > Labs.  

• Modify info: You can edit your own name and email address or the meeting subject using the File 
menu. 

• Preferences: Access the GoToMeeting preferences under the File menu. 
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Invite Others 
You can invite attendees to join your session either before or during the session.  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

Invite attendees while in session 
1. In the Attendees pane, click the Invite icon .  

 

2. Use the Invite Others window to invite an individual in any of the following ways: 

• Instruct the individual to go to www.joingotomeeting.com and enter the Meeting ID listed in the 
window.  

• Click Email to launch a new email with the session information automatically populated, then 
send it to the individual. 

• Click Copy to Clipboard to copy the session information to your clipboard, then paste it 
wherever desired (such as an instant message to the individual). 
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Invite attendees before a session 
1. Log in to your online account.  

2. On the My Meetings page, click the Invite icon  next to the desired session. 

 

3. Click Copy to Clipboard to copy the session information to your clipboard, then paste it wherever 
desired (such as an email or an instant message to the individual). 
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Share Your Screen 
You can share your screen during a session, which allows you to present a document, presentation or 
anything else you'd like to attendees. You can choose to share one or more of your monitors or even a 
single application. You can also show a clean Windows desktop to hide icons and the task bar, as well as 
blank out the background, so that the focus remains on the content you are presenting to your attendees. 

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

 

Share your screen 
1. You can begin screen sharing in either of the following ways: 

• Click the Screen button  in the Control Panel or Grab Tab. 
Note: Using this button will automatically share the entire screen of your main monitor. If you wish to share a more 
specific item with attendees, use the option below. 
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• On the Screen tab (in the Options pane), use the "Start sharing my" drop-down menu to select 
the portion of your screen you would like to share, as follows: 

• Screen of main monitor, secondary monitor or both monitors – This shares the entire 
screen of one or both of your monitors (if more than one is configured). Be sure to close 
any windows you do not want to share before proceeding. 

• Screen of main monitor, secondary monitor or both monitors (CLEAN) – This shares your 
screen, but also hides your background, task bar and desktop icons. Be sure to close 
any windows you do not want to share before proceeding. 

• Application – This shares only the specific application that you select and hides the rest 
of your screen (available for Windows Presenters only). 

• Rectangle (Labs) – This shares only a specific portion of your screen, which you can 
choose my moving a floating frame around your screen. 

Note: Sharing with "Screen (Clean)" and "Rectangle (Labs)" are not available to Mac organizers. If you wish to share a 
PowerPoint presentation on a Mac, you must first put the presentation into slide show mode and then select 
"PowerPoint Slide Show" in the Application window. If you do not, attendees will continue to see the main PowerPoint 
window instead of the slide show, and they will not see your slides advance.  

 

2. The Screen icon at the top of the Control Panel will glow green  when your screen is being 
shared with other attendees.  
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Pause/restart screen sharing 
Pausing screen sharing will freeze the image of the screen that attendees see.  

1. Hover over the Screen button  in the Control Panel or Grab Tab so that the Pause button  
appears. 

• Click the Pause button  to pause screen sharing. The Screen icon will start flashing when 
screen sharing is paused. 

 

 

• Click the Play button  to restart screen sharing. 

 

Stop sharing your screen 
When you stop screen sharing, attendees will see the Hallway again and a message that the organizer's 
screen is not being shared. 

 1. Click the Screen button  in the Control Panel or Grab Tab. 
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Share Your Webcam 
You can share your webcams with other attendees using high-definition video conferencing. Up to 6 
different webcams can be shared during a session. All you need is an internet connection and a webcam 
to begin enjoying a telepresence-quality experience! 

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  
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Preview your webcam 
Put your best face forward and get ready for business! You can preview how others will see you, what’s 
around you or behind you, and ensure that others see only what you want them to see before your share 
your webcam. 

• Select the Webcam tab in the Options pane to see a preview.  
• Once you share your webcam, a blue highlight will appear around the webcam box and the 

"Preview" header will disappear.  
Previewing webcam Sharing webcam 
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Share your webcam 
There are multiple places on the Control Panel and Grab Tab where you can turn on your webcam, as 
follows: 

• In the Control Panel or Grab Tab, click the Webcam button . 
• In the Webcam tab (Options pane), click the More icon  and select Share My Webcam. 
• In the Attendees pane, right-click your name and select Share My Webcam or click the Webcam 

icon  next to your name. 
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Pause/restart sharing your webcam 
When you pause webcam sharing, other attendees will still see the webcam box with your name, but the 
screen will be blacked out until you resume sharing. This does not free up a webcam spot (e.g., if all 6 
webcam spots are filled, another attendee will not be able to start sharing their webcam). 

• Hover over the Webcam button  at the top of the Control Panel, then click the Pause button . 
Click the Play button  to restart sharing.  

• Click the Pause icon  at the top of your webcam box in the Viewer. Click the Play icon  to 
restart sharing.  
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Stop sharing your webcam 
When you stop webcam sharing, your webcam box will disappear and the webcam spot will be freed for 
another attendee to share their own webcam. You can do so in any of the following places: 

• In the Control Panel or Grab Tab, click the Webcam button . 
• In the Webcam tab (Options pane), click the More icon  and select Stop Sharing My Webcam. 
• In the Attendees pane, right-click your name and select Stop Sharing My Webcam or click the 

Webcam icon  next to your name. 
• In the Viewer, click the Stop icon  at the top of your webcam box in the Viewer.  
• In the Viewer, click the Webcams drop-down menu and select Stop Sharing My Webcam. 

See Share your webcam for information about restarting webcam sharing after it's been stopped. 

 

Hide/show webcams 
Hiding webcams does not pause or stop webcam sharing; it simply hides the webcams currently being 
shared so that they do not take up space in the Viewer. Keep in mind that if you are sharing your webcam 
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and then hide webcams, other attendees will still be able to see you. You can choose to hide all 
webcams, or only hide your own.  

You can hide webcams in either of the following ways:  

• On the Webcam tab (Options pane), click the Options icon  and select Hide All Webcams or 
Hide My Webcam. 

• In the Viewer, click the Webcams drop-down menu and select Hide All Webcams or Hide My 
Webcam. 

 Use the same process and select Show All Webcams or Show My Webcam to display them again.   
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Start or stop webcam sharing for other attendees 
Note: This feature is available to organizers and co-organizers only. 

Organizers can send webcam requests to attendees in either of the following ways: 

• In the Attendees pane, click the Webcam icon  next to the attendee's name.  
• In the Attendees pane, right-click an attendee's name and select Send Webcam Request from the 

drop-down menu.  

 

Organizers can turn off attendee webcams in any of the following ways: 

• In the Attendees pane, click the Webcam icon  next to the attendee's name. Attendees will see a 
yellow tool tip or dialog indicating that the organizer has closed their webcam feed. 

• In the Attendees pane, right-click an attendee's name and select Stop Webcam Sharing. 
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Share a Whiteboard (Windows) 
Sightboard uses your HD webcam (and a little magic!) to broadcast an image of your whiteboard to 
attendees and share your updates in real time, allowing them to collaborate as if they were standing right 
in front of it. Sightboard can even see behind you as you write on the board and will automatically save 
snap shots documenting each change you make.  

Note: This feature is for Windows organizers and Presenters only. Sightboard on Windows is currently a Labs feature. Mac 
organizers who wish to use this feature should see Share a Whiteboard (Mac). 

 

Enable Sightboard (Labs) 
In order to use Sightboard, GoToMeeting will use a special Labs version of the desktop app to launch 
your session. To get started, you must first enable Sightboard.  

1. Log in to your online account.  

2. Click the Menu icon  in the right navigation, then select Labs. 

3. Under Sightboard, click Try it. When prompted, click Agree to agree to the Labs terms of use. 

© 2015 Citrix Systems. All rights reserved. 129 



GoToMeeting User Guide 

 

4. GoToMeeting will automatically create a new recurring session under My Meetings called "Labs 
with Sightboard." You can modify the meeting as needed, change the date(s) and invite others; each 
time you want to start a session with Sightboard, you will need to use this particular meeting. 
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Start a session with Sightboard 
1. Once Sightboard has been enabled, you can start a session in either of the following ways: 

• Click Start next to the Sightboard meeting on the My Meetings page.  

 

• Go to Menu  > Labs and click Start this meeting. 

 

2. You will automatically be launched into session using the special Labs build of the desktop app. 
See Share you whiteboard for next steps. 
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Share you whiteboard 
Note: For best results, ensure that your webcam is positioned as close to the whiteboard and centered as possible. Also ensure that 
the lighting is bright enough for the webcam to capture your whiteboard.  

1. While in a Sightboard session, click Share a Whiteboard  in the Labs - Sightboard pane. Your 
webcam will immediately begin broadcasting to attendees. 
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2. The Viewer will launch and use your webcam to automatically search for your whiteboard, then 
display an orange box to suggest the portion of your webcam that it believes is the whiteboard. 
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3. Use your mouse to drag the blue corners of the box around the screen and align them with the 
corners of your whiteboard. Once you are satisfied that the orange box represents the area that you 
want to share with attendees, click Yes, share this. 

 

4. In order to be able to "see" behind you as you write on the board, Sightboard will need a few 
seconds to focus on it. Click Start countdown to continue, then stand clear of the whiteboard to allow 
Sightboard a clear view.  
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5. You're all set! Start drawing on your whiteboard, and Sightboard will automatically broadcast and 
record all of your changes. You can also click Resize Whiteboard in the Labs - Sightboard pane of 
the Control Panel to readjust the portion of your screen being shown at any time. 
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Stop sharing your whiteboard 

1. First click the Resize Whiteboard button  in the Labs - Sightboard pane of the Control Panel. 

 

2. Then click theCancel button  in the Labs - Sightboard pane. You will then be prompted to save 
your snapshots. 
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Save your whiteboard snap shots 
1. Once you stop sharing your whiteboard or end the session, you will be prompted to save the snap 
shots that were automatically captured during the session. You can scroll through the snapshots in the 
Choose Snapshots window and click the Check icon  to deselect any that you do not wish to keep.  

2. Click Save to continue. 

 

3. Choose the location to which you want to save the Snapshots, then click Save. 
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4. You will see a confirmation message that your snap shots were successfully saved. You can open the 
new PDF file to view your snap shots and send it to attendees. 
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Give feedback about Sightboard 
1. Launch your Sightboard session. 

2. Click Give Feedback in the Labs - Sightboard pane.  

3. A new web browser page will open and direct you to Feedback survey. Fill it out and submit your 
thoughts! 
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Share a Video 
Video sharing is a Labs feature that allows you to stream videos (.wmv, .asf, .avi, .mov and .mp4 files) 
and their accompanying audio in real time during a session.  

Note: While streaming videos, shared webcams and the shared screen will be temporarily disabled to free up bandwidth. Only 
desktop attendees can view shared videos, and only those connected to audio via mic and speakers (VoIP) will hear the audio. Web 
app attendees will only hear the audio; iOS attendees will see the video but not hear the audio, and Android/Windows Phone users 
will neither see or hear the shared video. 

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

Start video sharing 
1. Go to GoToMeeting > Labs > Video Sharing. When prompted by the "terms of use" for Labs, click 
Agree to continue. 
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2. A new Video Sharing pane will open in the Control Panel. Click Share a Video to begin. 

 

3. Select the desired video file, then click Open. 
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4. The Video Sharing pane will display an embedded video player, and the video will automatically 
begin broadcasting to all attendees. Click the Pause button  to pause the shared video, and click 
the Stop button  to completely stop video sharing. 

Note: Shared webcams and the presenter's shared screen will all be temporarily disabled during video sharing in order to free 
up bandwidth. 

Organizer view: 

 

Attendee view: 

 

© 2015 Citrix Systems. All rights reserved. 142 



GoToMeeting User Guide 

Change Presenter 
The presenter has the ability to share their screen with other attendees during a session. As an organizer, 
you can make another attendee the presenter at any time (which does not cause them to automatically 
become an organizer).  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

Make an attendee Presenter 
Note: Only attendees who joined via the desktop app can be Presenter. Attendees who joined via Web App must switch to the 
desktop app to become Presenter. Mobile attendees cannot be made Presenter. 

1. Select a Presenter in either of the following ways: 

• On the Screen tab (in the Options pane), 
use the "Change Presenter to" drop-down 
menu to select a new Presenter. 

OR • In the Attendees pane, right-click the name of 
the desired attendee and select Make 
Presenter. 

 

  

 

2. Confirm the Presenter as follows: 

• If the attendee joined via the desktop app, you will be asked to confirm that you want to make 
them Presenter. You can also enable the "Request keyboard and mouse control" check box to 
have a request sent to the attendee before clicking Yes.  
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• If the attendee joined via the Web App, you will be notified that they must switch to the desktop 
app in order to become Presenter. Click Send Present & Download Request to prompt the 
attendee to switch. 
Note: Though you'll still see this notification, Web App attendees who are running Chrome will be able to share their 
screen without switching to the desktop app.  

 

3. The new Presenter will be notified, and you will see a confirmation that you are no longer the 
Presenter.  

• Desktop app attendees will see a "You've been made the Presenter" window prompting them to 
share their screen. 

 

• Web App attendees running Chrome will be prompted to install the GoToMeeting Pro 
Screensharing extension in order to share their screen. 

 

• Web App attendees running another browser will be prompted to switch to the desktop app. 
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Take back Presenter control 
You can resume Presenter control in the same way you passed it to another attendee: 

• On the Screen tab (in the Options pane), use the "Change Presenter to" drop-down menu to select 
your own name.  

- OR - 

• In the Attendee pane, right-click your own name and select Make Presenter. 

Give Keyboard and Mouse Control 
When you are Presenter, you can grant other attendees shared control of your keyboard and mouse. This 
allows them to move the mouse about your shared screen and use their own keyboard to type on it, 
which can aid in collaboration.  

Of course, your mouse always has priority. You can always override another attendees' mouse 
movements to temporarily regain control without removing their access.  

Note: This feature is available to Presenters only. 

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  
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Share keyboard and mouse control with others 
Note: Attendees who joined via Web App must switch to the desktop app and then be promoted to Panelist to share keyboard and 
mouse control. Mobile attendees cannot use this feature. 

1. Share keyboard and mouse control in either of the following ways: 

• On the Screen tab (in the Options pane), use 
the "Share keyboard & mouse with" drop-
down menu to select "Everyone" or an 
individual. 

OR • In the Attendees pane, right-click the name 
of the desired attendee and select Give 
Keyboard and Mouse. 

 

  

 

2. All attendees with keyboard and mouse control will have a Check icon  next to their name in both 
drop-down menus shown above. Attendees will see a notification that they have been given access to 
the presenter's keyboard and mouse. 
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Temporarily take control of your keyboard and mouse 
1. Simply type or move your mouse to re-gain control temporarily. The other person can continue to 
control your keyboard and mouse, but you will override their movements. 

2. Instruct the person with keyboard and mouse control to resume controlling your screen when you're 
finished. 

Remove keyboard and mouse control from others 
You can remove keyboard and mouse control in the same way that it was granted (e.g., selected from 
one of the drop-down menus). Once attendees have control removed, the Check icon  will disappear.  

  

© 2015 Citrix Systems. All rights reserved. 147 



GoToMeeting User Guide 

View and Manage Attendees 
The Attendees pane displays a list of all the participants in a session.  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

 

Attendees pane icon key 
The Attendees pane uses icons to describe the status of the attendees in your session.  

Audio icons 

 Individual is connected via VoIP and unmuted 
 Individual is connected via VoIP and has muted themselves 
 Individual is connected via VoIP and muted by organizer 
 Individual is attempting to connect via VoIP 
 Individual is connected via phone and unmuted 
 Individual is connected via phone and has muted themselves 
 Individual is connected via phone and muted by organizer 
 Individual is attempting to connect via phone OR they are connected but have not yet 
entered their audio PIN 

Other icons 

 Individual is the current Presenter  
 Individual has been given access to keyboard and mouse control 
 Individual is currently controlling the keyboard and mouse 
 Individual has a webcam connected (but is not sharing it) 
 Individual is sharing their webcam  
 Individual has been given access to drawing tools 
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Mute/unmute attendees 
• To mute or unmute a single attendee, click the Audio icon next to their name. Blue icons  

represent unmuted attendees, while orange icons  represent attendees who have been muted 
by the organizer.  

• To mute or unmute all attendees, click the Mute All  or Unmute All  icons at the bottom of the 
Attendees pane. 

 
Note: If an organizer attempts to unmute attendees who have muted themselves, the attendees will be prompted to be automatically 
unmuted or to remain muted.  

Make an attendee Presenter 
The presenter has the ability to share their screen with other attendees during a session. As an organizer, 
you can make another attendee the presenter at any time (which does not cause them to automatically 
become an organizer). See Change Presenter for more information.  

Make an attendee an organizer 
As the scheduling organizer of a session, you can allow other attendees to be co-organizers who can 
facilitate the session with you. You can either add an organizer before a session begins (which allows 
them to start the session on your behalf), or you can promote an attendee to organizer while in session. 
Co-organizers are able to access all the same session features as the scheduling organizer (however, co-
organizers who are promoted during a session will not have access to post-session features like reporting 
and follow-up emails). See Add Co-Organizers for more information.  

Give an attendee keyboard and mouse control 
When you are Presenter, you can grant other attendees shared control of your keyboard and mouse. This 
allows them to move the mouse about your shared screen and use their own keyboard to type on it, 
which can aid in collaboration. Of course, your mouse always has priority. You can always override 
another attendees' mouse movements to temporarily regain control without removing their access. See 
Give Keyboard and Mouse Control for more information.  

Stop/start attendee webcam sharing 
• To request that an attendee start sharing their webcam, right-click their name in the Attendee 

list and select Send Webcam Request. The attendee will be prompted to share their webcam 
(they can click Share My Webcam or Not Right Now).  
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• To stop sharing an attendee's webcam, right click their name in the Attendee list and select 
Stop Webcam Sharing. 

 

Hide/Show Attendees and Chat panes from an attendee 
If desired, you can hide the Attendee list and/or disable chat for some attendees (both are enabled by 
default).  

• To do so, right-click their name in the Attendee pane and select Allow Attendee List and/or Allow 
Chat. A Checkmark icon  will be displayed next to the selection when it is enabled, and will 
disappear when one or more panes are disabled.  
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Dismiss an attendee 
You can remove an attendee from the meeting by dismissing them. To do so, right-click their name in the 
Attendee list, select Dismiss Attendee, and then click Yes to confirm. Attendees will automatically be 
disconnected from the session and will see a message notifying them that they were dismissed from the 
meeting.  
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Add Co-Organizers 
As the scheduling organizer of a session, you can allow other attendees to be co-organizers who can 
facilitate the session with you. You can either add an organizer before a session begins (which allows 
them to start the session on your behalf), or you can promote an attendee to organizer while in session. 
Co-organizers are able to access all the same session features as the scheduling organizer (however, co-
organizers who are promoted during a session will not have access to post-session features like reporting 
and follow-up emails).  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

Add a co-organizer before the session 
You can make someone a co-organizer before the session begins so that they can start the session if you 
are unable to. 

Note: Only organizers with a corporate account can add co-organizers to their session. 

1. Log in to your online account.  

2. Either schedule a new meeting, or open an existing meeting from the My Meetings page.  

3. On the Co-organizers tab, search for a user on your account by entering their first name, last name 
or email address. Repeat for additional co-organizers. 

4. Click Save. You will be prompted to share the meeting invitation with the newly added organizers.  

5. Click Save when finished. 
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Promote an organizer during a session 
Note: Only attendees who joined via the desktop app can be promoted to organizer. Attendees who joined via Web App must switch 
to the desktop app to be promoted. Mobile attendees cannot become an organizer. 

1. In the Attendees pane, right-click the name of the desired attendee and select Make Organizer. 

 

2. You will be prompted to confirm that you wish to promote the attendee to organizers. Click Yes to 
continue. The attendee will be notified of their new organizer status. 
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Try Labs Features 
Citrix offers several beta features known as Labs, which are exciting new ways to enhance your sessions. 
Keep in mind that when you use a Labs feature, you are agreeing to use a feature that has not been fully 
tested and may still have some bugs. If you decide you no longer want to use a lab feature, you can 
always disable the feature from your Control Panel. 

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

Available Labs features 
The following Labs features are available to organizers: 

• Share a video 
• Share a whiteboard 
• Show Audience View pane 
• Show profile pictures for attendees 
• Allow "sharing a rectangle" (screen sharing) 
• Show Control Panel to attendees 

Enable/disable Labs features in desktop app 
Note: This is available to Windows users only.  

If you end a session with one or more Labs features enabled, then GoToMeeting will remember your 
preference when you next start or join a session. 

• To enable a Labs feature, select GoToMeeting > Labs. Then select the desired feature; once 
enabled, it will display a Check icon . 

• To disable a Labs feature, select it again in the Labs menu. Once the feature is disabled, the 
Check icon will disappear.  

 
Note: The first time you enable a Labs feature, you will be prompted to accept the terms of use. Click Agree to continue. 
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Share a video 
Note: This is available to Windows users only.  

Video sharing is a Labs feature that allows you to stream videos (.wmv, .asf, .avi, .mov and .mp4 files) 
and their accompanying audio in real time during a session. See Share a Video for more information.  
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Share a whiteboard 
Note: This is available to Windows users only. Sightboard must be enabled via the web app rather than the desktop app.  

Sightboard uses your HD webcam (and a little magic!) to broadcast an image of your whiteboard to 
attendees and share your updates in real time, allowing them to collaborate as if they were standing right 
in front of it. Sightboard can even see behind you as you write on the board and will automatically save 
snap shots documenting each change you make. See Share a Whiteboard (Windows) for more 
information.  

 

Show Audience View pane 
Note: This feature is available to Presenters as well as organizers. 

Note: This is available to Windows users only.  

Normally when you are sharing your screen with attendees, there isn't a way for you to see what your 
audience is seeing. By enabling the Audience View pane, you can see a thumbnail version of your shared 
screen (or the waiting room, if you are not sharing your screen).  

To enable/disable this feature, select GoToMeeting > Labs > G2M has Audience View Pane. 
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Show profile pictures for attendees 
Note: This is available to Windows users only.  

This feature allows attendees to add profile pictures to their names in the Attendee pane. To 
enable/disable this feature, select GoToMeeting > Labs > Profile Pictures. 

• To add their profile pictures, Windows and Mac desktop attendees can drag and drop an image 
file into the Attendees pane. GoToMeeting will remember profile pictures for future sessions that 
have this feature enabled. 

• To remove their pictures, they can right-click their name and select Clear My Profile Picture. 

Attendees can hover their mouse over an attendee's picture to see an enlarged version of the image. 
They will also see an attendee's picture appear next to their name in various other places (e.g., "Talking", 
"Now Viewing <attendee>'s Screen" messages). 
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Allow "sharing a rectangle" (screen sharing) 
Note: This feature is available to Presenters as well as organizers. 

Note: This is available to Windows users only.  

This feature allows you to use select a specific portion of your screen (denoted by a framed area) to 
share with attendees.  

1. To enable this feature, select GoToMeeting > Labs > Allow Sharing a Rectangle. 

2. On the Screen tab (Options pane), two new options will appear in the "Start Sharing My" drop-down 
menu: "Rectangle" and "Rectangle - but hide my icons & taskbar".  

3. When you select one of the new options, a floating GoToMeeting rectangle will appear on your 
screen. You can click and drag the edges of the rectangle to change its size and shape as desired, 
then drag it around the screen to frame the area you want to share. Only the area within the frame will 
be shown to attendees. 
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4. The attendee's Viewer will automatically re-size itself to match the shape of the frame on your 
screen.  

 

© 2015 Citrix Systems. All rights reserved. 159 



GoToMeeting User Guide 

Show Control Panel to attendees 
Note: This feature is available to Presenters as well as organizers. 

Note: This is available to Windows users only.  

By default, your Control Panel is hidden from attendees when you are sharing your screen. If desired, you 
can use this feature to have your Control Panel be visible on the shared screen.  

To enable/disable this feature, select GoToMeeting > Labs > Show my Control Panel to attendees 
during screen sharing. 
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Send Chat Messages 
You can exchange instant chat messages with other participants during a session.  

If desired, organizers can save a Chat log after the session ends to review messages later.  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

Chat with others 
Note: It is not possible for attendees to exchange chat messages with other attendees, but they can send questions to staff 
members if desired. 

1. Use the "To" drop-down menu to select the recipients of the message: "Everyone", "Organizer(s) 
only" or an individual attendee. 

• Everyone – All participants will see the message in their Chat pane.  
• Organizer(s) only – All organizers will see the message in their Chat pane.  
• Individual participant – Only the selected organizer or attendee will receive the private message.  

2. Type your message in the text field, then click Send.  
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Send a welcome message to attendees 
Note: This feature is available to organizers and co-organizers only. 

You can set up a chat message to be automatically send to each attendee as they join the session. 

1. In the Chat pane, click the Options icon . 

2. Enable the "When attendees arrive, show them this chat message" check box.  

3. Enter you message, then click OK.  

 

4. Attendees will see the message in their Chat pane as soon as they join. 
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Save the chat log 
You can save a log of the Chat messages as a Rich Text file (.RTF). The Chat log will only include 
messages that you saw; any private message sent between other attendees will not be included. 

Note: This feature is available to organizers and co-organizers only. 

1. Click GoToMeeting in the top navigation and select Save Chat Log. 

2. Select a location on your computer, and change the default name (if desired). 

3. Click Save. 
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Use Drawing Tools 
Participants can use drawing tools to draw directly on the shared screen so that the marks are visible to 
all attendees. This allows participants to highlight areas of the screen, draw attention to certain parts and 
generally illustrate their point. Organizers and presenters can allow only other organizers or all attendees 
to draw on the shared screen.  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  
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Use drawing tools 
1. Click GoToMeeting and hover over Drawing Tools.  

2. Use the menu to select the desired drawing tool (pen , highlighter , spotlight  or arrow ). You 
can also change the pen color, if desired.  

3. Click and drag the mouse over your desktop to start drawing on the shared screen. 
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Enable/disable drawing tools for an individual 
1. Right-click the participant's name in the Attendee pane.  

2. Click Allow Drawing.  

• When drawing tools are enabled for the user, a Check icon  will appear next to Allow Drawing. 
The attendee can click and drag the mouse over the Viewer to make their drawings appear on 
the shared screen for all participants.  

• When drawing tools are disabled for the user, the Check icon  will disappear.  

 

Enable/disable drawing tools for all participants 
1. Click GoToMeeting and hover over Drawing Tools.  

2. Click Attendees can draw.  

• When drawing tools are enabled for others, a Check icon  will appear next to Attendees can 
draw. Attendees can click and drag the mouse over the Viewer to make their drawings appear 
on the shared screen for all participants.  

• When drawing tools are disabled for others, the Check icon  will disappear.  

Erase all drawings 
1. Click GoToMeeting and hover over Drawing Tools.  

2. Select Erase all drawings. All drawings done by any participant will immediately disappear. 
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Desktop Notifications (Windows) 
Desktop Notifications is a free GoToMeeting feature for Windows users designed to deliver simple and 
effortless access to complimentary Citrix software upgrades, information, news and discounts you may be 
eligible for. Desktop Notifications delivers information right to your desktop, allowing you to safely receive 
important product information that is relevant to you. Desktop Notifications are sent only by Citrix as a 
service to our customers. 

Show desktop notifications 
Occasionally, when you are connected to the Internet, Desktop Notifications will automatically connect 
with Citrix servers to see if there are any new messages for you. If there are any messages for you, 
Desktop Notifications will display them on your computer screen. 

 

Disable desktop notifications 
1. To disable desktop notifications, unselect the "Show me desktop notifications" check box the next 
time a notification appears.  

2. You should no longer receive notifications on your desktop.  

© 2015 Citrix Systems. All rights reserved. 167 



GoToMeeting User Guide 

Dismiss Attendees 
You can remove an attendee from the meeting by dismissing them. To do so, right-click their name in the 
Attendee list, select Dismiss Attendee, and then click Yes to confirm. Attendees will automatically be 
disconnected from the session and will see a message notifying them that they were dismissed from the 
meeting.  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  
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Leave and End a Session 
You can leave or end a session anytime during the session (regardless of the scheduled end time). 
Organizers will be given the option to leave a session without ending it for everyone else so that others 
can continue without them. 

 

Leave a session (without ending it) 
1. Click GoToMeeting in the top navigation and select Exit - Leave Meeting. 

2. Continue as follows: 

• If there are already 1 or more co-organizers in the session, you can click Yes to confirm that you 
want to leave. The session will continue without you, and the other organizer(s) can take over 
facilitating.  
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• If there are not any co-organizers in the session, you can click Choose and Organizer & Leave, 
select an attendee from the drop-down menu and click Yes to confirm that you wish to make 
them an organizer. You will then exit the meeting.  

 

End a session for everyone 
1. Click GoToMeeting in the top navigation and select Exit - End Meeting. 

2. If prompted, click End Meeting for All.  

3. Click Yes to confirm that you want to end the session for everyone.  
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Audio 
Connect to Session Audio 
Depending on the options provided by the session organizer, attendees can connect to session audio 
using various methods. Participants can also test their audio connection before or after a session if 
needed. 

Note: Organizers can see Manage In-Session Audio for information about changing audio modes during a session and 
enabling/disabling chimes and on-hold beeps.  

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

Available audio modes 
Organizers can either select one or more of the built-in audio options, or they can provide their own 
conference call info.  

Built-in audio conferencing 

• Computer audio (VoIP): Participants can connect to audio through their computer's internet 
connection using a mic and speakers. 

• Conference call: Participants can use a telephone to dial in to the session audio using toll and/or 
toll-free phone numbers (depending on the organizer's settings). 

Third-party audio conferencing 

• Custom conference call info: Participants can use a telephone to dial into the session audio 
using a third-party audio service (provided by the organizer).  
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Connect via computer audio (VoIP) 
Audio quality may vary depending on the audio software, hardware, operating system and Internet 
connection being used. We recommend using a USB headset plugged directly into the computer and 
placing the microphone away from other speakers or devices to avoid noise feedback. 

Note: This feature is only available if enabled by the organizer.  

1. First ensure that your mic and speakers are properly plugged in to your computer. 

2. Select Computer audio as follows: 

• While in the Hallway, select the Computer Audio option. You can click Test your sound to 
select the right audio hardware. 

• While in session, select Computer audio on the Audio tab (Options pane). You can use the 
drop-down menus to select the right audio hardware. 
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Connect via telephone 
Note: This feature is only available if enabled by the organizer.  

1. First locate the audio information provided by the organizer. You can find it in any of the following 
locations: 

• Check the Invitation email sent by the organizer. 

 

• While in the Waiting Room before a session, select the Phone call option. 
• While in a session, go to the Audio tab (Options pane) and select the Phone call option. 

 

2. Find the phone number for the desired country. 
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• Check the list of phone numbers included in the Invitation email (listed by country). 
• While in the Waiting Room or during the session, use the drop-down menu to select the desired 

country. 

3. Use a telephone to dial the provided phone number.  

4. When prompted, enter the Access Code and Audio PIN listed in the session information. See 
Manage audio via keypad commands (phone mode only) for more information. 

Note: If you are having trouble with your audio connection, you can check for alternative phone numbers.  

Connect via custom conference call 
If the organizer uses a third-party conference-call service, they may wish to provide their own details 
about how to connect to the session audio. In this case, their instructions will appear in the Hallway and 
on the Audio tab (Options page). 

Note: This feature is only available if enabled by the organizer.  
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Switch between audio modes 
Attendees can switch between the provided audio modes any time during the session by opening the 
Audio tab (Options pane) and selecting the desired audio mode.  

Note: Only those options provided by the organizer will appear. If only one method of connecting was provided, then attendees will 
not be able to switch to another audio mode. 

 

Manage audio via keypad commands (phone mode only) 
 

When participants are connected via telephone, they can use their phone's 
keypad to manage the audio of the conference call.  

All participants: 

• *3 – Turn "on-hold" beeps on or off 
• *4 – Hear a menu of keypad commands available to you.  
• *6 – Mute or unmute the participants audio. 
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Organizers only: 

• *2 – Hear the number of attendees currently dialed in via telephone. 
• *5 – Change the "listening mode" of all attendees; pressing this command repeatedly will cycle 

through the following modes: 
• Soft mute: All attendees are automatically muted, but they can unmute themselves if 

desired. 
• Hard mute: All attendees are automatically muted and cannot unmute themselves. 
• Unmute: All attendees are automatically unmuted (default mode). 

• *8 – Change the "chime controls"; pressing this command repeatedly will cycle through the 
following modes:  

• Both entry and exit chimes on (default) 
• Both entry and exit chimes off 
• Only exit chimes on 
• Only entry chimes on 

Check for alternative phone numbers 
If you are having trouble connecting to the session with the phone number provided in the Options pane, 
you can check to see if the organizer provided any alternative phone numbers. 

1. On the Audio tab (Options pane), click Problem dialing in?. 

2. A new browser window will open and direct you to the right page. 

3. Use the drop-down menu to select the desired country, then use the alternative session information 
provided to try dialing in again. If you're still having problems connecting, see Audio Help for more 
information. 
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Manage In-Session Audio 
Once in session and connected to audio, the organizer can manage the session audio options for all 
participants. 

Note: This feature is available to organizers and co-organizers only. 

Note: If your Control Panel looks different than the one shown below, you may have a different version of GoToMeeting. See 
Original Control Panel and Viewer (Windows) for more information.  

 

Enable/disable on-hold beeps 
When enabled, this feature plays intermittent beeps to indicate that no one has yet joined the session.  

1. On the Audio tab (Options pane), click the Options icon .  

2. In the pop-up menu, click the On/Off button next to Play On-Hold Beeps to immediately enable or 
disable them.  

Enable/disable entry and exit chimes 
When enabled, this feature makes a "chime" sounds that announces each time attendee joins or leaves 
the session. 

1. On the Audio tab (Options pane), click the Options icon .  

2. In the pop-up menu, click the On/Off button next to Play Entry/Exit Chimes to immediately enable 
or disable them.  
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Edit the audio mode while in session 
You can change the audio-connection methods available to attendees at any time, even while in session. 

1. On the Audio tab (Options pane), click the Options icon .  

2. In the pop-up menu, click Edit audio mode. 

3. In the Edit Audio Mode window, select the desired audio option. You will be cautioned that changing 
the audio during the session will immediately impact all customers and that you should warn them 
verbally before doing so.  

4. Click OK when finished.  
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Set Default Audio Options 
When you schedule a meeting, the audio options are set to the default settings for your account. You can 
change these default audio options at any time, which will affect all meetings that you schedule in the 
future.  

Note: Changing your settings will only impact meetings that you schedule after that point. It will not affect previously scheduled 
sessions; you must change those manually if desired.  

Use built-in audio services 
GoToMeeting offers various built-in methods for participants to connect to the meeting audio. You can 
offer some or all of these methods to participants by changing your default audio options. 

Mic & Speakers (VoIP) Telephone (PSTN) 
Participants can use the mic and speakers 
on their computer to connect to the audio 
through the desktop, web or mobile app. 
This allows participants to join the audio 
without needing to use the telephone. 

Participants can use a telephone to dial in to the audio 
separately from the desktop, web or mobile apps. This allows 
participants to join the meeting even if they aren't able to the 

screen-sharing session. 

VoIP: This method allows participants to 
connect to audio over the internet using 

the desktop, web or mobile app with which 
they joined the session. 

Long-Distance (Toll): This 
method allows participants to dial 

in using long-distance (toll) 
phone numbers provided by 

GoToMeeting. 

Toll-Free: This method 
allows participants to dial in 

using toll-free phone 
numbers provided by 

OpenVoice Integrated.  

This method is free for both organizers 
and attendees. 

Each attendee will be charged 
rates based on their own long-

distance provider. 

Organizer's accounts will be 
charged a per-minute fee for 

each attendee who uses 
these methods. 
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Use your own audio service 
If you choose to provide your own conference call service, you must provide your own telephone numbers 
for participants, and you won't have access to built-in audio conferencing (VoIP, long distance and toll-
free numbers). 

• If you select Use my own conference call service under Settings, you can provide custom 
information telling attendees how to connect to the meeting audio using your third-party audio 
service.  

  

 

Change default audio options 
1. Log in to your online account.  

2. Click the Menu icon  in the top navigation, then select Settings. 

3. Select the desired audio options, as follows: 

• Select Use built-in audio, then enable the check boxes of the methods that you would like to 
provide to customers: VoIP, long-distance (toll) numbers or toll-free numbers (OpenVoice 
Integrated). If desired you can change the countries for which phone numbers are provided. 

• Select Use my own conference call service, then enter the conference-call information of your 
third-party audio service. 

4. Click Save when finished. 
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Change the countries for which phone numbers are provided 
If you are providing long-distance (toll) or toll-free phone numbers for your customers, you can always 
choose which countries are included in the session information for each meeting. 

1. While changing the default audio options, click Edit next to the "Long distance number" and/or 
"Toll-free number" options. 

2. Select the desired countries. To select all countries available, select the check box next to "Country" 
at the top of the list. If desired, you can also designate a preferred country. 

3. Click Done when finished. When you return to the Settings page, you'll see the additional countries 
you added next to the long distance and/or toll-free option(s). 
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Choose a preferred phone number 
If you are providing multiple countries in the list of long-distance (toll) or toll-free phone numbers shown to 
your customers, you can choose which country appears first in the list by designating it a "preferred 
country". If you don't choose a preferred number, the phone number that's displayed to attendees first by 
default is the billing country you have associated with your account. 

When selecting which countries are included, you can choose a preferred country by selecting the Star 
icon  next to a country so that it turns blue . You can only select 1 preferred country.  
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Broadcast Computer Audio 
While GoToMeeting is designed to efficiently broadcast voice audio over telephone or VoIP, there may be 
times when you wish to broadcast an audio recording from your computer. In this section you will find 
audio configuration instructions that should allow you to transmit both your voice and audio from your 
computer. Due to some sound card limitations, these procedures may not work with every system. 

Configure Windows XP to broadcast audio 
Note: Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like "What 
U Hear" on some Soundblaster cards) or may be absent entirely. 

Note: You cannot use your microphone when switching via software. 

1. Double-click the volume icon in the system tray (usually bottom-right of your desktop). 

2. Select Options, then Properties. 

3. Under Adjust Volume, choose Recording. 

4. Ensure "Stereo Mix" is checked. 

5. Click OK. 

6. On the Recording Control screen, select the check box under Stereo Mix. 

Configure Vista or Windows 7 to broadcast audio 
Note: Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like "What 
U Hear" on some Soundblaster cards) or it may be absent entirely. 

Note: You cannot use your microphone when switching via software. 

1. Right-click the volume icon in the system tray (usually bottom-right of your desktop). 

2. Select Recording devices from the menu. 

3. Right-click the first item on the list and ensure Show Disabled Devices is checked. 

4. Ensure Stereo Mix is the default device. 

5. Press OK. 

Hardware option 
Parts needed: 

• Two (2) 3.5 mm audio splitters (1 male, 2 female). 
• One (1) 3.5 mm audio patch cable (2 male ends, typically 3 " long). 
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Configure your system to broadcast with hardware 
1. Plug 1 splitter into your line out port (for speakers, typically colored green) 

2. Plug the other splitter into your microphone port (typically pink) 

3. Plug the patch gable into the splitter on line out and then into the splitter on microphone. 

4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out 
splitter. 

Note: You may use your microphone and speakers simultaneously.  
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Audio Conferencing FAQs 
Review frequently asked audio conferencing questions. 

Is there a cost for using the integrated audio conferencing feature? 
Your plan includes unlimited audio at no extra cost. You can use toll-based phone conferencing or VoIP 
(requires microphone and speakers) exclusively or allow participants to choose between both options. 
You can also provide your own conference call number for organizers, panelists and/or attendees, but 
you won't be able to choose our integrated audio conferencing options if you do so. 

 If you purchased a plan that provides toll (long distance) numbers, participants who dial in are charged 
their standard long-distance rate for calling. If you purchase Integrated Toll-Free service, your participants 
can dial in using a toll-free number, and you'll be charged according to the plan that you select. 

You and your attendees can also connect to the audio conference free of charge by choosing the Mic & 
Speakers (VoIP) option where you can send and receive audio over the Internet at no cost using a 
microphone and speakers connected to your computer. (A USB headset is recommended.) 

Is there a toll-free audio option? How do I sign up? 
If you'd like to purchase Integrated Toll-Free audio service provided by Citrix Online Audio so that your 
participants can dial in by telephone using toll-free numbers, call us at 1 866 962 6492. You can then 
provide your participants with a toll-free number if you so choose. Over 45 countries are available for toll-
free numbers. 

With this service, you can give your attendees the option of dialing in using VoIP, toll (long distance) or 
toll-free audio conferencing without any additional equipment needed.  

Can I mute/unmute individual attendees? 

As the organizer, you can easily mute attendees on VoIP by clicking the Microphone icon  or 
Telephone icon  next to their name in the Attendee List. You can mute attendees who dial in by phone 
only if they entered their Audio PIN. Attendees will be able to unmute themselves if they wish to speak. 

Can I use my own toll-free phone numbers for all of my sessions? 
Yes. As an organizer, you can easily change your default audio options from the Settings page. Simply 
log in to your account, and select Settings to adjust the audio options for future sessions. To provide your 
, select Use my own conference call service on the Settings page, and enter the conference call info 
for attendees (and optionally for organizers and panelists). Then click Save to apply the audio settings for 
all future sessions (new default setting). 

What microphone/speaker configuration is recommended for best audio quality 
using VoIP? 
For optimum audio quality, we recommend a USB headset connected to your computer, or USB 
headphones and standalone microphone connected to your computer. Analog versions are okay, but not 
ideal. We don't recommend using a webcam mic. 

© 2015 Citrix Systems. All rights reserved. 186 

http://global.gotowebinar.com/


GoToMeeting User Guide 

Can I test the quality of my microphone and speakers setup before a session? 

Yes. Just right-click the GoToMeeting daisy icon  in your system tray, and select Preferences > Audio 
to choose the device(s) you want to test. 

Where can I go for help with audio problems? 
Please see our Audio Help for tips on how to troubleshoot common audio problems 

Can I broadcast my computer's audio?  
Although GoToMeeting is designed to broadcast audio over VoIP or telephone, you can also broadcast 
recorded audio from your computer. Due to some sound card limitations, these instructions may not 
always work on every system. 

Broadcast audio on Windows 7 or Vista  

1. Right-click the Speakers icon  in the system tray, and select Recording devices.  

2. On the Recordings tab, right-click the first item on the list, and select the Show Disabled Devices 
option. 

3. Check that Stereo Mix is the default device, and click OK. 

Broadcast audio on Windows XP 

1. Double-click the volume icon in the system tray. 

2. Select Options > Properties. 

3. Below Adjust Volume for, choose Recording. 

4. Check that Stereo Mix is enabled, and click OK.  

5. On the Recording Control window, select the check box under Stereo Mix. 

Broadcast audio using hardware 

You will need the following: 

•  Two 3.5 mm audio splitters (one male, two female) 
• One 3.5 mm audio patch cable (two male ends, typically 3" long) 

1. Plug one splitter into your line out port (typically green for speakers). 

2. Plug the other splitter into your microphone port (typically pink). 

3. Plug the patch cable into the splitter on line out and then into the splitter on your microphone. 

4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out 
splitter. 

Is there any way to see if there are any unidentified callers in my meeting? 
Yes, internal customer support reps and Account Managers can enable the "Audio Attendee 
Identification" feature from the User Settings page. Organizers will then be able to see any unidentified 
callers who have called into the meeting (as well as attendees who have called into the meeting without 
joining the screen-sharing portion of the meeting) but have not entered their Audio PIN. 
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OpenVoice Integrated (Toll-Free Audio) 
Organizers whose accounts include an OpenVoice Integrated subscription can use it to offer their 
attendees toll-free phone numbers for over 50 countries. This provides attendees with an alternative to 
connecting with their mic and speakers (VoIP) or incurring long-distance phone charges, making it easy 
for them to choose the most convenient method of joining the audio conference.  

Note: OpenVoice Integrated toll-free audio service must be purchased separately from your GoToMeeting plan. Organizers incur 
per-minute changes for each attendee who uses the OpenVoice integrated toll-free audio service. If you have a GoToMeeting 
corporate plan and your billing address is based in the U.S., U.K., Canada or Australia, you may purchase OpenVoice integrated 
toll-free audio online.  

Note: This article refers to OpenVoice Integrated, which allows you to add toll-free phone numbers to your meetings. However, 
OpenVoice is also offered as a standalone audio-conferencing product.  

Create a new account that includes OpenVoice Integrated 
1. Start the sign up process for GoToMeetinghere. 

2. During Step #2, enable the "Add toll-free numbers provided by Citrix OpenVoice" check box. 

 

Add OpenVoice Integrated to your GoToMeeting plan 
You can add OpenVoice Integrated to your existing GoToMeeting account at any time. Once your 
account includes OpenVoice Integrated, you will see the toll-free audio option whenever you schedule 
meetings and under the default audio options. 

Note: If you have a plan that is billed via invoice, then you must contact your Account Manager or Global Customer Support to 
modify your account and subscription plans. 

1. Log in to your online account.  

2. On the My Account page, click How It Works under "Add OpenVoice Toll-free Numbers to your 
GoToMeeting Plan".  
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3. Click Subscribe Now to confirm. 

 

Schedule a session with OpenVoice Integrated toll-free audio 
When you schedule a new meeting, you will automatically see the option to include toll-free numbers if 
you have a plan for OpenVoice Integrated. Simply select the option if desired, then click Edit to change 
the countries for which toll-free phone numbers will be provided. 

• When scheduling from the web, select the "Include Toll-Free Numbers (OpenVoice Integrated) 
for: <countries>". Click Edit to change the countries provided. 

 

• When scheduling from the desktop app, select Use build-in audio conferencing then either 
Provide a conference call number only or Provide both. When you click Edit countries, you will 
see both toll and toll-free (i.e., OpenVoice Integrated) options listed.  
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Available international countries with OpenVoice integrated toll-free audio 
See the available international toll-free and long-distance (toll) numbers. 
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Unsubscribe from OpenVoice 
You can cancel your subscription to OpenVoice integrated at any time. Keep in mind that you and other 
organizers on your account will lose access to toll-free numbers, and that toll-free numbers will be 
removed from all scheduled sessions associated with this account. 

Note: If you have a plan that is billed via invoice, then you must contact your Account Manager or Global Customer Support to 
modify your account and subscription plans. 

1. Log in to your online account.  

2. On the My Account page, click Remove Toll-free Numbers under "Toll-free Numbers for 
GoToMeeting, Provided by OpenVoice".  

3. Click Unsubscribe Now to confirm. 

 

OpenVoice Integrated (Toll-Free Audio) FAQs 
Review frequently asked questions about OpenVoice Integrated (toll-free audio). 

What is OpenVoice Integrated (toll-free audio)? 
Organizers whose accounts include an OpenVoice Integrated subscription can use it to offer their 
attendees toll-free phone numbers for over 50 countries. This provides attendees with an alternative to 
connecting with their mic and speakers (VoIP) or incurring long-distance phone charges, making it easy 
for them to choose the most convenient method of joining the audio conference. See OpenVoice 
Integrated (Toll-Free Audio) for more information. 

How much does it cost to use OpenVoice Integrated? 
Per-minute charges are based on your service contract, and minutes are calculated per participants. For 
instance, if 3 participants dialing to the session for 10 minutes using the toll-free option, you will have 
used 30 minutes of your plan. Those who join by regular toll numbers are charged rates based on their 
own long-distance provider. There are no additional charges for those who join a session using VoIP. 

How am I billed for OpenVoice Integrated? 
You will receive a separate monthly invoice from Citrix Online Audio, LLC for any toll-free minutes used 
by you and your attendees. 
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How do I add the toll-free option to sessions that I've already scheduled? 
For any sessions that were scheduled prior to enabling toll-free integration, the regular toll-based 
conference numbers will automatically be changed when toll-free numbers are added to an existing 
session. It is recommended that you resend the invitation email to participants so they have access to the 
new toll-free audio information. The Meeting ID and URLs will stay the same, and the new toll-free 
number will be provided to attendees in the Waiting Room, as well as in the Audio Pane of the Control 
Panel. 

Will I use the same toll-free number for each session? 
No, as with existing sessions, each session will have a unique toll-free number and access code. If you 
wish to re-use the same audio options for your sessions, select the "Recurring meeting" check box in the 
Schedule a Meeting window. Once you do so, the OpenVoice integrated toll-free number and access 
code remain the same. 

How do I schedule a session with OpenVoice integrated toll-free? 
When you're scheduling a session, click Edit countries in the Audio section to choose which toll-free 
numbers you'd like to provide to attendees. 

For which countries do you offer international toll-free & long-distance (toll) 
service? 
See the available international toll-free and long-distance (toll) numbers. 

Is there anything different about recording a session with OpenVoice integrated 
toll-free? 
No. Whether you or your attendees join with VoIP, long distance or toll-free audio, you can seamlessly 
record audio. Open Preferences > Recording > Use GoToMeeting integrated audio. 

How can I cancel OpenVoice integrated toll-free? 
If you'd like to cancel your OpenVoice integrated toll-free service, please contact our 24/7 Global 
Customer Support. 

Audio Help 
If you are experiencing difficulty with audio, determine which scenario is applicable to you and follow the 
recommended guidelines. 

I can't hear anyone 
Test your audio setup by clicking Settings in the Audio pane of your Control Panel. Or, you can right-click 
the GoToMeeting daisy icon  in your system tray, and select Preferences > Audio. Check to see if 
you're using an appropriate audio device. Click Play Sound to check that you can hear sound from your 
speakers. Speak into the microphone to test your microphone setup. 
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No one can hear me. 
If you're the organizer, you must click Start Broadcast at the top of your Control Panel, or press *1 on 
your telephone's keypad to start the audio conference. 

Check to see that you're not muted by clicking the Audio icon  in your Control Panel or Grab Tab.  

If you're experiencing problems dialing in by phone, try hanging up and dialing in again.  

If you're having problems connecting to VoIP (Mic & Speakers), test your computer's detected audio 
devices by clicking Settings in the Audio pane. Speak into your microphone to test if your microphone 
setup is working.  

I hear static or clicking sounds. 
Move electronic handheld devices, such as an iPhone, away from your mic and speakers. 

I hear echo, feedback or background noise. 
If you suspect that the echo is coming from an attendee, check to see who's talking at the bottom of the 

Audio pane in the Control Panel, and mute the attendee by clicking that person's Audio icon . 

If you dial in to the audio conference by telephone, make sure that you select Telephone from the Audio 
pane in the Control Panel instead of Use Mic & Speakers. 
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Built-in or external speakers may cause an echo. Try lowering the speaker's volume. 

Built-in microphones on your computer or webcam can pick up noise and cause an echo. We don't 
recommend using built-in microphones. Try plugging in a USB headset to your computer. 

The audio quality is poor and choppy. 
Poor network performance, lack of memory or high CPU usage often causes the audio quality to drop, 
become delayed or sound robotic. 

Try closing all applications you aren't using to free up some bandwidth. 

If you're using a dial-up Internet connection with VoIP, it may cause poor performance. For optimum 
performance when using VoIP, we recommend using a broadband Internet connection. 

 If the problem persists, switch to Telephone mode. Select Use Telephone in the Audio pane and dial in 
to the audio conference. 

No sound is detected. 
After the first minute of a session, GoToMeeting looks for microphone input from attendees who have the 
following: a microphone, speaking rights and unmuted. 

If no audio input is detected, you may see a "Trying to speak?" pink tip. You may see the error when you 
haven't spoken or made any sounds when the session starts or if your microphone device is incorrectly 
selected. Click Audio Setup in the Audio pane to test your input device. 

No microphone is detected. 
If a microphone (or headset) isn't detected or connected properly, you may see a pink tip.  

Check that your microphone (or headset) is properly plugged in. 

If the problem still persists, try switching to Telephone mode if available. Then dial in to the conference 
using the telephone number and Audio PIN provided in the Audio pane of your Control Panel. 

My microphone is disconnected. 
If your microphone isn't working or gets unplugged during a session, you may see a pink tip.  

Check that your microphone is properly plugged in. 

If the problem still persists, try switching to Telephone mode if available. Then dial in to the conference 
using the telephone number and Audio PIN provided in the Audio pane of your Control Panel. 

I can't connect to audio with VoIP. 
In some cases, you will see an error that reads "Internet Audio Not Available." In this scenario, are a few 
things you can try to connect to the audio in the meeting. 
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If you see the above error message, please try the following: 

•  Update the device drivers for your sound hardware. 
• Close any programs on your computer that you are not using. 
• Unplug audio hardware that you are not currently using. 
• Exit the GoToMeeting program and restart it.  

Note: If you see this error message in the Audio pane, you will not be able to record your session 
unless "No Audio" is selected in the Recording Preferences. Audio PINs and muting controls will also 
be disabled.  
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Session Recording 
Record a Session 
You can record any session and then store the recording for attendees to view at a later time. When a 
session is recorded, then the presenter's screen, the audio and any shared applications are recorded.  

Note: Session recording is not supported for GoToMeeting Essentials organizers. 

Get started with session recording 
Successfully using session recording requires a series of steps on the part of the organizer. Use the steps 
below to set up and use session recording. 

1. Record sessions: You can start and stop recording during meetings. 

2. Convert recordings: After each recorded session, a temporary recording file is saved to the 
specified location in .G2M format. You must then convert the recording into a downloadable format 
(.MP4, .WMV or .MOV).  

Start and stop recording a session 
Note: We recommend having 2 organizers record the session in case 1 organizer encounters any issues that may potentially disrupt 
the recording. 

1. Ensure that you are sharing your screen, application and/or webcam.  

2. At the bottom of your Control Panel, click Record this meeting. The Recording icon  will glow 
and attendees will see a notification that the session is being recorded at the bottom of their Control 
Panel. 

Note: At least 500MB of free space must be available in the Recordings folder in order to record a session. 

3. Click Stop recording to temporarily pause or stop recording altogether. If desired, you can click 
Restart recording to start recording again.  

4. Once you end the session, you will be prompted to convert it using the GoToMeeting Recording 
Manager. You must convert session recordings in order to view them later.  
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Convert Session Recordings 
Once a session has been recorded, the temporary recording file (.G2M) must be converted before 
anyone can view it. Using the Recording Manager, you can easily convert multiple recordings at once 
whenever it's convenient for you.  

Open the Recording Manager 
You can access the recording manager at any time in any of the following ways: 

• When you end a session, the Recording Manager will automatically launch and prompt you to 
convert your recordings. 

• Right-click the Daisy icon in the system tray, then select Convert Recordings (Windows only). 

 

• Open Preferences > Recordings > Convert Recordings now.   
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Convert a recording 
1. Open the Recording Manager. 

2. Under "Recordings you need to convert", any unconverted files will be listed (both the most recent 
session and any past sessions that were not yet converted). Use the check boxes to select the files 
that you wish to convert. 

Note: If you do not see the session recording you are looking for, simply locate it on your computer and move it to the specified 
Recordings folder. It will then automatically appear in the "Recordings you need to convert" section.  

3. Use the "Choose a file format" drop-down menu to select the desired format: 

• .MP4 (Windows only) Can be played on most Windows and mobile devices 
• .WMV (Windows and Mac): Can be played all Windows devices, as well as some Mac and 

mobile devices 
• .MOV (Mac only): Can be played on most Mac and mobile devices using Quicktime 

Note: If you are converting a recording that was made in 2012 or earlier, then you must use .WMV format (.MP4 will not work 
correctly).  

4. Click Convert Recording.  
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5. The conversion process will begin for the selected files. The recording may take some time to 
process and convert, depending on the video content and length, CPU speed, chosen media format 
and the amount of available memory.  
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6. Once the file has been successfully converted, it will be moved to the "Converted recordings" list in 
the Recording Manager. You can click the Folder icon  to automatically open the folder on your 
computer in which the converted file is stored.  
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 7. You can share the converted recording with attendees via email, YouTube, Vimeo, etc. so that 
anyone can view it. 

Locate Recording Files 
After each recorded session, a temporary recording file is saved to the specified location in .G2M format. 
You must then convert the recording into a downloadable format (.MP4, .WMV or .MOV).  

By default recordings are stored in C:\Users\<user>\Documents. The original "pre-converted" .G2M 
files are stored in a subfolder called "originals" after a successful conversion has finished. However, you 
can change the location for which all future session recordings will be saved (ensure it has at least 1GB 
of space available).  

 

Change the location of saved files 
1. Right-click the daisy icon in the system tray and select Preferences.  

 

2. Go to the Recording tab.  

3. At the bottom of the window, click Browse.  

4. Select the desired location, then click OK.  
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Recording and Playback FAQs 
Here you can review frequently asked questions regarding session recording and playback. Please see 
Record a Session for details about starting and stopping session recording, as well as modifying the 
recording settings.  

How do I record a session? 
Please see Record a Session for details about starting and stopping session recording, as well as 
modifying the recording settings.  

How do I locate my session recordings? 
By default recordings are stored in C:\Users\<user>\Documents. The original "pre-converted" .G2M 
files are stored in a subfolder called "originals" after a successful conversion has finished. See Locate 
Recording Files for more information.  
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What file formats are supported? 
You can convert a session recording into any of the following formats: 

• .MP4 (Windows only) Can be played on most Windows and mobile devices 
• .WMV (Windows and Mac): Can be played all Windows devices, as well as some Mac and mobile 

devices 
• .MOV (Mac only): Can be played on most Mac and mobile devices using Quicktime 

Can people on Macs view sessions recorded on Windows computers (and vice 
versa)? 
Yes, as long as the session has been converted to .MP4 format. 

Can I include audio in my session recordings? 
Yes. The Recording Preferences will determine if and how audio is included in session recordings. The 
following options are available: 

• Don't record audio: Records the presenter's screen only. 
• Use Use GoToMeeting integrated audio: Records everyone who speaks via VoIP or telephone. 
• Use your own audio service: Uses a microphone to record the organizer's voice, while a phone 

patch device will record everyone else who speaks (requires a physical input device).  

Can I exclude audio from session recordings? 
Yes. You can modify the settings so that only the shared screen is included by selecting the "Don't record 
audio" option under Recording Preferences. 

 Can I record a session using my own audio service? 
Yes. If you're using your own conference call number, you must have a sound card and an audio input 
device like a microphone to record audio. If you're recording a teleconference, you can position the 
microphone next to the phone or set up a phone recording adapter to your phone and line-in input on your 
computer's sound card. If you're having trouble with your audio, see Audio Help. 

Can I edit a recorded session? 
Yes. You can use third-party editing software such as TechSmith Camtasia® to edit recording files. Just 
make sure that they have been converted first.  

Can I post a recorded session? 
Yes. You can post your recorded session wherever you'd like (e.g., YouTube, Vimeo).  

Can I mail a recorded session? 
Yes. However, it is not recommended as the file may be extremely large. Depending on its size, a 
session recording can be zipped and sent via email or via File Transfer Protocol (FTP). 
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GoToMeeting Codec 
The GoToMeeting Codec was a Windows Media Player component that was formerly required in order for 
you to view and convert session recordings on a Windows computer.  

However, the current GoToMeeting Recording Manager is able to convert session recordings into .MP4 
and .WMV formats, which can be played on a variety of platforms, including mobile devices – nothing 
extra required! 

What is the GoToMeeting codec? 
The codec is an executable file (.EXE) that was formerly required in order for you to view session 
recordings.  

How do I download the GoToMeeting codec? 
 You don't need to anymore! Although the codec was once required, you are now able to view your 
session recordings from any device that supports playback for .WMV, .MP4 (Windows) or .MOV 
(Mac) files – without installing the codec or any other software.  

Why can't I view my session recording? 
When a session is recorded, the recording file is automatically saved to the organizer's computer in the 
.G2M (GoToMeeting Action) format. The organizer must then use the GoToMeeting Recording Manager 
to convert it into a universal format (.MP4, .WMV or .MOV).  

• If someone else recorded the session, then you must ask them to complete the 
recommendations below.  

• If you recorded the session yourself, then check the format of the file you are trying to play. If it 
is ".G2M", then you need to convert the recording before it can be viewed. 

Note: If the session was recorded 2+ years ago, you will be unable to convert it into .MP4 format and must use .WMV instead.  
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Mobile Apps 
Join, Schedule, and Start Meetings via iOS 
You can download the GoToMeeting app for iOS to schedule, start and join meetings from anywhere. 
Also see Use iOS Session Features to learn more about the features that are offered while in session.  

 

Join a session from the app 
1. Download the GoToMeeting app from the App Store.  

2. Open it and tap Join a Meeting.  

3. Find the correct session in either of the following ways: 

• Enter the meeting ID provided by the organizer, then tap Join.  

- or - 

• Tap the desired session under My Meetings (if you have the app connected to your calendar).  

4. You will be automatically launched into session. See Use iOS Session Features  to learn about 
what you can do during a session.  

© 2015 Citrix Systems. All rights reserved. 206 

https://itunes.apple.com/us/app/gotomeeting/id424104128?mt=8
https://itunes.apple.com/us/app/gotomeeting/id424104128?mt=8


GoToMeeting User Guide 

 

Schedule a meeting from the app 
1. Download and open the GoToMeeting app from the App Store.  

2. Tap Sign In and enter your GoToMeeting login and password.  

3. Tap My Meetings in the lower toolbar, then tap the Add icon  in the upper toolbar.  

 

4. Use the available fields to configure your new meeting, as follows: 

• Subject – Enter a name for the meeting. 
• Recurring meeting – Tap this switch to toggle between a single meeting and series.  
• Starts/Ends – Tap this field to select the date and time of the meeting.  
• Audio – Tap to select which audio options should be available to attendees. 
• Password – To password-protect the meeting, enter a password in this field.  

5. Tap Done in the upper toolbar when finished. 
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6. A pop-up message will confirm that the meeting was scheduled successfully. Tap Send Invitation 
to invite attendees, or tap OK to exit without sending invitations. 

 

Start an instant meeting 
1. Sign in to the GoToMeeting app and tap My Meetings. 

2. Meet Now at the bottom of the page.  

3. You will be automatically launched into session! 
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Start a scheduled meeting 
1. Sign in to the GoToMeeting app and tap My Meetings.  

2. Tap the desired meeting, then tap Start. 

3. You will be automatically launched into session! 

 

Invite attendees (before a meeting) 
1. Sign in to the GoToMeeting app and tap My Meetings. 

2. Tap the desired meeting, then tap Send Invitation. 

 

3. Select the desired option, as follows: 

• Calendar Invitation – This will open a new event (using the Calendar app) with the meeting details 
pre-populated. You can add Invitees, then tap Done. 

• Email – This will open a new email (using the Mail app) with the meeting details pre-populated. 
You can add email recipients, then tap Send. 

• Message – This will open a new Message (using the Messages app) with the meeting details pre-
populated. You can add recipients, then tap Send. 

• Copy to Clipboard – This will copy the meeting details to your clipboard, which you can then 
paste wherever desired (e.g., Notes app shown below). 
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Edit a scheduled meeting 
1. Sign in to the GoToMeeting app and tap My Meetings. 

2. Tap Edit in the upper toolbar. 

3. Tap the meeting that you want to modify to open the meeting details. 

4. Make the desired changes, then tap Done. 
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Cancel a scheduled meeting 
1. Sign in to the GoToMeeting app and tap My Meetings. 

2. Tap Edit in the upper toolbar. 

3. Tap the Delete icon  next to the desired meeting.  

4. Tap Delete to permanently delete (i.e., cancel) the meeting. Caution: This cannot be undone!  

 

Use iOS Session Features 
The GoToMeeting app for iOS allows you to use many of the same features as when you join from the 
desktop app, including presenting content and sharing and viewing webcams. 

Note: Some features are only available for iPads users.  
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Mute/unmute yourself 
• Tap the Mute icon in the toolbar. The icon will turn gray when muted ( ) and orange when 

unmuted ( ).  

 

Mute/unmute attendees 

1. Tap the Attendee icon . 

2. To mute or unmute a single attendee, click the Audio icon next to their name. Icons will have a red 
slash through them when attendees are muted.  
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Share content (iPad only) 
Although iPad presenters can't share their entire screen with attendees, they can share specific content in 
the following ways: 

1. Go to the Present Content screen by tapping the Screen Sharing icon and enabling the Present 
Content toggle.  

 

2. Select one of the following share options. Be sure to tap the Play icon  in the floating toolbar so 
that you can share content. 
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• Share from the Cloud 
Open and share a file from your ShareFile or Dropbox account. 

 

• Share from the Browser 
Open and share a web page by entering a URL or tapping the Bookmark icon. 
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• Share from the Whiteboard 
Use drawing tools to collaborate with attendees on a whiteboard screen. 
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Stop or pause content sharing (iPad only) 
• To pause your shared content, tap the Pause icon in the floating toolbar.  

 

• To completely stop sharing content from the cloud, browser or whiteboard, simply tap the 
Screen Sharing icon in the top navigation.  

 

Preview, share and stop sharing your webcam (iPad only) 
You can use HDFaces to share your iPad's webcam and view the webcams of others.  

• To preview your webcam, tap the Webcam icon  in the top navigation.  
• To share your webcam, tap Share My Webcam.  
• To stop sharing your webcam, tap Stop Sharing My Webcam.  
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View and rearrange attendee's shared webcams (iPad only) 

Tap the Webcam icon  in the top navigation, then select one of the following views: 

 

• All – All webcams that are being shared will be displayed a floating Viewer. You can drag this 
around your screen as desired.  

 

• Talking – Only the webcam of the person or people currently talking will be shown at the bottom of 
your screen.  

 

• None – All shared webcams will be hidden (this does not hide your shared webcam from 
attendees).  
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Chat with attendees 
You can send chat messages to everyone in the meeting, only the organizers or to a single attendee. 

1. Tap the Attendee icon . 

2. Tap Everyone, Organizer(s) Only or a specific attendee. 

3. If prompted, tap Chat.  

4. Type your chat message, then tap Send.  

 

Make attendees presenter or organizer 

1. Tap the Attendee icon . 

2. Tap the name of the desired attendee. 

3. Select Make Presenter or Make Organizer.  

Note: You cannot take back presenter control manually. The current presenter must instead transfer it back to you once they 
are finished.  

 

Invite attendees to the session 

1. Tap the Attendee icon . 

2. Select Invite Others from the drop-down menu.  
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3. Select Email, Message or Copy to Clipboard to send the meeting information.  

 

 Use Drawing Tools (iPad only) 
Note: Only the current presenter can use drawing tools.  

1. As the presenter, make sure you've tapped the Play icon  in the toolbar so that you can share 
content. 

2. Then tap the Drawing Tools icon  in the Grab Tab to expand and display the main controls. You 
may use Drawing Tools on any screen you're sharing.  

 

 
 The Drawing Tools icon turns Drawing Tools on or off. When Drawing tools are 
on, the Drawing Tools icon is blue and the Drawing Tools toolbar is displayed.  

 /   The Play icon starts content sharing and the Pause icon pauses the screen so 
attendees will only be able to view the last screen that was displayed.  

 
 The Pen icon lets you draw and annotate on-screen. You can select different 
colors and adjust the width of the markings.  

 
 The Highlighter icon lets you highlight certain areas of your screen. You can 
choose from 4 different highlighter colors and adjust the width of the markings.  

 
 The Whiteboard icon brings the whiteboard to the screen which you can use to 
draw on a blank slate.  

 
 The Undo icon undoes the previous action you made.  

 
 The Redo icon redoes whatever action you've previously undone.  

 
 The Erase All icon erases all drawings from the screen.  

Leave a session 

Tap the Leave icon  in the top navigation to leave a session, then select the desired option. 
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• End Meeting for Everyone – Ends the meeting completely and disconnects everyone from the 
session. 

• Leave Meeting – Allows the meeting to continue after you leave by making someone else an 
organizer. 

Join, Schedule, and Start Meetings via Android 
The GoToMeeting app for Android allows you to schedule and start meetings directly from your Android 
device! Attendees can also use the app to attend sessions from anywhere.  

 

Join sessions from the app 
1. Download the GoToMeeting app from the Google Play Store.  
2. Join a session in any of the following ways: 

• Tap the Join URL of the session (in your Email app, Message app, etc) to automatically 
launch the app.  

• Open the app, enter the session ID and tap the Arrow button. 
• Open the app, find the desired upcoming session and tap it to join (if you have the app 

connected to your calendar). 
3. You will be automatically launched into session! 

Log in as an organizer 
You do not need to have a GoToMeeting account in order to attend sessions from the iOS app. However, 
if you have organizer credentials you can also use the app to schedule and host sessions.  

1. Select the Profile icon  in the toolbar.  
2. Enter your GoToMeeting credentials (email address and password). If you do not have an account, 

sign up for a free trial! 
3. Select the Log In button.  
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Schedule a meeting 
1. First, log in to the app. 
2. Select the Profile icon  in the toolbar, then select Schedule a Meeting.  
3. On the "Schedule a Meeting" screen, fill out the session details (title, date, audio options, etc.).  
4. Select Schedule when finished.  
5. Once the session is successfully scheduled, you will be prompted to invite others.  
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Start a scheduled meeting 
1. First, log in to the app. 
2. Select the Profile icon  in the toolbar. The Scheduled Meetings screen will then display all of 

your future scheduled meetings.  
3. Select the desired meeting. When prompted, select Start.  
4. You will be immediately launched into session. 

 

Start an instant meeting 
1. First, log in to the app. 
2. Select the Profile icon  in the toolbar. 
3. Select Meet Now to launch your session, then invite others. 
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Edit or delete a scheduled meeting 
1. First, log in to the app. 
2. Select the Profile icon  in the toolbar. The Scheduled Meetings screen will then display all of 

your future scheduled meetings.  
3. Select the desired meeting. When prompted, select Edit or Delete.  
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Invite others before a session 
1. First, log in to the app. 
2. Select the Profile icon  in the toolbar. The Scheduled Meetings screen will then display all of 

your future scheduled meetings.  
3. Select the desired meeting. When prompted, select Invite.  
4. The Send Invite pop-up will give you options for sending the invitation. Select the desired option to 

launch the Drive, Email or Gmail apps with the session information pre-populated.  

 

Invite others while in session 
1. While in session, tap the Attendees icon  in the toolbar. 
2. Tap the Invite icon  in the Attendees pane.  
3. The Send Invite pop-up will give you options for sending the invitation. Select the desired option to 

launch the Drive, Email or Gmail apps with the session information pre-populated.  

 

GoToMeeting App for Windows devices 
The GoToMeeting app for Windows phone allows you join GoToMeeting or GoToWebinar sessions from 
a Windows Phone free of charge. Organizers can also start, schedule and edit meetings directly from the 
app.  

© 2015 Citrix Systems. All rights reserved. 224 



GoToMeeting User Guide 

Schedule a meeting  
1.  Log in to your account from the GoToMeeting app for Windows phone. If you don't already have 

the app installed, download the free GoToMeeting App for Windows phone and Windows RT/8. 
2. Tap the Menu icon at the bottom of the screen. 
3. Tap schedule. 
4. Enter the information for your meeting and tap the Save icon. 
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Edit a scheduled meeting 
1. Log in to your account from the GoToMeeting app. 

2. Tap Join the top of the screen. You will see all your upcoming meetings. 

3. Tap the name of the meeting you would like to edit. 

4. Tap edit the meeting. 

5. You can then edit the name, date, time and audio options for the meeting.  

6. Tap the Save icon to save your changes. 
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View and start scheduled meetings 
1. Log in to your account from the GoToMeeting app. 

2. Tap Join atthe top of the screen. You will see all your upcoming meetings. 

3. To start a meeting, tap the name of the meeting you would like to start. 

4. Tap Start the Meeting.  
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Start a Meet Now 
1. Log in to your account from the GoToMeeting app. 

2. Tap Host at the top of the screen. 

3. Tap the Meet now button. A new meeting will begin.  
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Invite others to join 
1. Log in to your account from the GoToMeeting app. 

2. Tap Join at the top of the screen. You will see all your upcoming meetings. 

3. Tap the meeting you would like to invite people to. 

4. Tap invite people. 

5. You can then invite people to your meeting via text message, email or social media.  
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GoToMeeting App for Android Permissions 
When you install the GoToMeeting app for Android on your device, the app will request permission to 
access different features on your Android device to run properly. While some of the permissions may 
sound scary, keep in mind that almost all apps require certain permissions to run features. Below is a 
table of the features that the app is requesting permission to, with an explanation of why the 
GoToMeeting app is requesting permission for this specific feature.  
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Feature How GoToMeeting Uses this Information 

Phone calls 

Directly call cell phone 
numbers, read phone status 
and identity 

The app will use your device's Phone app to dial in to the phone call (should you 
choose to do so) by tapping the switch to phone button in the app's audio tab. 
The app also reads the state of phone calls to mute or disconnect from the 
session audio so that the meeting audio does not interrupt your phone call.  

Bluetooth 

Pairs with Bluetooth devices 

The app will pair with your Bluetooth device to connect to your audio via 
Bluetooth. 

Network 
communication 

Full network access 

The app will use your network communication to connect to the internet. 

Your personal 
information 

Read calendar events plus 
confidential information 

The app reads your calender events to scan for upcoming meetings and display 
them in the app, enabling you to join with a single touch. This information is used 
solely to make joining a session easier and quicker. 

Microphone 

Records audio 

The app will use your microphone to share your voice with others in the meeting. 
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Audio Settings 

Change your audio settings 

The app uses information in your audio settings to provide you with optimal audio 
by switching to different audio settings and controlling your audio devices. 

System Tools 

Send sticky broadcast 

The app uses your system tools to connect to your audio via Bluetooth devices. 

Network 
communication 

View network connections 

The app uses your network communication information to see whether you're 
connected to the internet and to handle network disconnections. 

Affects Battery 

Prevent phone from sleeping 

The app will keep your screen from locking when you are viewing a presenter's 
screen. 
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Use Windows Session Features 
The free GoToMeeting app for Windows phone allows you to interact with others during a meeting, either 
by inviting attendees, promoting attendees or chatting with other attendees while in session.  

Invite others during a meeting 
1. On a Windows phone, tap the expand menu icon. 

2. Tap invite people. 

3. Select one of the following: Messaging, Email or Social Networks to invite someone through one 
of those mediums.  
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Chat with others during a session 
1. To chat with someone in session, tap the attendees icon on the bottom toolbar. 

2. Tap the name of the person you would like to chat with. 

3. Tap chat. 

 

Make someone a presenter 
1. Tap the attendee icon in the bottom toolbar. 

2. Tap the name of the attendee you would like to become presenter. 

3. Tap Switch Presenter.  
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Make someone an organizer 
1. Tap the attendee icon in the bottom toolbar. 

2. Tap the name of the attendee you would like to promote to organizer. 

3. Tap Promote to Organizer. 

Share content (Windows 8.1 and Windows RT users only) 
When you start a session as an organizer or are promoted to presenter, you will see a Share 
Content screen where you can share content during a meeting. You will have the option to share 
content from the web or share content from the whiteboard.  
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Share content from Cloud or Tablet 

1. On the Share Content screen, tap Share from Cloud or Tablet.  

2. You can then select content from another app on your device, such as Sharefile, DropBox and 
OneDrive. You can also present content from email attachments.  

 

Share content from the web 

1. Click Share from the Web on the Share Content screen. 

2. Enter a URL into the browser to have attendees see web content. 
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Share content from the whiteboard 

1. Click Share from the Whiteboard on the Share Content screen. 

2. Use the available drawing tools to draw content that your attendees can see.  
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Mobile Feature Comparison 
The GoToMeeting mobile apps offer different features depending on the device's operating system. Use 
the chart below to see what is available on each app for iOS, Android and Windows devices. 

Features  iOS  Android Windows RT Windows Phone 
Join a meeting     
Schedule and start 
meetings 

    

View shared screen     
Invite others     
Promote others to 
organizer 

 
 (iPad only) 

   

Promote others to 
presenter 

 
 (iPad only) 

   

Chat with attendees     
View webcams  

 (iPad only) 
   

Share webcams  
 (iPad only) 

   

Share content  
 (iPad only) 

   

Use drawing tools  
 (iPad only) 

   

Raise your hand     
Answer polls     
Leave a session     
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Switch Devices While In Session 
If you are running iOS 8 and have the GoToMeeting app for iOS installed, you can seamlessly transition 
your attendance in a meeting from an iOS device to a Mac OS X 10.10 (Yosemite) computer or a different 
iOS device (e.g. switch seamlessly from an iPhone to a computer or an iPad).  

In order to switch from an iOS to another iOS device or to a Mac computer, Continuity must be enabled. 
To enable Continuity, please refer to the Continuity support article from Apple. 

Switch from an iOS device to a Mac computer 
1. While attending a meeting on your iOS device, your computer will detect the meeting from your iOS 
device if both devices are in the same room. 

2. A Safari icon with a mobile phone badge will be displayed on the left side of the main dock. Click on 
this icon and the desktop version of GoToMeeting will launch and the computer will join the meeting. 

 

Switch from an iOS device to a different iOS device 
1. The second iOS device (e.g. iPhone or iPad) will detect your meeting from the first iOS device. 

2. If the second device is locked, swipe up on the GoToMeeting icon on the locked screen. The 
GoToMeeting app will launch and you will automatically join the meeting  

 – or – 

If the second iOS device is unlocked, double tap the Home button and swipe left until you reach a 
page with the meeting information. Tap the meeting information to launch the meeting. 
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FAQs 
Roles FAQs 
Review frequently asked questions on roles in GoToMeeting FAQs. 

What is an organizer? 
An organizer has a GoToMeeting account and schedules, starts, manages and ends a session. An 
organizer can also designate other attendees to be organizers. Once a session starts, the scheduling 
organizer is the default presenter and may either begin presenting or pass the presenter controls to 
another organizer. 

What is a presenter? 
A presenter is the person who is presenting their screen to the audience. The GoToMeeting organizer is 
always designated as the initial presenter. The presenter role can then be passed to another organizer or 
attendee. 

Presenters can show their complete desktops, a clean screen (with no icons or taskbar) or a specific 
application window to the audience. Presenters may choose to pause Screen Sharing at any time. 
Presenters may give other organizers the ability to control their keyboard and mouse. 

What is an attendee? 
An attendee is any person who attends a session, including organizers and presenters. By default, 
attendees can view the presenter's screen. An attendee may remotely control the presenter's computer 
screen if given the privilege. An attendee may optionally chat with other attendees, use Drawing Tools or 
view the Attendee List. 

How many people can speak on the call at once? 
When using integrated audio conferencing, up to 25 attendees can be unmuted and speak on the call at 
any one time. 

HDFaces Video Conferencing FAQs 

How is HDFaces different from other web conferencing video solutions? 
We provide the highest resolution video conferencing quality currently available among web conferencing 
providers – up to 6 streams at 640p x 480p for a maximum resolution of 1920p x 960p. Best of all, there's 
no additional cost to use HDFaces with GoToMeeting! 

What are the system requirements for HDFaces video conferencing? 
• Internet connection with cable modem, DSL or better 
• Windows® 8, 7, Vista, XP or 2003 Server, or Mac OS® X 10.6 Snow Leopard® or later 
• Dual core 2.4GHz CPU or faster with at least 2 GB of RAM 
• Internet Explorer® 7.0 or later, Mozilla® Firefox® 3.0 or later, Google Chrome 5.0 or later or 

Safari® 3.0 or later 
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• 700 Kbps or more bandwidth recommended per participant for simultaneous screen sharing, audio 
and video conferencing 

Which webcams are recommended? 
Video conferencing will work with most standard video conferencing webcams. From our testing, we 
highly recommend the following webcams: 

• Logitech® HD Pro Webcam C910 
• Logitech HD Webcam C510 
• Logitech HD Webcam C310 

Which webcams are unsupported? 
HDFaces video conferencing does not support the following webcams: 

• 4eyeGrab 
• Hava Remote Video Device 
• Hava Video Device 
• BT878 VfW to WDM mapper (32-bit) 
• Live! Cam Notebook Pro (VF0400) 

If 6 video streams are being shared and I turn off my video stream, can another 
participant share their video? 
Yes, participants can stop and share video streams at any time. Organizers can also disable an 
attendee's video stream so that another participant can share their webcam. 

Can I temporarily stop my webcam without giving up my webcam slot? 

Yes. You can pause your webcam temporarily by clicking the Pause button  on the top-right corner of 
your webcam feed. 

Is HDFaces available on GoToWebinar and GoToTraining? 
Yes! HDFaces video conferencing is available for GoToMeeting, GoToWebinar and GoToTraining at no 
additional cost.  

How do I set up my webcam to use with HDFaces video conferencing? 
Install your webcam using the manufacturer's installation instructions. You can set your webcam settings 
from GoToMeeting Preferences. We recommend using a headset with mic and speakers (VoIP) instead 
of your webcam's built-in mic and speakers. 

What happens if I install a webcam during an HDFaces session? 
In most cases, we should be able to detect your new hardware and allow you to use it during the same 
session. 
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What are the bandwidth requirements for HDFaces? 
We recommend 700Kbps or more per participant for simultaneous screen sharing, audio and video 
conferencing. HDFaces uses bandwidth optimization to make the best possible use of any available 
bandwidth. If you experience slow performance issues, try closing data-intense applications like 
YouTube, Netflix, Skype, etc. 

What is the supported video frame rate? 
HDFaces supports up to 30-frames/second. The frame rate depends on your webcam, lighting, network 
and computer. 

Can I join an HDFaces session from an Android or iOS device?  
Yes. You can join HDFaces sessions as an attendee, but you'll be unable to view or share webcams and 
show your screen if you're using an iPhone or iPod Touch. If you're on anAndroid or an iPad 2 or newer, 
you can share and view webcams in meetings. In a webinar, you can only view webcams from an iPad.  

Can I view webcams if I join an HDFaces session from an Android or iOS device? 
• If you are joining an HDFaces session from an Android, you will be able to view webcams. 

However, you will not be able to share your own. 
• If you are joining an HDFaces session from an iPhone or iPod touch, you will not be able to view 

webcams. However, if you are joining from an iPad you will be able to view webcams.  

What are some video conferencing tips and best practices? 
• Secure your webcam on your computer to make sure it's stable and won't move around. 
• Choose a location with adequate lighting. If you're sitting directly in front of a window, try moving to 

another spot; otherwise, your webcam may only capture your silhouette. 
• Position your webcam so that your entire face fills up at least half of your webcam viewer. 
• For optimal performance, open Preferences > Webcam > Advanced. If you have a high-

performance webcam, you can enable high-quality features, such as "face recognition" or "right 
light," to enhance your video conferencing experience. 

How do I select a different webcam if I have more than one plugged in to my 
computer? 
To select a different webcam, open Preferences > Webcam. If more than one webcam is detected, 
simply choose which webcam you'd like to use from the Your Camera section. 

Can I record webcams during an HDFaces session? 
Although you can record screen sharing and audio, you cannot record webcams at this time. 

Why can't I see other participants' webcams? 
Your webcam viewer may be minimized, but you can bring the viewer back up again from your taskbar or 
dock. If you previously selected the Hide Webcams from the Webcams drop-down menu, select Show 
Webcams. Only staff members can show their webcams. 
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Why can't other attendees see my webcam? 
Double check to see if your webcam is connected to your computer and then try clicking the Share My 
Webcam button if you haven't already done so. To see if your webcam has been detected, open 
Preferences > Webcam. 

What should I do if I'm experiencing poor video quality? 
Make sure you have adequate lighting in your room. If you have low bandwidth, you should make sure 
you have nothing else running that might use up bandwidth. If your webcam is out of focus, turn off the 
auto-focus setting on your webcam. You can also check to see if you're using one of our unsupported 
webcams. 

What should I do if my webcam stops working? 
If you have low bandwidth or CPU issues, you may see a "Low Bandwidth" or "Computer Overloaded" 
message. You'll be prompted to hide all webcams and/or stop sharing your own webcam. If you click Yes, 
all webcams and/or your own webcam will be hidden. 

To improve bandwidth and CPU performance, close all other programs on your computer, and switch to a 
high-speed cable Internet connection (if you haven't already). 

Security FAQs 
Review frequently asked security questions. 

How secure is GoToMeeting? 
Your sessions are completely private and secure. All of our solutions feature end-to-end Secure Sockets 
Layer (SSL) and 128-bit Advanced Encryption Standard (AES) encryption. No unencrypted information is 
ever stored on our system. 

How do I use GoToMeeting with firewalls? 
Our solutions use HTTP outbound connections to transparently enable screen-sharing sessions, even 
with corporate firewalls in place. In most cases, organizers and attendees can connect to Citrix Online's 
servers without re-configuring firewall settings. 

Can my computer get a virus from downloading the software or attending a 
session? 
No, neither organizers nor attendees can catch or be exposed to viruses from downloading our software. 
We continuously monitor our development environment for viruses and malware, and all of our 
downloadable software is digitally signed to prevent tampering by third parties. The warning message 
customers might see when they install the software is a default message displayed by their browser 
whenever they download executable files. 

Do I need to set my browser to accept cookies to use your website? 
You can browse our website without having cookies enabled. However, if you need to log in to an existing 
account, you will need to adjust your browser's privacy settings to accept cookies. We primarily use 
cookies to provide you with secure access to your account. 
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GoToMeetingApp for Android FAQs 
Review frequently asked questions on GoToMeeting App for Androids. 

Can I use the app to join GoToMeeting and GoToWebinar sessions? 
If you’re running Android 4.0 or higher, you can install the GoToMeeting app from the Google Play Store 
to join GoToMeeting and GoToWebinar sessions as an attendee. If you're a GoToMeeting organizer, you 
can log in and schedule and start a meeting from the app, but you won't yet be able to share your screen, 
so we recommend making someone else who joined the meeting from a Windows or Mac the presenter 
or co-organizer. 

We recommend using devices with a 1Ghz processor or higher for optimal performance. 

How can I download the GoToMeetingapp? 
You can download the GoToMeeting app from the Google Play Store by logging in to your Google 
account that's linked with your Android device and searching for the GoToMeeting app. If you don’t see 
an Install button, you may not be running Android 4.0 or higher (the minimum system requirement 
needed to install the GoToMeeting app).  

You can also download the GoToMeeting app from the Amazon Appstore (only available in the U.S.), 
which lets you instantly download the GoToMeeting app to an Android device. 

What are the minimum system requirements for joining a GoToMeeting or 
GoToWebinar session from my Android device? 

• Android 4.0 or higher 
• 1 Ghz CPU or higher recommended 
• WiFi or 3G connection (WiFi and headset recommended) 
• Free GoToMeeting App from Google Play or Amazon Appstore 

How do I join a meeting on my calendar from the app? 
Meetings in the Android Calendar app sync with the GoToMeeting app so you will see a list of your 
upcoming meetings on your Join screen. You can quickly join a meeting by tapping the name of the 
meeting. 
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You will also see a GoToMeeting widget that displays your upcoming meetings. You can tap the meeting 
to view the meeting information, and tap Join to join the meeting.  
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Can I schedule meetings from the GoToMeeting app? 
Yes, you can schedule meetings from the GoToMeeting app by tapping the Schedule a Meeting button. 
You can then select whether or not is a recurring meeting, choose the audio and edit phone numbers. 
You can also edit meetings and invite others from the GoToMeeting app.  

Can I host GoToMeeting and GoToWebinar sessions on the app? 
You can log in to schedule or start instant or existing meetings from your Android smartphone or tablet, 
but you won't be able to share your screen. We recommend making someone else who joined the 
meeting from a Windows or Mac the presenter or co-organizer from the Attendee List. Unfortunately, you 
can't start GoToWebinar sessions from your Android device at this time. 

 

What are some of the unsupported GoToWebinar features? 
Organizers and panelists can't do the following: 

• Host or join a GoToWebinar session 
• Join a session from a panelist invitation email 
• Present as a panelist or organizer 
• Start Screen Sharing 

Attendees can't do the following: 

• Start Screen Sharing or accept Presenter Control 

Can I record a session from my Android? 
No, you cannot currently record sessions from an Android device. 
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Can I chat from the app? 

Yes, all attendees, organizers and presenters in a meeting can chat by tapping the Chat icon  in the 
toolbar, entering a message and tapping Send. You can choose to chat with everyone in the meeting or 
privately with another person in the meeting. When you receive a Chat message, the Chat icon will 
bounce in the keyboard toolbar.  

Chat is currently unsupported for GoToWebinar. 

Why do I see an “Unable to Join the Meeting” error telling me that the Meeting ID 
is invalid? 
If you manually entered the Meeting ID, double check to see that you typed it correctly. 

Why do I have to enable cookies to join? How do I enable cookies on my 
browser? 
If your browser is set to disable cookies, you must first enable cookies before you can join a session. To 
enable cookies, go to your browser's settings and select Accept Cookies.  

I prefer to dial in to the audio conference by telephone. Where can I find the Audio 
PIN? 
You do not need an Audio PIN to dial in to the audio conference by telephone. To dial in to the audio 
conference by telephone, you can set your default audio to Phone by going to the Settings tab and 
selecting the Phone icon  next to Default Audio. If your default audio is set to Phone and you join a 
meeting from an Android device, you will be automatically dialed in to the meeting.  

You can see if you are connected to the meeting by VoIP or telephone in the Audio tab. If the organizer 
has provided dial-in phone numbers, you can switch to telephone by tapping Switch to Phone in the 
Audio Tab. In the Audio tab, you'll see a list of phone numbers associated with the session. If the 
organizer provides international country numbers, you can choose which country you want to dial into. 
Once you tap Dial, you will automatically dial in to the conference from your Phone app and will need to 
navigate back to the GoToMeeting app to return to the session.  

Why am I disconnected from GoToMeeting when I try dialing in from my phone? 
If you’re using a device that doesn’t allow simultaneous data and voice sharing (CDMA), you must 
connect to the Internet from a WiFi network to dial in using the same device you use to join the session; 
otherwise, you’ll be disconnected from GoToMeeting. If you aren’t connected to the Internet through WiFi, 
you must use your device’s mic and speakers (VoIP) or dial in with a different device to connect to audio. 
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GoToMeeting App for iOS FAQs 
Review frequently asked questions on GoToMeeting App for iOS. 

What are the system requirements for using the GoToMeetingapp for iOS? 
Please see System Requirements for details.  

Are there any additional fees for using the GoToMeetingapp? 
Nope, the app is free, and there's no charge for attending GoToMeeting, GoToWebinar or GoToTraining 
sessions. But you may be responsible for any long-distance charges associated with dialing in to 
sessions by phone or any data charges that may be incurred. 

Can I host a GoToMeeting or GoToWebinar session from my iPad, iPhone or iPod 
Touch? Can I show my screen if I'm given presenter controls? 
Yes, you can log in and host a meeting from an iPad, iPhone and iPod touch with the GoToMeeting app. 
Organizers can schedule meetings, start previously scheduled meetings and even launch instant 
meetings from the My Meetings screen. Only iPad presenters can share content on-screen. At this time, 
you can't host a GoToWebinar session from an iOS device.  

Can I schedule meetings from the GoToMeeting app for iOS? 
Yes, you can schedule meetings from the GoToMeeting app for iOS. You can invite attendees to these 
meetings, edit the audio and create a meeting password from the GoToMeeting app. Also, you can delete 
meetings from the My Meetings screen.  

How do I share content as a presenter? 
If you're presenting from an iPad, you can share content from the cloud, browser or whiteboard by tapping 

one of those options from the Tap to Share Content screen. Presenters must first tap the Play icon  in 
the toolbar for attendees to see shared content. The Screen Sharing icon  will turn green when content 
is being shared. 
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Can I invite others to the meeting? 
Yes, organizers can invite others by tapping the Invite icon and selecting either Email, Message or Copy 
to Clipboard to send the meeting information to others. 

As an organizer, can I promote attendees to presenter or organizer? 
Organizers can make someone who joins from a Windows, Mac or iPad the presenter so that person can 
share their screen. At this time, attendees who join from an iPhone an Android cannot be made 
presenters. 

From the Attendee List, organizers can make someone else who joined from a Windows, Mac or Android 
the organizer. Currently, attendees who join from an iOS device cannot be made an organizer. 

Can I see how my screen looks to attendees? 
Yes, when sharing content you can preview how attendees are viewing your screen by tapping the 
Screen Sharing icon and turning Audience View on. A thumbnail image of what attendees are seeing will 
appear on-screen, which you can hold and drag with 1 finger to move it across the screen. 

Can I only draw on a whiteboard? 
No, presenters can use Drawing Tools to annotate directly on any screen being shared by tapping the 
Drawing Tools icon in the toolbar. 
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Can I join a GoToWebinar session as a panelist? 
No, you can't join a session as a panelist on an iPad, iPhone or iPod Touch. 

Can I record a session from my iOS device? 
No, you can't currently record sessions from an iOS device. 

Can I be made presenter during a webinar on an iPad? 
No, not at this time. 

How does attending a GoToMeeting or GoToWebinar session on an iPad, iPhone 
or iPod Touch compare with the experience on a Windows or Mac? 
Just as on a Windows or Mac, you can view the presenter's screen, see who's attending and who's 
talking. However, some organizer features are not yet available on the iPad, iPhone and iPod Touch. 

Unsupported features for GoToWebinar on iOS: 

• Drawing tools 
• Presenter controls 
• Keyboard and mouse controls 
• Start sessions 
• Schedule sessions 

Unsupported features for GoToMeeting for iOS: 

• Keyboard and mouse controls of the presenter's desktop 

How can I change the view or zoom into the presenter's screen? 
You can view the presenter's screen in both portrait and landscape mode. You can also double-tap 
anywhere on the GoToMeeting Viewer to change the display to Fill Screen mode. Double-tap a second 
time to zoom in to 100% mode. Double-tap a third time to return to the default view – Entire Screen mode. 
You can also pinch or expand with 2 fingers, and pan to different parts of the presenter's screen by 
dragging 1 finger across the GoToMeeting Viewer. 

Can I chat with other meeting participants? Can I ask questions during a 
webinar? 
During a meeting or training, you can tap Chat in the toolbar to instantly send and receive messages to 
everyone in the meeting, to only the organizer(s) or to individual attendees. You can toggle between 
meeting participant names in the Attendee List to read and send messages. 

During a webinar, you can tap Questions in the toolbar to send questions to the organizer. You can also 
view other attendees' questions and answers if the organizer sends the response to everyone in the 
webinar.  

Can I connect to audio from the GoToMeeting app? 
If the organizer provides both mic and speakers (VoIP) and conference call numbers as audio options, 
you'll automatically connect to VoIP over your iPad, iPhone or iPod Touch’s Internet connection (WiFi or 
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3G) once you join. The audio quality depends on the quality and bandwidth available on your WiFi or 3G 
network (WiFi recommended).  

You can dial in by telephone on your iPad, tap the Settings icon > Audio Settings > Telephone to 
access the conference call information.If you want to dial in on your iPhone, tap the Settings icon > 
Meeting Information > Phone Number link to automatically connect to audio. With a single tap of a U.S. 
telephone number, the conference call number, access code and Audio PIN are automatically dialed. 

If you have an iPhone 4 or 4S on a network that does not allow simultaneous voice and data sharing 
(CDMA), you won’t be able to connect to GoToMeeting and dial in on your iPhone at the same time. To 
connect to audio, you should use your iPhone’s Internet connection (WiFi or 3G) or dial in with a different 
device. 

Can I mute/unmute iOS attendees? 
Yes, if the attendee is connected to VoIP, you can mute/unmute them to allow them to speak. If the 
attendee dials in by phone, you can mute/unmute them only if the they have entered the Audio PIN, which 
they can access in-session from Settings. 

Why can't I switch from Telephone to Mic & Speakers (VoIP)? 
Once you dial in to the audio conference by telephone, Mic and Speakers (VoIP) becomes disabled for 
the remainder of the session. If you want to switch back to VoIP, you will need to leave the session and 
rejoin. 

Why can't I connect toGoToMeeting and dial in by telephone on my iPhone? 
If you have an iPhone on a network that does not allow simultaneous voice and data sharing (CDMA), 
you won't be able to connect to GoToMeeting and dial in on your iPhone at the same time. To connect to 
audio, you should use your iPhone's built-in mic and speakers (VoIP) or dial in with a different device. 

If the organizer only provides a conference call number as the audio option and you try to dial in to the 
audio conference from a CDMA network without having a WiFi connection, you'll see a notification saying 
that your device does not support simultaneous voice and data sharing. Once you tap the Dial button on 
the notification, you won't be able to see the presenter's screen.  

What audio options does the GoToMeetingapp support? 
• iPad, iPhone or iPod Touch's built-in mic and speakers (VoIP) 
• iPad, iPhone or iPod Touch's built-in mic along with external headphones connected via the 3.5-

mm stereo headphone jack 
• Headset connected via the 3.5-mm stereo headphone jack 
• Bluetooth Hands Free devices 

For optimal audio quality, we recommend using a headset. 

Can I join HDFaces meetings and webinars from an iPad and view webcams? 
Yes, you can join HDFaces meetings and webinars and view webcams from an iPad. You can share your 
own webcam in a meeting from an iPad 2 or newer, but you cannot yet share your own webcam in a 
webinar.  
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GoToMeeting App for Windows Phone FAQs 
Review frequently asked questions on the GoToMeeting app for Windows Phone. 

What can I do with the GoToMeeting app for Windows phone? 
As an attendee, you can do the following: 

• Attend online meetings and webinars free of charge 
•  Join meetings in seconds by entering the Meeting ID and your name in the app 
• Chat with others in meetings 
• Raise your hand, participate in polls and question and answer in webinars 
•  View the presenter’s screen 
• Connect to audio through VoIP 
• Dial in by phone 

As an organizer, you can do the following: 

• Start and end scheduled meetings 
• Schedule meetings 
• Start a Meet Now session 
• Invite others 
• Give presenter controls to attendees 
• View the Attendee List 

What Windows devices are supported by this app? 
The GoToMeeting app will work on any phone, tablet or desktop running Windows 8. See additional 
FAQs for the GoToMeeting app for Windows tablet.  

Can anyone use the app? 
Yes, anyone can download the app and join a meeting. In order to host a meeting, users will need to have 
an active GoToMeeting account or free trial. For those that want to host meetings but don't have an 
account, there will be a free trial link in the app description. 

How do I join a meeting from a Windows phone? 
If you know the 9-digit Meeting ID, you can join the meeting by simply opening the GoToMeeting app and 
entering the Meeting ID and your name. If you don't have the GoToMeeting app yet, you can install it for 
free from the Windows store.  
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How do I start a meeting from a Windows phone? 
You can start a meeting by opening the GoToMeeting app, going to the Host screen, entering your email 
address and password and tapping Log In. You can then either select a scheduled meeting or tap Meet 
Now to start an impromptu meeting.  
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Are there any limitations to using the GoToMeeting app? 
Yes, it is not possible to view or share webcams from a Windows Phone 8. 

What are the system requirements for using the GoToMeeting app for Windows 
phone? 

• Windows Phone 8 

Are there any additional fees for using the GoToMeeting app? 
You can download the GoToMeeting app and join unlimited sessions for free; however, you will be 
responsible for any data charges that may occur if the phone is not connected to WiFi. In addition, you 
must sign up for a free trial or paid subscription plan in order to host meetings from the app. 

Can I join GoToTraining and GoToWebinar sessions from the GoToMeeting app? 
You can join GoToWebinar sessions, but you cannot currently join GoToTraining sessions. 

Can I connect to audio from the GoToMeeting app? 
Yes. You will be automatically connected to VoIP over the tablet's WiFi connection, or you can switch to 
either 3G or 4G connection. You will also have the option to dial in to a conference by going to the 
Settings screen before a session and tapping Phone in the Audio section, or tapping the Phone icon in 
the bottom toolbar while in session.  

Why does my Windows desktop sometimes launch the GoToMeeting desktop 
application instead of the GoToMeeting app? 
If you launch GoToMeeting from a web browser on a computer using an x86 or x64 processor, it will 
automatically launch the desktop application. In order to launch the GoToMeeting app for Windows, 
select the app icon on your desktop.  

GoToMeeting App for Windows 8 and Windows RT FAQs 
Review frequently asked questions on the GoToMeeting app for Windows 8 and Windows RT. 

What is the GoToMeeting app for Windows 8 and Windows RT? 
The GoToMeeting app for Windows 8 and Windows RT can be downloaded to your Windows 8 desktop 
and Windows RT tablet from the Apps for Windows store. Windows 8 users can join meetings from either 
the app or desktop version.  
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What can I do with the GoToMeeting app for Windows 8 and Windows RT? 
•  Attend online meetings free of charge 
• Join meetings in seconds by entering the Meeting ID and your name in the app 
• Schedule meetings 
• Start scheduled or impromptu meetings 
• View the attendee list and chat with others 
• Pass presenter role 
•  View the presenter's screen 
•  Connect to audio through VoIP 

How do I join a meeting with the GoToMeeting app for Windows 8 and Windows 
RT? 
If you know the 9-digit Meeting ID, you can join the meeting by simply opening the GoToMeeting app and 
entering the Meeting ID and your name. If you don't have the GoToMeeting app yet, you can install it for 
free from the Windows Store.  

 

Are there any limitations to using the app? 
• Presenting, Screen Sharing and Keyboard and Mouse Control  
• Viewing and sharing webcams 
• Dialing in by phone 

What are the system requirements for using the GoToMeeting app for Windows 8 
and Windows RT? 
Organizers must be using GoToMeeting v5.0, build 799 or higher for attendees to join sessions on the 
app. Any user with Windows 8 or Windows RT running on x86, x64 or ARM processors will be able to use 
the GoToMeeting app. Windows 8 tablets and all-in-one devices, such as the Surface Windows 8 Pro, are 
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not officially supported on the GoToMeeting desktop application, but if the GoToMeeting app for Windows 
8 and Windows RT is installed, you can enter the 9-digit Meeting ID and your name on the app to join a 
meeting from the mobile app.  

For more information, see the complete GoToMeeting System Requirements.  

Are there any additional fees for using the GoToMeeting app? 
Nope, the app is free, and there's no charge for attending GoToMeeting sessions. But you may be 
responsible for any data charges that may be incurred. 

Can I join GoToTraining and GoToWebinar sessions from the GoToMeeting app? 
You cannot currently join training sessions from the GoToMeeting app. You are able to join any webinar 
or meeting hosted by a GoToMeeting organizer using GoToMeeting v5.0, build 799 or higher. 

Can I host a GoToMeeting session from the GoToMeeting app for Windows 8 and 
Windows RT? 
Yes, you can host a GoToMeeting session by opening the app, tapping View your meetings on the 
Enter Meeting ID screen and entering your email and password. On the My Meetings screen, you will see 
a list of your scheduled meetings which you can tap to start, or you can tap Meet Now to start an 
impromptu meeting.  

 

Can I connect to audio from the GoToMeeting app? 
If the organizer provides mic and speakers (VoIP), you will automatically connect to mic and speakers 
over your device’s Internet connection (WiFi) once you join. The audio quality on your device depends on 
the quality and bandwidth available on the WiFi network that you're connected to. For best results, you 
should make sure you have nothing else running that might use up bandwidth. WiFi connection is highly 
recommended. 

© 2015 Citrix Systems. All rights reserved. 256 



GoToMeeting User Guide 

Can I join password-protected meetings from the app? 
No, you cannot currently join password-protected meetings from the GoToMeeting app for Windows 8 
and Windows RT. 

Are webcams supported? I’m prompted to use my webcam but I don’t see them at 
all. 
Although you may be prompted to use your webcam, GoToMeeting does not currently support webcams 
for Windows 8 or Windows RT. Therefore, you will not be able to see others' webcams or show your own. 

If I have the GoToMeeting app for Windows 8 and Windows RT, as well as the 
GoToMeeting desktop application on my desktop, what happens when I click the 
Join URL? 
If you have the GoToMeeting app for Windows 8 and Windows RT, as well as the GoToMeeting desktop 
application installed on your Windows 8 desktop, clicking the Join URL will automatically launch the 
GoToMeeting desktop application.  

New Version of GoToMeeting FAQs 
Review frequently asked questions on the new version of GoToMeeting 

What does the new version of GoToMeeting offer? 
• Multi-language support: Switch to English, French, German, Italian, Spanish or Chinese, and 

even set your default language. 
• Choose a preferred telephone number: Set a preferred telephone number that your attendees 

see first in invites and meetings.  
• More scheduling options: Schedule, edit and delete meetings from the My Meetings page, as 

well as from the GoToMeeting for iOS and Android apps. 
• Unified log-in experience: Log in to your account to easily manage and access your Citrix 

products from the My Account page. 

What else is different? 
You'll probably notice some improved features on the new version of GoToMeeting.  

• Even higher reliability and performance: Use the new best-of-breed platform to collaborate in 
real-time all across the globe. 

• New look and feel: Scheduling meetings and running reports never looked better with our new 
and improved website. It's sleeker and easier to navigate.  

Will I lose anything? 
Nope, the new version of GoToMeeting is very robust and offers an even better experience. And don't 
worry about losing your previously scheduled meetings, meeting history or reports – all your data will be 
moved over to the new system after you upgrade. 
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How do I transition to the new version? 
You've probably received an email with instructions that tell you how you'll be upgraded. The next time 
you log in, the new version will automatically download. 

Do I need to download anything? 
Yes, the next time you log in, you'll automatically upgrade to the new version of GoToMeeting.  

Will my pricing stay the same? 
Yes, your plan and pricing will stay the same, but please note the following: 

• GoToMeeting charges will now appear on your credit card or bank statement as "GoToCitrix.com". 
• If your billing address location mandates sales tax on subscription-based software (SaaS), data 

archiving or telecom services, we may be required to collect state and/or local sales taxes by law. 
For more information, see Domestic Sales Tax.  
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Plugins and Integrations 
Try GoToMeeting Free 
GoToMeeting Free is a video-chat tool that allows you to connect with co-workers or 
friends online quickly and easily! Ideal for small teams and quick sync-ups, GoToMeeting 
Free uses many of the same features as the full version of GoToMeeting (which is 
designed for larger teams and businesses). Get started with a meeting right away – no 
need to sign up 

If any of the following apply to your team, then GoToMeeting Free might be right for you! 

• Your meetings are typically only 2-3 people.  
• You need a simple and quick solution to chat and share webcams online.  
• You are on a budget.  
• You don't need the more robust tools included in the full version of GoToMeeting (like session 

recording and annotation tools).  

 

Features and tools 
You can do the following using GoToMeeting Free: 

• Start an unlimited number of meetings. 
• Invite up to 2 attendees per meeting.  
• Share your audio and webcam. 
• Share your screen. 
• Chat with attendees. 
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• Share documents (PDF, Word, Excel or PowerPoint) with attendees. 
• Schedule meetings by reserving and sharing Join URLs.  

Advanced features: You do not need to sign up for a GoToMeeting Free account in order to start and 
join meetings. However, signing up will allow you to access some additional features of GoToMeeting 
Free (e.g., claiming a room, scheduling a meeting). Sign up to access the following features:  

• Claim personalized meeting rooms.  
• Lock rooms to control who joins. 
• Have your name on your video tile and in the chat window.  
• Add your own avatar to appear on your account.  

GoToMeeting Free for Google Calendar 
You can also schedule and start meetings for GoToMeeting Free in Google Calendar.  

 

Check out: 

• Install the GoToMeeting Google Calendar extension. 
• Schedule a meeting in Google Calendar. 
• Modify a meeting in Google Calendar. 
• Start a scheduled meeting. 

Start a meeting 
1. Open a web browser and go to http://free.gotomeeting.com.  

2. Click the Start a Meeting button.  

 

3. The new meeting will automatically launch in the browser window.  

4. When prompted, enable the use of your speakers and webcam as follows: 

• Firefox – Click Share Selected Devices in the drop-down message.  
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• Chrome – Click Allow in the top-navigation.  

 

5. Once you are in session, a floating toolbar will appear at the top of your screen. This provides you 
with easy access to Mute and Webcam icons, even when the browser window isn't at the forefront of 
your screen. 

  

Invite attendees (2 max) 

1. Click the Add People icon  at the bottom of the page.  

2. A pop-up window will display the Join URL for the meeting. You can share the link with attendees in 
any of the following ways: 

• Click the Copy Link button to copy the URL to your clipboard and share it as desired. 
• Click the Share via email link to launch a new email with the Join URL automatically included.  
• Click the Invite with Facebook link to launch a new Facebook message with the Join 

URL automatically included.  

 

3. Up to 2 attendees can join the meeting (i.e., 3 participants, including you).  

• If the room is locked, then you will be prompted to approve or deny their joining. 
• If the room is unlocked, then they will be launched into session immediately. 

When attendees join, they will be assigned a random nickname (e.g., "Charming Star", "Rugged 
Diamond") that will be displayed in the webcam and chat box. 
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Note: Attendees can have their own name appear in the webcam box and chat box if they sign in to GoToMeeting Free. 

Share your audio and webcam 
When you join a session, your audio and webcam are automatically shared.  

To unshare them, you can do the following: 

• Click the Mute icon  so that a "Muted" message appears across the shared webcam.  
• Click the Webcam icon  so that the shared webcam goes black with an icon  across it.  

 

Click the icons again to un-mute your audio or re-share your webcam. 

Chat with attendees 
Use the Chat bar in the lower-right of the bottom navigation to instant message with attendees. Simply 
enter your message in the next field and press Enter on your keyboard to send your chat.  

 

Share your screen 
1. Start a meeting.  

2. Click the Share Content icon  in the bottom navigation.  

3. Click the Share Screen button.  

Note: You must first enable the extension by clicking Enable Extension button then clicking Allow or Add.  

4. Share your screen or applications as follows: 

• Chrome – In the pop-up window, select an application or screen to share with attendees. Click 
Share when finished.  
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• Firefox – In the browser drop-down message, select Entire Screen > Share Screen button. It is 
not possible to share only an application window using Firefox.  

 

5. The Share Content icon will turn green ( ) when your screen is being shared, and you will see 
the following message on your desktop (not visible to attendees) notifying your that the GoToMeeting 
Free extension is sharing your screen with others.  
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Share a document on your screen 
If desired, you can share the image of a PDF, Word, Excel or PowerPoint file with attendees. Rather than 
sending the file to attendees for download, this feature temporarily displays the file on the shared screen 
in the web browser.  

1. Click the Share Content icon  in the lower navigation.  

2. Upload a compatible file in either of the following ways: 

• Under "Share a document", click Choose File. Select the desired file in the File Upload window 
and click Open when finished.  

• Drag and drop the desired file into the "Share a document" box in the browser.  

 

3. The file will be automatically uploaded and displayed on the screen for you and your attendees. For 
multi-page documents, you can use the Arrow icons in the top navigation to move between pages.  

4. To stop sharing the file, click the Share Content icon  again.  

Note: The file is not saved to the meeting; if you would like to share it again, you will need to complete the above steps again. 
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Claim a meeting room 
If desired, you can claim your own meeting room with a personalized URL. This allows attendees to 
always join the same meeting without you having to send out new invitations each time.  

Note: You can only claim 1 room per account. 

1. Click the Claim room link in the top-left corner.  

2. If you haven't yet done so, sign in to GoToMeeting Free.  

3. Use the text field to specify the URL you would like to use as a Join Link for your meeting.  

4. Click the Claim Room button when finished. 

 

5. To start a meeting with the claimed room, simply go to the new Join URL. Alternatively, you can 
sign in and click Enter Your Room on the home page.  
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Use locked rooms 
If you want to control who joins your claimed room, you can lock it (i.e., make it private). When the room is 
locked, attendees are presented with a waiting screen until you arrive. When a room is unlocked, 
attendees will automatically join without your being prompted to approve them.  

1. Enter your claimed room. 

2. Click the Lock icon  in the top navigation so that the icon changes ( ). 

3. When prompted, click Lock Your Room.  

4. Attendees who attempt to join the room will see a waiting screen informing them that they must wait 
to be approved to join.  

 

5. You will be prompted to allow or deny entrance to each attendee by using the  and  icons 
displayed along with the attendee's shared webcam.  
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Schedule a meeting 
1. Sign in to GoToMeeting Free.  

2. Click the Schedule a Meeting button on the home page.  

 

3. Click the Copy Invitation button to copy the Join URL of a new meeting to your clipboard. Share 
the link with your attendees, and then use it yourself when you want to start the meeting.  
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Leave feedback for GoToMeeting Free 
You can leave feedback in either of the following ways.  

• When you leave your first meeting, you will be prompted to rate how likely you would be to 
recommend GoToMeeting Free to a friend or colleague on a scale of 1 - 10.  

 

• In the lower toolbar, click the Settings icon  and then Feedback to access the Feedback form, 
where you can report an issue or provide feedback. 
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Sign up for a GoToMeeting Free account 
You do not need to sign up for a GoToMeeting Free account in order to start and join meetings. However, 
signing up will allow you to access some additional features of GoToMeeting Free (e.g., claiming a room, 
scheduling a meeting).  

1. Go to https://free.gotomeeting.com.  

2. Click the Start a Meeting button. 

3. Click the Sign in link in the top navigation.  

4. You can click Sign in with Facebook or Sign in with Google to continue.  

5. When prompted, log in with your Facebook or Google credentials in order to connect your account.  

 

System requirements 
The following are required in order to use GoToMeeting Free: 

• Operating System 
Windows  
Mac 
Linux 

• Browser 
Google Chrome (latest version here) 
Mozilla Firefox (latest version here) 

• Hardware  Webcam 
Mic/speakers (preferably with a headset) 

Note: GoToMeeting Free for Androids using Chrome browsers is still considered a “work in progress”, so feel free to try it but please 
forgive us for any bugs. We suggest using headphones to improve the audio experience. Chrome on iOS is not yet supported. 
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Integrate GoToMeeting with Microsoft Outlook 
The GoToMeeting Outlook Toolbar gives organizers on Windows computers with Microsoft Office 2002 or 
later quick and easy access to GoToMeeting's features within Outlook. 

Add the GoToMeeting Toolbar (Windows only) 

1. Right-click the GoToMeeting daisy icon   in the system tray, and select Preferences. 

2. On the Integrations tab, select "Use GoToMeeting with" and then "Microsoft Outlook", as well as 
any other applications you would like integrated with GoToMeeting. 

3. Click OK.You may need to close and restart any programs you selected for the GoToMeeting 
Toolbar to appear. 
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Use GoToMeeting with Outlook (Windows only) 
1. Once you've added the GoToMeeting Toolbar from Preferences, open Microsoft Outlook.  

2. Depending on which version of Outlook you have, you may be able to access the GoToMeeting 
Toolbar from the Outlook ribbon, or you may need to first select Add-Ins from the Outlook ribbon to 
see the GoToMeeting menu items. If you don't see the GoToMeeting Toolbar Add-In, enable Add-Ins 
in Outlook. 

3. Whenever you'd like to host or join a session, simply use one of the following options to do so from 
within Outlook: 

• Host a Meeting 
• Join a Meeting 
• My Meetings  
• Meet Now 
• Schedule Meeting 
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Enable Add-Ins in Outlook 2010 
1. Open Outlook 2010. 

2. Select the File menu > Help. In the "Tools for Working with Office" section, select Options.  

3. In the Outlook Options window, select Add-Ins from the left navigation. 

4. In the Inactive Application Add-ins section, select GoToMeeting Outlook COM Addin > Go. 

 

5. In the COM Add-Ins window, select the "GoToMeeting Outlook COM Addin" check box, and then 
click OK.  

 

Enable Add-Ins in Outlook 2007 
1. Open Outlook 2007. 

2. Select the Tools menu > Trust Center.  
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3. In the Trust Center window, click Add-Ins. 

5. From the Manage drop-down menu, select GoToMeeting Outlook COM Addin > Go. 

6. In the COM Add-Ins section, select the "GoToMeeting Outlook COM Addin" check box, and click 
OK. 

Enable Add-Ins in Outlook 2003 
1. Open Outlook 2003.  

2. Select the Help menu > About Microsoft Office Outlook.  

3. Select the Disabled Items button.  

4. Choose the GoToMeeting Outlook COM Add-in, and click Enable.  

Download the GoToMeeting Outlook Plugin 
The GoToMeeting Outlook plug-in allows you to schedule and manage GoToMeeting sessions directly 
from your Outlook calendar. 

Download the GoToMeeting Outlook Plugin 
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Install the GoToMeeting Outlook Plugin 

System Requirements 

• Windows XP or newer (not available for Mac computers) 
•  Outlook 2010 or newer 

Download the Outlook plugin 

1. Close Microsoft Outlook. 

2. Click the link above to initiate the download.  

• For Outlook 2010, click Yes on the download prompt. The plugin will be automatically installed on 
your Outlook Calendar.  

• For Outlook 2013, click Install on the Customization Installer pop-up to install the Outlook plugin. 
Click Close once the installer is finished. 

3. You may need to restart Outlook in order to see the changes.  

IMPORTANT: To ensure your audio preferences are used for your meetings, click Set Default Audio Options. For instance, if 
you specify toll or tollfree conference numbers, these will be picked up and used by the plugin. 

 

Uninstall the Plugin 
The process for uninstalling the plugin from a computer varies depending on the computer's operating 
system. See your operating system's user manual for more information.  

Example (Windows 7): Go to Windows Start  > Control Panel > Programs and Features. Right-click 
GoToMeetinOutlook Calendar Plug-in and select Uninstall > Yes.  
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Install the GoToMeeting Outlook Plugin in Silent Mode for Admins 
The silent installation enables an administrative install of the Outlook plugin as a company-standard 
application. The process allows an IT admin to obtain a Trusted Publisher certificate for the plugin and 
deploy that to user devices, and then to create an installation package that will automatically install the 
plugin on user devices. The certificate must be renewed on an annual basis. 

Once the plug-in is installed on a user's account, it updates automatically. Each time Outlook is restarted, 
the plug-in checks for updates, and if they are available, makes the updates automatically without user 
notification. 

System Requirements 
• Windows XP or newer 
•  Outlook 2010 and Outlook 2013 (must be set up to use Exchange as the mail system) 
• Access to the Internet 
•  Visual Studio (VSTO) Installer is installed on user machines. (MicroSoft Office typically installs this 

as part of the Click-Once installer. To download it, go to the VSTO Installer. If the link fails, search 
for: ‘download visual studio 2010 tools for office runtime’.) 
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Register for Certificate Access 
To obtain the currently valid Trusted Publisher certificate, the admin must first request access to the Citrix 
Certificate Store. The certificates are valid for one year. Registering for access ensures you receive an 
email alert from Citrix when a new certificate is available. This enables you to update certificates on user 
devices before they expire.  

IMPORTANT: If certificates expire on user devices, errors are generated and the users' lose their ability 
to use the plugin to schedule and launch meetings until a valid certificate is in place. 

1. Go to Podio: https://podio.com/webforms/8544012/635668 and complete the registration form. Click 
Submit. 

 

2. You will receive an email confirmation that will permit you to proceed to the next step. 
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Get Currently Valid Certificate 
Once you have registered for access to the Citrix Certificate Store, or when a new certificate is available, 
you will receive an email directing you to the Citrix Certificate Store where you can download the latest 
certificate. You can then use your company-standard delivery tools or scripts to deploy the certificate to 
user devices. 

NOTE: If there is more than one certificate that is currently valid, download both. A conflict between 
plugin versions and certificates can exist in some cases. Downloading both certificates eliminates that 
possibility. 

1. Click the button in the email you received to access the Podio space, Citrix Signing Certificate 
(https://podio.com/citrix/citrixsigningcertificate). 
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2. In the Podio space, choose Public Certificates. 

 

3. In the list of public certificates - there will be no more than two - check the Valid dates. Click on the 
latest certificate. The certificate download page displays. 

 

4. Select the CitrixOnline.cer file. The file downloads to your local drive automatically. 
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Disable Notifications in Podio as Needed 

Because this Podio space is only needed to provide you access to the latest certificate, and Citrix will 
email you directly when a new certificate is available, you may want to disable Podio notifications. To do 
this: 

1. Open Podio and click on your profile menu in the upper right corner. 

  

2. Click Account Settings, and choose Email & Notifications. 

3. Uncheck all notifications, and choose Save. 
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Deploy Certificate 
Deploying the certificate(s) consists of copying the file or files to local machine stores and then adding 
them to the Trusted Publishers store for both the machine and the current machine user. Most 
IT departments have tools that accomplish these steps. The deployment of the certificate(s) is 
described here as a separate step, but you could also incorporate it into the silent install described in 
the next section. 

To test this, or if you are scripting this install, you could use a script with syntax something like the 
following (the script will pick up all certificates in the directory): 

@Certutil -addstore -enterprise -f "TrustedPublisher" "CitrixOnline*.cer" 

If you want to step through these processes manually to test them or for a problem machine, see 
Install the Trusted Publisher Certificate Manually. 

Configuring the Silent Mode Installation Package 
The silent mode installation of the GoToMeeting Outlook Plugin can be accomplished using your standard 
IT deployment tools. Citrix provides an installation package that includes sample scripts and the Plugin 
installer that you can use or modify as needed. 

The scripts provided, and their functions, are: 

File Description 
ImportCertificate.cmd Copies the certificate to the local machine and 

adds it to the Trusted Publishers store for the 
machine and current user.  

Test_SilentPluginInstallation.cmd Sample install of the GoToMeeting Outlook 
Plugin. 

TestandInstall_G2MOutlookPlugin.cmd Sample boot script to check for the plugin, and if 
it is absent, to install it. Also disables existing, 
older version of the plugin. 

TestandInstall_G2MOutlookPlugin.ps1 The sample boot script in Windows PowerShell 
format. 

CitrixOnline.cer The certificate. Must be acquired from the Citrix 
Podio site. 

1. If you haven't already, obtain the CitrixOnline.cer certificate. 

2. Download the Citrix install package. The contents of the package are: 

• ImportCertificate.cmd - this picks up a qualified certificate files in the directory location 
• Readme.txt 
• Test_SilentPluginInstallation.cmd 
• TestandInstall_G2MOutlookPlugin.cmd 
• TestandInstall_G2MOutlookPlugin.ps1 

3. Create the install model that works for your environments. The full install should accomplish the 
following: 

• Execute ImportCertificate.cmd as administrator to copy and install the certificate(s). 
• Optionally check local machines on boot for the presence of the plugin using the equivalent of 

TestandInstall_G2MOutlookPlugin.cmd. 
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• Install the plugin in silent mode as in Test_SilentPluginInstallation.cmd, or 
TestandInstall_G2MOutlookPlugin.cmd. 

• Disable any older plugins. 

If you are using a boot script on local machines, the syntax would be something like: 

"C:\Program Files (x86)\Common Files\microsoft 
shared\VSTO\10.0\VSTOInstaller.exe" /install 
https://builds.citrixonlinecdn.com/builds/calendarintegration/ 
outlook/G2M/GoToMeetingOutlookCalendarPlugin.vsto /silent 

This completes the silent mode installation instructions. If you have difficulties, questions, or 
comments, please either comment on this page, or contact developer-support@citrixonline.com. 

The remaining sections of this article provide manual steps for the certificate deployment process. 

Install the Trusted Publisher Certificate Manually 
If there is a problem installing the Trusted Publisher certificate, or if the install is to be performed 
locally on a user device, you can complete installation manually. 

1. Locate the Citrix Signing Certificate, CitrixOnline.cer, and double-click on the file to check the 
expiration date. The certificate is valid for roughly one year. Note the date of expiration and set a 
reminder to download a new silent install package with a new certificate a month or so prior to the 
expiration of your current certificate. 
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2. If the certificate is valid, click Install Certificate. Choose Next to continue. 

 

3. In the Certificate Store window, choose Place all certificates, and click Browse. In the Select 
certificate store dialog, select Trusted Publishers and click OK, then click Next. 
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 4. In the Completing the Certificate Import window, make sure the Certificate Store Selected by 
User is selected, and choose Finish. 

 

5. After a few moments, you should see an "Import was successful" dialog box. Choose OK to end 
the install process. 

 

© 2015 Citrix Systems. All rights reserved. 283 



GoToMeeting User Guide 

Use MicroSoft Management Console to Install Certificate  
1. In your computer's Start menu, type mmc in Search programs and files and press Enter. 

2. If you are asked for permission to proceed choose Yes. The management console opens. 

3. Open File | Add/Remove Snap-in. 

4. In the Add/Remove Snap-in box, select Certificates and then click Add. 

5. Click Computer Account, and then click Next. 

6. Click the Local computer (the computer this console is running on) option, and then click 
Finish. 

7. Repeat steps 4 and 5, this time choosing My User Account. 

8. Click Close, and then click OK. If you are asked to Save the console settings, choose Yes. 

Schedule a Meeting with the Outlook Plug-in 
The GoToMeeting Outlook plug-in allows you to schedule and manage GoToMeeting sessions directly 
from your Outlook calendar.If you then update or reschedule the appointment on your calendar, the 
associated meeting will be rescheduled as well. 

IMPORTANT: If you wish to use the GoToMeeting Outlook plug-in, it is highly recommended that you 
only schedule, update and/or cancel meetings in Outlook. This is because while all changes you make in 
the plug-in are automatically reflected in the web portal, changes made in the web portal are not 
duplicated in the Outlook plug-in. In addition, any rescheduling for meetings while in Outlook offline mode 
will not appear in the GoToMeeting admin site. 

Notes: The Outlook Plug-in automatically uses your default audio settings when scheduling meetings. See Download the 
GoToMeeting Outlook Plugin for single machine and admin silent mode installation instructions.  

Schedule a meeting via Outlook 
1. Create a new meeting or appointment.  

2. On the Meeting tab in the Ribbon, click Add Meeting. If prompted, sign in with your GoToMeeting 
credentials. 

 

3. Session information for a new meeting (including join links and dial-in numbers) will be 
automatically populated in the body of the email.  

4. Use the Outlook fields to specify the subject, date and start/end times.  

5. Invite attendees by adding their email addresses in the To field. Click Invite Attendees in the 
ribbon if the To field is not displayed. 

6. Click Send when finished. 
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Edit a meeting via Outlook 
You can easily update any sessions that you originally scheduled via the Outlook plug-in.  

Note: If a meeting was scheduled via the web app or desktop application, updating it in your Outlook calendar will not automatically 
update it in the GoToMeeting web app.  

1. Open the desired appointment on your Outlook calendar.  

2. Update the date, time, subject and/or attendees as desired. 

3. Click Send Update when finished.  

Remove a meeting from an Outlook appointment 
If needed, you can remove the session information from an appointment without canceling the 
appointment altogether. This will keep the appointment on your calendar (and those of your attendees), 
but it will remove the meeting from the GoToMeeting system.  

1. Open the desired appointment on your Outlook calendar.  

2. In the Ribbon, click Remove Meeting. 

3. Click Send Update when finished.  
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Configure a Proxy for the GoToMeeting Outlook Plug-in 
The GoToMeeting Outlook plug-in supports proxies via Internet Explorer or the Control Panel. Currently, 
the following are supported: 

•  Proxy without login 
•  Proxy with login via User Name/Password 

You can configure your proxy by following the below steps: 

1. Open your Windows menu and click Control Panel. 
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2. Click the drop-down menu and select Network and Internet. 

 

3. Click Internet Options. 
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4. Under the Connections tab, click LAN Settings. 
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5. Under Proxy server, enter your proxy address and port to activate the proxy and hit OK. 

 

6. The next time you open your Outlook and click the Add Meeting button, enter your log-in information to 
use the proxy. Be sure to check the “Remember my credentials” check box so you will not have to enter 
your information again. Then click OK. 
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Install the GoToMeeting Extension for Google Calendar 
The GoToMeeting Extension for Google Calendar supports both GoToMeeting and GoToMeeting Free. 
The extension allows you to schedule and update meetings directly from your Google calendar in a 
browser or on a mobile device. You can email meeting invitations and updates directly to attendees. To 
see documentation on scheduling meetings, see Schedule a meeting with the GoToMeeting Google 
Calendar Extension. This article covers: 

Note: If you have already installed earlier versions of the extension, it is updated automatically to use the latest version of the 
extension when you relaunch your browser. 

System Requirements  
• Windows XP or newer 
• Mac OS® X 10.7 or newer 
• Google account 
• Chrome or Firefox browser 

Install GoToMeeting Google Calendar extension for Chrome 
1. Go to the GoToMeeting Google Calendar extension in the Chrome Store. 

2. Click the +Free button next to “GoToMeeting Extension for Google Calendar" 

3. In the Confirm New Extension dialog, click Add. 
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4. The extension is installed automatically and ready to use. To double-check, go to Chrome Tools | 
Extensions and make sure it is listed and checked as Enabled. 

 

Install GoToMeeting Google Calendar extension for Firefox 
1.Go to the Mozilla Add-Ons store. Search for GoToMeeting. 

 

2. Click the Add to Firefox button on the GoToMeeting Extension for Google Calendar. (The button 
appears when you move a cursor over the location.) 

  

3. Choose Install Now at the trusted author warning. 

 

The extension is ready for use! 
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Update or remove your Google Calendar extension 
Once you have installed the GoToMeeting Google Calendar extension, you can quickly access the latest 
version of the extension to update it, or access your extension management page to modify your settings 
for the extension. 

Update the GoToMeeting Google Calendar Extension 

1. Open Google Calendar in your browser. Right-click on the GoToMeeting icon  to open the 
extension menu. 

2. Select GoToMeeting for Google Calendar. You are taken to the Extensions page with the current 
GoToMeeting extension displayed. If your installed extension is current, the button read Added to 
Chrome. If it is not current, click Free to install the latest version. 

 

Manage the GoToMeeting Google Calendar Extension 
The extension manager lets you enable or disable an extension, delete it, place it in incognito mode, and 
view the extension permissions. 

1. Open Google Calendar in your browser. Right-click on the GoToMeeting icon  to open the 
extension menu. 

2. Select Manage. You are taken to your Extensions page. 

 

3. You can do the following: 

• Update the extension -- This enables the latest version, and disables the prior version. Click the 
Update Extensions Now button at the top of the page. 

• Allow in incognito -- This permits the extension to show up in incognito browser sessions. 
Incognito sessions do not allow the browser to save a record of what you visit and download. 

• Visit the extension website -- This takes you to the Extensions page with the current 
GoToMeeting extension displayed. 
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• Disable the extension -- This leaves the extension installed, but removes it from Google 
Calendar. 

• Delete the extension -- Click the Trash can icon . This removes the extension from your 
environment entirely. 

• Review permissions -- View the read and write permissions the extension requires, and any 
other permissions used. 

 

Remove a Meeting from Google Calendar 
For meetings in Google Calendar with GoToMeeting or GoToMeetingFree events included, you can 
delete the meeting by either deleting the entire event, or by removing the GoToMeeting session from the 
event. In either case, the change automatically updates your GoToMeeting account.  

1. In Google Calendar, you can click on the event in calendar view, and then click Delete. This deletes 
the event and scheduled GoToMeeting session. 

2. Double click the event in calendar view to open the meeting you want to edit, or click once and 
select Edit event. Your meeting data displays.  

3. Click the trash can icon to remove the meeting from the event. 

 

4. Click Save for the Google Calendar event. This retains the event without the meeting. 
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Schedule a Meeting in Google Calendar 
The GoToMeeting Extension for Google Calendar supports both GoToMeetingand GoToMeeting Free. 
The extension lets you start and schedule meetings directly from your Google calendar. You can then 
email meeting invitations directly to your contacts. See Install the GoToMeeting Extension for Google 
Calendar to install the extension. 

1. In your calendar, click the desired time slot and select Create an event. 

 

2. The event is added to calendar. Click the title of the event to open it. 

3. The GoToMeeting extension displays under Event details. If you are not logged in, you will see the 
GoToMeeting Free extension: 

 

© 2015 Citrix Systems. All rights reserved. 294 



GoToMeeting User Guide 

Click Add to add a scheduled GoToMeeting Free meeting to the event. GoToMeeting Free is limited 
to two additional attendees. Skip below to view the invitation and scheduled event. 

4. Click Sign in to GoToMeeting PRO to add the event using your account. Enter your GoToMeeting 
account user name and password and click Login. 

 

5. If this is the first time you have logged in through Google Calendar, the extension requests access 
to your GoToMeeting profile. Click Allow. 

 

6. Click Add to add the event using your GoToMeeting account: 
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7. Once you have added the event in either GoToMeeting or GoToMeeting Free, the detailed invitation 
text displays in the Description box that will be included in emails to invitees. 

The audio settings for the meeting defaults to those set in your account in the Citrix portal. See Modify 
audio settings to change these in your GoToMeeting account from right inside your Google Calendar 
event. 

 

8. Click Save to save the event. If you have invitees identified in the event, the Send invitations? query 
displays. Click Send to send the invites. 

 

Modify a Meeting in Google Calendar 
In addition to standard changes (guests, locations, times, etc.) on the Google Calendar, you can also 
modify the GoToMeeting audio settings for the event.  

If you are logged into GoToMeeting, any changes you make and complete by clicking Save are reflected 
in your GoToMeeting account, and can be viewed in your online portal. 
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GoToMeeting Free 
If you are editing a GoToMeeting Free event, the changes are limited to the schedule and guests. You 
cannot update audio settings. 

Modify a meeting 
1. In your calendar, double click the meeting you want to edit, or click once and select Edit event. 
Your meeting data displays.  

2. Click the edit icon to modify the audio settings for this event. Basic data about the scheduled 
event displays. Modify the audio settings for the call as needed: 

• VoIP – Your participants can use microphone and speakers to connect to audio through their 
computer. 

• Long distance number – Your participants can use a telephone to dial in to the audio 
conference using a long distance number. You can choose which countries to provide long 
distance numbers for your attendees. 

• Toll-free number – If OpenVoice Integrated is activated on your account, your participants can 
use a telephone to dial in to the audio conference using a toll-free number. You can choose 
which countries to provide toll-free numbers for your attendees. 

• Use my own conference call service – This option is currently disabled. 
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3. Choose Save to save changes for the current meeting. A success message displays. If you are 
logged into GoToMeeting, the changes are updated in the GoToMeeting portal. 

 

4. You will be prompted to send updates to attendees. Click Send update to send the invitation 
updates or click Don’t Send if you do not wish to send an updated event to guests. 

 

Modify Default Audio Settings from Google Calendar 
The audio settings for meetings created in Google Calendar default to those set in your account in the 
Citrix portal. You can adjust these defaults from the Google Calendar extension. 

IMPORTANT: Modified account settings affect all new meetings, whether they are scheduled in Google 
Calendar, from your desktop or mobile phone, or elsewhere. Any existing meetings retain the audio 
settings they were most recently created or updated with. To update audio settings for an existing 
meeting, see Update a meeting. 

1. In your calendar, double click the meeting you want to edit, or click once and select Edit event. 
Your meeting data displays. 
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2. To review or modify the audio settings for your GoToMeeting account, click the gear icon . The 
default GoToMeeting audio settings displays. The Toll-free numbers option displays only if you have 
OpenVoice integrated added to your GoToMeeting account. 

 

3. Make your changes and click Save. A success message displays. The change takes place in your 
GoToMeeting account immediately. 
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Troubleshooting 
General GoToMeeting Troubleshooting FAQs 
Review frequently asked GoToMeeting troubleshooting questions. 

I never received my GoToMeeting invitation email. What should I do? 
It's possible that your email server blocked the invitation email. If you're in a corporate environment and 
don't have the ability to check email in a spam folder, check with your administrator to see if the invitation 
can be resent.  

Where can I view my scheduled meetings? 
See View Scheduled Meetings for information on where to find My Meetings.  

I forgot my password. What should I do? 
Go to the Forgot Your Password? page, and enter the email address you use to log in to your account. 
Once you click Continue, an email will be sent to you where you can click a link to create a new 
password.  

How long will my past meetings appear in my Meeting History? 
Past meetings will appear in your meeting history for 90 days after a meeting's scheduled end time. If 
you're on a GoToMeeting corporate plan, you can view meeting history up to 12 months after a meeting's 
scheduled end date.  

What happens when I stop showing my screen? What do my attendees see? 
When you click the Stop button, Screen Sharing will be turned off, and you will no longer show your 
screen to attendees. Instead, your attendees will see the Waiting Room until you resume Screen Sharing. 
If you're on a GoToMeeting corporate plan, you can customize the Waiting Room and display a logo to 
attendees.  

How do I share one application and nothing else? 
A presenter can share a single application by right-clicking the screen-sharing icon on the Control Panel 
and then selecting the application to share from the list of applications presented. The application-sharing 
feature is only available to presenters using Windows computers.  

If I'm the organizer, how do I take back Keyboard and Mouse Control? 
As a security feature, you can regain control of your computer by simply moving your mouse. The change 
of control happens almost instantaneously. At any time, you can revoke an attendee's shared control of 
your mouse and keyboard if you want to prevent him or her from regaining control. 
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Are there any files or folders left on an attendee's computer after the session 
ends? 
Some downloaded files do remain after a meeting so that attendees can join future meetings more quickly 
(without having to download all the files again). The Citrix Online Launcher app may be installed on 
attendees' computers, which also includes an optional browser plugin that lets them join faster. These 
files are inactive, will not consume system resources, do not compromise security and perform no 
functions until the attendee joins another meeting and the files are engaged by a new Meeting ID. If 
desired, an attendee may uninstall all GoToMeeting files using the Add/Remove Programs feature in the 
Windows control panel. 

If the option to save chat logs is enabled, attendees will see their chat history stored by default in the My 
Documents folder. They may also see GoToMeeting log files stored in %temp%\CitrixLogs\gotomeeting 
on Windows computers and ~/Library/Logs/com.citrixonline.GoToMeeting/ on Macs.  

Why would I make someone else an organizer in my meeting? 
If you created a meeting and needed to leave, but wanted your attendees to continue the discussion, you 
would want to make someone else the organizer. The meeting would proceed without you and without 
interruption. 

Is there a charge for using GoToMeeting's integrated audio?  
GoToMeeting is packaged with both VoIP and a telephone conferencing at no extra cost. You may decide 
to use one or both of these services or choose another method of connecting to audio during meetings. 
Our phone conference service provides a toll-based phone number that meeting participants can dial. 
Participants are then charged their standard long-distance rate for calling a toll-based number, just as if 
they made a regular long-distance call. There is no additional charge for the conferencing feature. If 
attendees wish to avoid incurring long-distance charges, then they can join the meeting with VoIP. Please 
see Integrated Toll-Free Audio for information on how to provide your attendees a toll-free option. 

How do I save chat sessions from my meetings?  
Under the File menu, select Save Chat Log. Or, if you are using a Windows computer, open 
Preferences > General, and select the "Chat Logs" check box to automatically save logs to that 
computer after each meeting. 

Is video streaming supported in GoToMeeting? 
While we do not yet support streaming video, our GoToMeeting technology is fast enough to keep up with 
screen changes on the desktop, so it appears as if it is streaming video.  

Because more data is being sent to all meeting attendees, bandwidth usage will increase for all meeting 
participants. The amount will depend on the resolution and length of the video. 

Also, certain versions of Windows Media Player with Microsoft DirectX (an advanced suite of multimedia 
application programming interfaces, or APIs, built into Microsoft Windows operating systems) will not 
display the video. 

To enable video display for your meetings, you need to disable Hardware Overlay for your player. Please 
see your media player's help section for instructions on disabling Hardware Overlay. 
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Can I change a meeting in Outlook without going into GoToMeeting to change the 
time manually? 
No, once you generate the invitations and calendar event, you must change the meeting time in 
GoToMeeting if you want to reschedule the meeting. 

What happens if I have two monitors? 
You can choose to either display one or both of the monitors. However, your two-monitor display may 
cause problems of resolution and visibility for your attendees if you display both monitors simultaneously. 

GoToMeeting Essentials FAQs 

What is GoToMeeting Essentials? 
GoToMeeting Essentials is a lighter version of GoToMeeting that allows up to 5 attendees and 1 
organizer to join your meeting.  

What is the difference between GoToMeeting Essentials and other GoToMeeting 
plans? 
GoToMeeting Essentials supports all GoToMeeting features except for the ability to record a meeting. 
The regular GoToMeeting plan allows up to 25 attendees per session and also allows you to add multiple 
organizers to your account.  

  GoToMeeting Essentials GoToMeeting 
Attendee Limit 5 25 

HDFaces Video Conferencing   

Screen Sharing   
Phone and VoIP Conferencing   
Recording   

Can I switch from a GoToMeeting Essentials plan to a GoToMeeting 25 plan? 
Yes, you can easily switch from a GoToMeeting Essentials plan to a GoToMeeting 25 plan by going to 
the My Account page and clicking Change Plan. However, you can not switch back to a GoToMeeting 
Essentials account since GoToMeeting Essentials is not offered as a subscription option (it is only 
available to existing GoToMeeting Essentials users). 
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